Foreword

- This manual contains text, diagrams and explanations which will guide the reader in the correct installation and operation of the FX-PCS/WIN-E.
- Before attempting to install or use the FX-PCS/WIN-E this manual should be read and understood.
- If in doubt at any stage of the installation of the FX-PCS/WIN-E always consult a professional electrical engineer who is qualified and trained to the local and national standards which apply to the installation site.
- If in doubt about the operation or use of the FX-PCS/WIN-E please consult the nearest Mitsubishi Electric distributor.
- This manual is subject to change without notice.
Registration

- Microsoft® Windows®, MS, MS-Windows® 3.1, Windows® 95, Windows® 98, Windows® Millennium Edition, Windows NT® 4.0 Workstation, Windows® 2000 and Windows® XP are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

- The company name and the product name to be described in this manual are the registered trademarks or trademarks of each company.
Mitsubishi has a worldwide reputation for its efforts in continually developing and pushing back the frontiers of industrial automation. What is sometimes overlooked by the user is the care and attention to detail that is taken with the documentation. However, to continue this process of improvement, the comments of the Mitsubishi users are always welcomed. This page has been designed for you, the reader, to fill in your comments and fax them back to us. We look forward to hearing from you.

Fax numbers: ................................................... Your name: ...................................................
Mitsubishi Electric.... ...................................................
America (01) 847-478-2253 Your company: ...................................................
Australia (02) 638-7072 ...................................................
Germany (0 21 02) 4 86-1 12 Your location: ...................................................
Spain (34) 93-589-1579 ...................................................
United Kingdom (01707) 278-695

Please tick the box of your choice

- What condition did the manual arrive in?  □ Good □ Minor damage □ Unusable
- Will you be using a folder to store the manual? □ Yes □ No
- What do you think to the manual presentation? □ Tidy □ Unfriendly
- Are the explanations understandable? □ Yes □ Not too bad □ Unusable
- Which explanation was most difficult to understand: ...................................................

- Are there any diagrams which are not clear? □ Yes □ No
- If so, which: ...........................................................................................................................

- What do you think to the manual layout? □ Good □ Not too bad □ Unhelpful
- If there is one thing you would like to see improved, what is it? ...................................................

- Could you find the information you required easily using the index and/or the contents, if possible please identify your experience: ...................................................

- Do you have any comments in general about the Mitsubishi manuals? ...................................................

Thank you for taking the time to fill out this questionnaire. We hope you found both the product and this manual easy to use.
Guidelines for the Safety of the User and Protection of the Programmable Controller

This manual provides information for the use of the FX Series Communication Unit. The manual has been written to be used by trained and competent personnel. The definition of such a person or persons is as follows;

a) Any engineer who is responsible for the planning, design and construction of automatic equipment using the product associated with this manual should be of a competent nature, trained and qualified to the local and national standards required to fulfill that role. These engineers should be fully aware of all aspects of safety with regards to automated equipment.

b) Any commissioning or service engineer must be of a competent nature, trained and qualified to the local and national standards required to fulfill that job. These engineers should also be trained in the use and maintenance of the completed product. This includes being completely familiar with all associated documentation for the applicable product. All maintenance should be carried out in accordance with established safety practices.

c) All operators of the completed equipment (see Note) should be trained to use this product in a safe manner in compliance to established safety practices. The operators should also be familiar with documentation which is connected with the actual operation of the completed equipment.

Note: the term 'completed equipment' refers to a third party constructed device which contains or uses the product associated with this manual.

Notes on the Symbols Used in this Manual

At various times throughout this manual certain symbols will be used to highlight points of information which are intended to ensure the users personal safety and protect the integrity of equipment. Whenever any of the following symbols are encountered its associated note must be read and understood. Each of the symbols used will now be listed with a brief description of its meaning.

Hardware Warnings

1) Indicates that the identified danger **WILL** cause physical and property damage.

2) Indicates that the identified danger could **POSSIBLY** cause physical and property damage.

3) Indicates a point of further interest or further explanation.

Software Warnings

1) Indicates special care must be taken when using this element of software.

2) Indicates a special point which the user of the associate software element should be aware of.

3) Indicates a point of interest or further explanation.
• Under no circumstances will Mitsubishi Electric be liable responsible for any consequential damage that may arise as a result of the installation or use of this equipment.

• All examples and diagrams shown in this manual are intended only as an aid to understanding the text, not to guarantee operation. Mitsubishi Electric will accept no responsibility for actual use of the product based on these illustrative examples.

• Please contact a Mitsubishi Electric distributor for more information concerning applications in life critical situations or high reliability.

Abbreviations
The following definitions or abbreviations will be used throughout this manual.

• The FX-PCS/WIN-E software will be referred to as the FX-PCS/WIN-E or FXGP/WIN-E.

• The FX0, FX0S, FX0N, FX, FX2C, FX1S, FX1N, FX2N and FX2NC Series PLC may be referred to as the FX Series PLC or FX Series PLC.

• Input/Output may be referred to as I/O.

• Personal Computer may be referred to as PC

CONTENTS

1. Introduction ........................................................................................................... 1-1
   1.1 Main Software Features .................................................................................. 1-1
   1.2 Contents of Product Package and System Configuration ............................... 1-3
      1.2.1 Contents of product package ................................................................. 1-3
      1.2.2 Operation environment ......................................................................... 1-3
   1.3 Compatibility of Data File Types .................................................................... 1-5
   1.4 Comment Control ......................................................................................... 1-7

2. Installing FXGP/WIN-E ....................................................................................... 2-1
   2.1 Install Procedure (for Windows 3.1) ............................................................... 2-1
   2.2 Install Procedure (for Windows 95 or after) ................................................. 2-2

3. Main Operation .................................................................................................... 3-1
   3.1 Starting method ............................................................................................. 3-1
      3.1.1 Starting FXGP/WIN-E for Windows 3.1 ................................................ 3-1
      3.1.2 Starting FXGP/WIN-E for Windows 95 or After ................................... 3-1
   3.2 Initial Screen Operation ................................................................................. 3-2
   3.3 Main screens ................................................................................................. 3-3
   3.4 Terminating method (Exit) .......................................................................... 3-4

4. Work Windows and their Functions .................................................................... 4-1
   4.1 Construction and Types of Windows ............................................................. 4-1
      4.1.1 Construction of windows and relation between windows ....................... 4-1
      4.1.2 Handling of opened FXGP/WIN-E softwares at a time ......................... 4-2
      4.1.3 Split window .......................................................................................... 4-3
      4.1.4 Selecting a window from tool menu ...................................................... 4-4
   4.2 Functions of the Programming Window Group: View .................................. 4-5
   4.3 Functions of the Comment Window Group: View → Comment View ............. 4-6
   4.4 Functions of the Register Window: View → Register View ......................... 4-8
   4.5 Functions of the Device List Window Group: View → .................................. 4-9
   4.6 Functions of the Sampling Trace Window Group: PLC → Sampling Trace .... 4-10
   4.7 Functions of Device Monitor Window: Monitor/Test → ............................... 4-11

5. Guidance of Main Operations ............................................................................. 5-1
   5.1 Startup/Edit/window display ......................................................................... 5-1
   5.2 Program ......................................................................................................... 5-2
   5.3 Ladder circuit .............................................................................................. 5-3
   5.4 List ............................................................................................................... 5-4
   5.5 SFC ............................................................................................................. 5-4
   5.6 Instruction input ......................................................................................... 5-4
   5.7 PLC ............................................................................................................. 5-5
   5.8 Monitor ....................................................................................................... 5-6
   5.9 Comment ..................................................................................................... 5-6
   5.10 Printer ........................................................................................................ 5-7
   5.11 PC .............................................................................................................. 5-8
   5.12 Data compatibility and conversion .............................................................. 5-8
   5.13 Telephone line connection ....................................................................... 5-8
   5.14 Others ....................................................................................................... 5-9
## 6. Menu Bar Commands

### 6.1 File Menu Functions
- New ................................................................. 6-2
- Open ................................................................. 6-3
- Close and Open ................................................ 6-5
- Save ................................................................. 6-6
- Save As ............................................................. 6-7
- Print ................................................................. 6-8
- Print All ............................................................ 6-16
- Page Setup ....................................................... 6-17
- Print Preview .................................................... 6-18
- Displaying file use history .................................. 6-20
- Exit ................................................................. 6-21

### 6.2 Edit Menu Functions
- Undo ................................................................. 6-22
- Cut ................................................................. 6-23
- Copy ................................................................. 6-23
- Paste ............................................................... 6-23
- Delete ............................................................... 6-23
- Line Delete ....................................................... 6-24
- Line Insert ....................................................... 6-25
- Block Select ..................................................... 6-26
- NOP Overwrite ................................................ 6-28
- NOP Insert ....................................................... 6-28
- NOP Remove ..................................................... 6-29
- Device Name .................................................... 6-30
- Device Comment .............................................. 6-31
- Coil Comment ................................................... 6-32
- Block Comment ............................................... 6-32
- Device Registration ......................................... 6-34
- Edit cancel ....................................................... 6-35

### 6.3 Tools Menu Functions
- Contact ............................................................ 6-37
- Coil ................................................................. 6-39
- Function .......................................................... 6-41
- Wire ............................................................... 6-44
- Instruction ....................................................... 6-46
- All Clear ........................................................... 6-47
- Convert ............................................................ 6-48
- Default comments for special M/D .................... 6-49
- Comment settings ............................................ 6-50
- Setting of step of comment ............................... 6-52

### 6.4 Search Menu Functions
- Go to Top, Go to End ........................................ 6-53
- Device Name Search ......................................... 6-55
- Device Search .................................................. 6-55
- Instruction Search ............................................ 6-56
- Contact/Coil Search ......................................... 6-56
- Go to Step ....................................................... 6-57
- Go to State ....................................................... 6-57
- Character Search ............................................. 6-58
- Character Exchange ......................................... 6-58
- Change Device Number .................................... 6-59
- Change Bit Device ........................................... 6-60
- Swap Device Number ....................................... 6-60
- Tag Set ............................................................ 6-61
- Tag Jump ........................................................ 6-61
<table>
<thead>
<tr>
<th>Section</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5 View Menu Functions</td>
<td>6-62</td>
</tr>
<tr>
<td>6.5.1 Ladder View</td>
<td>6-63</td>
</tr>
<tr>
<td>6.5.2 Instruction View</td>
<td>6-64</td>
</tr>
<tr>
<td>6.5.3 SFC View</td>
<td>6-65</td>
</tr>
<tr>
<td>6.5.4 Inner Ladder View</td>
<td>6-66</td>
</tr>
<tr>
<td>6.5.5 Comment View</td>
<td>6-67</td>
</tr>
<tr>
<td>6.5.6 Register View</td>
<td>6-71</td>
</tr>
<tr>
<td>6.5.7 Tool Bar Status Bar Function Keys</td>
<td>6-75</td>
</tr>
<tr>
<td>6.5.8 Palette</td>
<td>6-76</td>
</tr>
<tr>
<td>6.5.9 Contact/Coil List</td>
<td>6-77</td>
</tr>
<tr>
<td>6.5.10 Device Used List</td>
<td>6-77</td>
</tr>
<tr>
<td>6.5.11 TC Setting List</td>
<td>6-78</td>
</tr>
<tr>
<td>6.5.12 Comment display</td>
<td>6-79</td>
</tr>
<tr>
<td>6.5.13 Display Setting</td>
<td>6-82</td>
</tr>
<tr>
<td>6.5.14 Zoom</td>
<td>6-82</td>
</tr>
<tr>
<td>6.6 PLC Menu Functions</td>
<td>6-83</td>
</tr>
<tr>
<td>6.6.1 Transfers</td>
<td>6-84</td>
</tr>
<tr>
<td>6.6.2 Register Data Transfers</td>
<td>6-86</td>
</tr>
<tr>
<td>6.6.3 PLC Memory Clear</td>
<td>6-88</td>
</tr>
<tr>
<td>6.6.4 Serial Setting (D8120)</td>
<td>6-88</td>
</tr>
<tr>
<td>6.6.5 PLC Keyword Current or Delete</td>
<td>6-89</td>
</tr>
<tr>
<td>6.6.6 Runtime Program Changes</td>
<td>6-91</td>
</tr>
<tr>
<td>6.6.7 Remote Run/Stop</td>
<td>6-94</td>
</tr>
<tr>
<td>6.6.8 PLC Diagnostics</td>
<td>6-94</td>
</tr>
<tr>
<td>6.6.9 Sampling Trace</td>
<td>6-96</td>
</tr>
<tr>
<td>6.6.10 Ports</td>
<td>6-99</td>
</tr>
<tr>
<td>6.7 Monitor/Test Menu Functions</td>
<td>6-100</td>
</tr>
<tr>
<td>6.7.1 Start monitor</td>
<td>6-101</td>
</tr>
<tr>
<td>6.7.2 Stop Monitor</td>
<td>6-103</td>
</tr>
<tr>
<td>6.7.3 Dynamic Monitor</td>
<td>6-104</td>
</tr>
<tr>
<td>6.7.4 Entry Device Monitor</td>
<td>6-105</td>
</tr>
<tr>
<td>6.7.5 Forced Y Output</td>
<td>6-108</td>
</tr>
<tr>
<td>6.7.6 Forced On/Off</td>
<td>6-109</td>
</tr>
<tr>
<td>6.7.7 Change Current Values</td>
<td>6-110</td>
</tr>
<tr>
<td>6.7.8 Change Setting Values</td>
<td>6-112</td>
</tr>
<tr>
<td>6.7.9 Display change of monitor data</td>
<td>6-113</td>
</tr>
<tr>
<td>6.8 Option Menu Functions</td>
<td>6-114</td>
</tr>
<tr>
<td>6.8.1 Program Check</td>
<td>6-115</td>
</tr>
<tr>
<td>6.8.2 Parameter Settings</td>
<td>6-116</td>
</tr>
<tr>
<td>6.8.3 Keyword Setting</td>
<td>6-119</td>
</tr>
<tr>
<td>6.8.4 PLC’s Mode Setting</td>
<td>6-119</td>
</tr>
<tr>
<td>6.8.5 Serial Setting (Parameter)</td>
<td>6-120</td>
</tr>
<tr>
<td>6.8.6 Printer Title</td>
<td>6-121</td>
</tr>
<tr>
<td>6.8.7 Device range Setting</td>
<td>6-122</td>
</tr>
<tr>
<td>6.8.8 Comment Move</td>
<td>6-123</td>
</tr>
<tr>
<td>6.8.9 PLC Type Change</td>
<td>6-124</td>
</tr>
<tr>
<td>6.8.10 Preferences</td>
<td>6-125</td>
</tr>
<tr>
<td>6.8.11 EPROM Transfer</td>
<td>6-126</td>
</tr>
<tr>
<td>6.8.12 Font</td>
<td>6-127</td>
</tr>
<tr>
<td>6.9 Window Menu Functions</td>
<td>6-128</td>
</tr>
<tr>
<td>6.10 Help Menu Functions</td>
<td>6-129</td>
</tr>
</tbody>
</table>
Contents

7. Creating Ladder and Instruction Programs ......................................................... 7-1
   7.1 Use of Programming Window ........................................................................... 7-1
   7.2 Creating Ladder Programs ............................................................................. 7-2
      7.2.1 Main operations necessary for entering ladder circuit symbols .......... 7-2
      7.2.2 Instruction type ladder circuit entry ....................................................... 7-11
      7.2.3 Essentials for programming ................................................................. 7-13
      7.2.4 Creating ladder circuit ladder diagram ................................................. 7-16
   7.3 Creating Instruction List Program .................................................................. 7-20
      7.3.1 Main operations necessary for entering instruction words ................. 7-20
      7.3.2 Creating instruction list ......................................................................... 7-29

8. Creating SFC Programs ..................................................................................... 8-1
   8.1 Description of SFC ......................................................................................... 8-1
      8.1.1 Types of SFC ......................................................................................... 8-1
      8.1.2 Program types ....................................................................................... 8-2
      8.1.3 Structure of SFC section ....................................................................... 8-3
   8.2 Creating SFC Programs .................................................................................. 8-4
      8.2.1 Main operations necessary for entering SFC symbols ......................... 8-4
      8.2.2 Cursor position and entering symbol .................................................... 8-5
      8.2.3 Main items necessary for creating SFC ................................................ 8-6
      8.2.4 Creating SFC ......................................................................................... 8-9

9. Remote Maintenance Using a Telephone Line ..................................................... 9-1
   9.1 System Configuration and Functions .............................................................. 9-1
      9.1.1 Remote access to PLC ......................................................................... 9-1
      9.1.2 Sending/receiving files ......................................................................... 9-3
      9.1.3 Caution ................................................................................................. 9-4
   9.2 Operation Procedures ..................................................................................... 9-5
      9.2.1 Remote access to PLC ......................................................................... 9-5
      9.2.2 File transfer ......................................................................................... 9-7
   9.3 Functions on Remote Menu ........................................................................... 9-10
      9.3.1 Connect ............................................................................................... 9-10
      9.3.2 Disconnect .......................................................................................... 9-14
      9.3.3 File transfer ......................................................................................... 9-15
      9.3.4 Environment → Modem ...................................................................... 9-17
      9.3.5 Environment → Logging File ............................................................... 9-20
   9.4 Data Setting on PLC Side for Remote Access ............................................... 9-21

Appendix A:
   PLC Device Tables .......................................................................................... A-1
      A-1: FX0/FX0S Series PLC .......................................................................... A-2
      A-2: FX0N Series PLC ................................................................................ A-3
      A-3: FX Series PLC (Version 2.30 or earlier) ............................................. A-4
      A-4: FX (Version 3.07 or later)/FX2C (All version) Series PLC ................. A-6
      A-5: FX1S Series PLC ................................................................................ A-8
      A-6: FX1N Series PLC ................................................................................ A-9
      A-7: FX2N/FX2NC Series PLC ................................................................. A-11

Appendix B:
   PLC Instruction Tables ..................................................................................... B-1
      B-1: Basic Program Instruction Table ............................................................ B-1
      B-2: SFC (STL) Program Instruction Table .................................................. B-1
      B-3: Applied Instruction Table ................................................................. B-2
Appendix C:
  Error Cord of PLC ................................................................. C-1

Appendix D:
  File converter ........................................................................... D-1

Appendix E:
  Associated Manuals ................................................................. E-1
<table>
<thead>
<tr>
<th></th>
<th>Introduction</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Installing FXGP/WIN-E</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Main Operation</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Work Windows and their Functions</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>Guidance of Basic Operations</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Menu Bar Commands and their Functions</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Creating Ladder and Instruction Programs</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>Creating SFC Programs</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Remote Maintenance Using Telephone Line</td>
<td>9</td>
</tr>
<tr>
<td>A</td>
<td>Appendix A: Device Lists</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>Appendix B: Instruction List</td>
<td>B</td>
</tr>
<tr>
<td>C</td>
<td>Appendix C: Error Code Tables</td>
<td>C</td>
</tr>
<tr>
<td>D</td>
<td>Appendix D: File Convertor</td>
<td>D</td>
</tr>
<tr>
<td>E</td>
<td>Appendix D: Associated Manuals</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>-------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Installing FXGP/WIN-E</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Main Operation</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Work Windows and their Functions</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Guidance of Basic Operations</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Menu Bar Commands and their Functions</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Creating Ladder and Instruction Programs</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Creating SFC Programs</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Remote Maintenance Using Telephone Line</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Appendix A: Device Lists</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Appendix B: Instruction List</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Appendix C: Error Code Tables</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Appendix D: File Convertor</td>
<td></td>
</tr>
<tr>
<td>E</td>
<td>Appendix D: Associated Manuals</td>
<td></td>
</tr>
</tbody>
</table>
1. **Introduction**

This software manual describes the outline connection of the FX-PCS/WIN-E software and the construction of the hardware system.

In addition, this manual describes the connection of various units and utilization of various the software functions, such as data file compatibility. Please read this manual before installing the software.

1.1 **Main Software Features**

FX-PCS/WIN-E is designed for the creation of programs used on Mitsubishi FX series PLC. This software runs on MS-Windows® 3.1, Windows® 95, Windows® 98, Windows® Millennium Edition, Windows NT® 4.0 Workstation, Windows® 2000, and Windows® XP.

**Programming:**

- **Three types of programming windows**
  
  Three types of programming tools are available for simultaneous operation. They are the ladder program edit window, list program edit window, and SFC program edit window. You can enter or edit data while switching the active window between the three different methods of programing.

- **Selection of the operation type in creating ladder diagrams**
  
  To create ladder diagrams via the ladder diagram editing window, you can use the conventional keyboard operation method. Using this method, use function keys to enter in ladder symbols. In addition to this conventional operation method, use the mouse operation method. To support the mouse operation method, there is a floating pallet of ladder symbols, menu commands, and function key guides.

  In addition, use the list editing window. You can create ladder diagrams by directly entering instructions.

- **Various tools for selecting instructions from list**
  
  This software has various tools that facilitate entry of instructions, such as contact symbols, coil instructions, and application instructions.

  Particularly for application instruction entry, the list of instructions will be displayed, and desired instructions can be selected from the list. Such interactive functionality will facilitate instruction entry operation.

- **Importance placed on keyboard operation**
  
  In some work places, the use of a mouse or pointing device may be difficult, however considering such a problem, we have designed this software so that most of operation can be performed using the keyboard.

- **Entire ladder diagram edit function**
  
  Modifying part of the diagram while looking the front and rear of the ladder block currently edited.

- **Splitting screen into two**
  
  Splitting the ladder diagram editing window, ladder circuit monitoring window, comment editing window, etc. into two (upper and lower windows) using the split handle at the lower section of the screen is possible. Each window can display the different sections of the document, and each screen can be scrolled individually. Use this function to display the separate sections of a document concurrently, or to monitor two sections simultaneously.
Monitoring, connection via telephone line, and others:

- **Monitoring function**
  Using the ladder program edit window and SFC program edit window, directly monitor the PLC status.

- **Remote access to the FX1S, FX1N, FX2N and FX2NC Series PLC through telephone line**
  Connect the FX1S, FX1N, FX2N and FX2NC Series PLC to the PC using the modem and telephone line. You can transfer or monitor the programs through the telephone line even if the PLC is away from the PC. This software has a telephone line connection and remote station control function, etc. In addition, if two PCs are connected to each other through the telephone line, data files can be transferred between PCs.

- **Activation of two or more application programs**
  The FX-PCS/WIN can activate two or more application programs at the same time, therefore, the uses can display another program by switching the active window, and move or copy data between the programs using the cut and paste functions.

- **Preview of printed documents**
  Before printing, preview the images of the printed documents, such as ladder diagrams, command lists, SFC diagrams, or other printable data.
1.2 Contents of Product Package and System Configuration

1.2.1 Contents of product package

The FX-PCS/WIN-E software package contains the following items:
1) 3.5-in. floppy disks (1.44 MB) (system disks that can activate the SW0PC-FXGP/ WIN-E system), 2 disks
2) This operation manual

The cable connecting the PC to the PLC and the interface unit are optional. Prepare a cable and interface unit applicable to the system, while referring to the configuration shown on the next page.

1.2.2 Operation environment

Table: 1.1

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>MS-Windows® 3.1 (386 enhance mode) English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 95¹ English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 98¹ English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition¹ English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® WindowsNT® 4.0¹² Workstation English version (Service Pack 3 or later)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000¹² English version</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP¹² English version (Home Edition or professional)</td>
</tr>
<tr>
<td></td>
<td>Operation® of each OS shall be assured in the PC to be used.</td>
</tr>
<tr>
<td>PC main body</td>
<td>MS-Windows® 3.1: 804 6SX or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 95: CPU i486SX or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 98: CPU i486DX (66 MHz) or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition: CPU Pentium 150 MHz or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® WindowsNT® 4.0: CPU i486 (25 MHz) or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000: CPU i486 (133 MHz) or better one</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP: Pentium 300MHZ or better one</td>
</tr>
<tr>
<td>Required memory</td>
<td>MS-Windows® 3.1: 8MB or more (16 MB or more is recommended.)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 95: 8 MB or more (16 MB or more is recommended.)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 98: 16 MB or more (32 MB or more is recommended.)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® Millennium Edition: 32 MB or more</td>
</tr>
<tr>
<td></td>
<td>Microsoft® WindowsNT® 4.0: 16 MB or more</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® 2000: 32 MB or more (64 MB or more is recommended.)</td>
</tr>
<tr>
<td></td>
<td>Microsoft® Windows® XP: 128MB or more</td>
</tr>
<tr>
<td>Hard disk capacity</td>
<td>Free space of 6 MB or more</td>
</tr>
<tr>
<td>Floppy disk unit</td>
<td>3.5-inch (2HD) floppy disk drive × 1 unit</td>
</tr>
<tr>
<td></td>
<td>A disk formatted as 1.44 MB shall be able to be read.</td>
</tr>
<tr>
<td>Display</td>
<td>Video display adaptor whose resolution is VGA or better</td>
</tr>
<tr>
<td>Interface</td>
<td>RS-232C serial interface (COM1 to COM9 shall be able to be changed over.)</td>
</tr>
<tr>
<td>Printer</td>
<td>Printer in accordance with the OS above</td>
</tr>
<tr>
<td>Others</td>
<td>Mouse or other pointing device</td>
</tr>
<tr>
<td>Applicable PLC</td>
<td>FX0, FX0S, FX0N, FX (FX2), FX2C, FX1S, FX1N, FX2N and FX2NC series PLC</td>
</tr>
</tbody>
</table>

*1: Long file names cannot be used.
*2: Remote Maintenance cannot support with these operating systems.
1.2.3 System configuration
The cable connecting the PC to the PLC and the interface unit is optional. Select an appropriate cable and interface unit while referring to the following description.

*1 When using FX1S, FX1N or FX2N PLC, PLC can connect to PC via the following expansion board
- FX1S, FX1N PLC: FX1N-422-BD - FX2N PLC: FX2N-422-BD

*2 When connecting the FX0n-232ADP or FX2NC-232ADP to FX1S, FX1N or FX2N PLC, the following expansion board need to be installed to the FX1S, FX1N or FX2N PLC.
- FX1S, FX1N PLC: FX1N-CNV-BD - FX2N PLC: FX2N-CNV-BD
1.3 Compatibility of Data File Types

Windows Data files
The programs and comments created by FXGP/WIN-E will be stored using the following file names:

<table>
<thead>
<tr>
<th>File name</th>
<th>Extension</th>
<th>Data stored in file</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program file *1</td>
<td>PMW</td>
<td>Parameter, program, file register, and comments</td>
</tr>
<tr>
<td>Comment file *2</td>
<td>COW</td>
<td>Device comments, block comments, coil comments, and device name</td>
</tr>
<tr>
<td>Register file *1</td>
<td>DMW</td>
<td>Data register and RAM file register</td>
</tr>
<tr>
<td>Sampling trace file</td>
<td>STW</td>
<td>Result of sampling trace</td>
</tr>
<tr>
<td>Printer title file</td>
<td>PTW</td>
<td>Printing style</td>
</tr>
<tr>
<td>Entry device monitor file</td>
<td>RMW</td>
<td>Content of Entry device monitor setting</td>
</tr>
</tbody>
</table>

For these data files, the special format for the FXGP/WIN-E is used. The SW1PC-FX/EE (AT compatible machine, DOS version) and the A6GPP/PHP cannot read these files.

*1: Only the program and register file data will be stored in the memory of the PLC and the optional memory cassette. Other files will be stored in the peripheral devices.

*2: The comments stored in the comment file are controlled by the peripheral devices.

Refer to Sec. 1.4 "Comment Control", to control the comments to be written to the program memory of the PLC.

Storing data in DOS file
To store data in a DOS file, select File and then Save As. Program files (.PMC) and comment files (.COK) are saved. Up to sixteen characters are allowed as a file name, thus, excessive characters are deleted.

Applicable DOS application program:
- SW1PC-FXGP/EE (designed for AT compatible machine)
Reading various data files
FXGP/WIN-E has a data file conversion function that converts the data files created by peripheral devices into Windows format.

Applicable software models:
• SW1PC-FXGP/EE (for AT compatible machine, DOS version)

Converted files:
• Program file (PMC)
• Data register file (DMD, DME, DMG)
• RAM file register (DMF)
• Comment file (COK)
• Sampling trace file (STA)
• Printer title file (PTL)

Unconverted files:
• Comment file (COH)
• Block comment file (COL)
• Diversion ladder circuit file (DAT)

Sequentially select File Open Save As Type and DOS Files (*.pmc) to open a file. When opened, the file will be automatically converted. Converted data can be stored as the FXGP/WIN-E file described on the previous page.
1.4 Comment Control

FXGP/WIN-E V2.00 or above has enabled storage of device comments in the parameter-set comment area of the program memory held in the PLC. The number of characters allowed in each comment written to the PLC is 16 maximum.

Comment control using FXGP/WIN-E:
If the FXGP/WIN-E is used, the peripherals can control both types of comments as the device comments; comments to be controlled by peripheral devices and comments to be written to the PLC.
These device comments can be entered using the input device comment window or comment list program edit window (refer to Sec. 6.2.13 and Sec. 6.5.5).

Setting comments to be written to the PLC:
The device comments to be controlled by the peripheral devices can be written in the parameter-set comment area of the program memory in the PLC.
The device comments can be written to the comment area until the comment area is fully loaded (the comment storage capacity is parameter set). The minimum unit for device comment storage is one comment.
- Parameter setting (see Sec. 6.8.2)
- Device comment entry and specifications (see Sec. 6.2.13)
- Setting of comments to be written to the PLC (see Sec. 6.3.9)
- Editing and displaying of device comments using device comment/name window (see Sec. 6.5.5)

Controlling programs including comments:
Programmable controller
- Reading from PLC:
The comments read from the PLC will be transferred to the device comment area of the FXGP/WIN-E. After transfer, the comments will be set as comments to be written to the PLC, and the corresponding device numbers shown in the list window will have an asterisk *.
- Writing to PLC:
The device comments to be written in the PLC (comments marked with an asterisk *) will be written in the comment area of the program memory in the PLC.

File
- Reading from program file:
Before opening a file, a confirmation message will appear and prompt whether the comments in the program memory should be transferred to the device comment area of the FXGP/WIN-E.
Click “Yes” to transfer the comments to the device comment area of the FXGP/WIN-E. When clicking “No”, the comments will be loaded to FXGP/WIN-E as program data, therefore, device comment area of the FXGP/WIN-E will not be subject to change. Even if comments are loaded to FXGP/WIN-E, transfer the comments into the device comment area later (refer to Sec. 7.8.8).
After clicking “Yes”, the comments are transferred to the device comment area, and regarded as the comments to be written to the PLC. In addition, the corresponding device numbers displayed in the list window will be marked with an asterisk *.
- Writing in program file:
The device comments to be written to the PLC (comments marked with an asterisk *) will be written to the program memory, and then stored in the file. All the device comments are stored in the comment file (.COW).
- Importing into comment file:
No comment data will be imported into the device comments if the comments are specified as the comments to be written to the PLC.
- Exporting from the comment file:
All the device comments in FXGP/WIN-E will be stored in the file.
ROM writer
Data will be read/written to/from the ROM writer in the same way as the PLC.

Exporting and Importing a comment file

Exporting and Importing a comment file export:

Only a comment file can be saved (expect) with a different name. An existing comment file can be read (import) into opened a program file.

Select the comment window, and execute the following operation.
Exporting : [File (F)] → [Export (E)]
Reading : [File (F)] → [Import (I)]

The comment type can be selected.
If there are comment types which should not be processed in import or export, remove a check mark in such comment types.

When a program file is saved or read, comment files are handled together. The export and import operations described above are required only when independent operations for comment files are required. (Refer to section 6.1.2 and 6.1.4.)
2. Installing FXGP/WIN-E

This section describes the FXGP-WIN-E installation procedure.
Before installing FXGP/WIN-E, install the necessary system software, such as MS-DOS and MS-Windows.

2.1 Install Procedure (for Windows 3.1)

1) Turn on the power of the PC and start Windows.
2) Insert the SW0PC- FXGP/WIN system floppy disk (1.44 MB) into the floppy disk drive.
3) Click Icon in the Program Manager dialog box.
4) Click “Run”.
5) Click in the Command Line box, and type “A: SETUP EXE”. (A= Floppy disk drive name)
6) Click the “OK” button.
7) Specify the directory where the FXGP/WIN-E should be installed. The default is C:\FXGPWIN
8) Follow the directions shown on the screen to install FXGP/WIN-E.

Uninstallation (for Windows 3.1):

- To delete this software (application program) from the hard disk, delete all the files from the installation directory, and FXGPWIN. INI files from the Windows directory using the file manager, etc. If program files are stored in the directory, be sure to back up the files before deleting this application program. If the program files are not deleted, it will be deleted together with the application program.

Initialize of FXGP/WIN-E:

1) FXGP/WIN-E is ended.
2) Delete the FXGP/WIN.INI files from the Windows directory.
3) Restart FXGP/WIN-E.
2.2 Install Procedure (for Windows 95 or after)

To install the FX-PCS/WIN-E component files from the 2 install disks. Note that this software cannot be run from the install (floppy) disk; this components must be installed onto hard-drive and subsequently run the software from the drive.

Note:
If the PC had been installed with FX-PCS/WIN-E, please uninstall it. If it is uninstalled before the install, the FX-PCS/WIN-E may not operate correctly. For uninstall, refer to below.

To install FX-PCS/WIN-E:
1) Restart Windows, and do not start-up any other applications.
2) Insert the SW0PC-FXGP/WIN-E bellow disk 1 into floppy disk drive.
3) Execute “setup32.exe.”
4) During the FX-PCS/WIN-E Setup dialog box, click “NEXT” whenever ready thus proceeding to the next panel.
5) If the destination folder need to be changed for the FX-PCS/WIN-E component files, click “Browse”, and use the browser to locate the appropriate destination.
6) Click “NEXT”.
7) If the Program folders need to be changed for the FX-PCS/WIN-E, enter the program folder name.
8) Click “NEXT” to begin the installation. When the process is complete, a message will follow indicating He successful installation of the FX-PCS/WIN-E software.
9) Click “OK” to finish to install.

Uninstallation:
It is possible to remove all of the FX-PCS/WIN-E component files installed on your system with the Install/Uninstall in the Control Panel.

To uninstall FX-PCS/WIN-E:
1) Click the “Start Menu”, choose “Setting” > “Control Panel”, and click it.
2) Double-click “Add/Remove Programs” icon.
3) Select “FX-PCS/WIN-E” in the “Install/Uninstall” tab, and click “Add/Remove”.
4) Click “Yes” to begin the uninstall of the FX-PCS/WIN-E component files. When the process is complete, a FX-PCS/WIN-E is successfully uninstalled from your PC.
3. Main Operation

This section describes the main operation of FXGP/WIN-E. Note that operation methods described in this section are not the special methods used for FXGP/WIN-E, but are the common operation methods used in a Windows environment. For an inexperienced windows operator, it is recommended that the manual for operating system should be used in conjunction with this manual.

3.1 Starting method

3.1.1 Starting FXGP/WIN-E for Windows 3.1

At the completion of install, the MELSEC-F FX application group will be created, and the FXGP/WIN-E start icon will be stored. The figure below shows the Windows 3.1 screen.

![Windows 3.1 Screen](image)

Double-click on this icon to start FXGP/WIN-E. The FXGP/WIN-E can activate two or more programs at the same time. For this reason, after starting FXGP/WIN-E, if the icon is double-clicked again, another FXGP/WIN-E will be started.

3.1.2 Starting FXGP/WIN-E for Windows 95 or After

This software cannot be run from the install (floppy) disk; this components must be installed onto hard-drive and subsequently run the software from the drive.

To start FX-PCS/WIN-E:

- Click the “Start Menu”, choose “Program” ⇒ “MELSEC-F FX Applications”, and click the name of the program you want to start.
- It is possible to also double-click a program icon to begin start-up.
3.2 Initial Screen Operation

1) File menu
   New
   Use this function to create a new program.
   Select the PLC type, and then click the “OK” button.
   A new file will appear on the display, and data entry is then possible.
   Open
   Use this function to read out program file from a floppy or hard disk.
   - Select a file type from the Save As Type box, and then select a drive, directory, and file name.
   - From the Save As Type box, select FXGP/WIN-E type program files (*.pmw) or DOS type program files (*.pmc).

2) PLC menu
   Program read
   This function reads the programs from the PLC connected to the PC.
   Before reading the programs, be sure to connect the PC to the PLC using the appropriate cabling and interface unit.
   Ports
   Use this function to select an RS-232 port from the PC in order to connect the PLC or ROM to the PC.

3) Remote
   See. Sec.9.3 "Functions on Remote Menu"
3.3 Main screens

This section describes the main screens of FXGP/WIN-E.

The Minimize button shrinks the size of the ladder program edit window, list program edit window, etc.

*1: When either Windows 95, Windows 98, Windows Millennium Edition, WindowsNT 4.0 Workstation, Windows 2000 or Windows XP are used, the FX icon will be displayed in place of the control menu box. In addition, the Minimize, Maximum, and Close buttons are different from those shown above.
3.4 Terminating method (Exit)

There are two program termination methods for FXGP/WIN-E.
For either method, if there is a non-stored file, the following confirmation dialog box will appear on the display:

1) Sequentially select File and then Exit.
2) Click in the control menu box of the application window, and then select Close.

When either Windows 95, Windows 98, Windows Millennium Edition, Windows NT 4.0 Workstation, Windows 2000 or Windows XP are used, click on the FX icon at the upper left corner of the box, or the Close button (×) at the upper right corner of the box.

The FXGP/WIN-E can open two or more the application windows.
Note that the Exit command is valid only for the application window currently active. If two or more programs are activated, sequentially end the programs by simultaneously activating the application windows.
4. Work Windows and their Functions

FXGP/WIN-E has six work windows that ensure efficient programming, thus various form of operations can be performed using such windows.

To create a program, open the appropriate window, then create the program. Monitoring is also possible. Various functions that can be executed in each window will be shown in the menu bar. The menu bar, therefore, is optimized for each work window.

4.1 Construction and Types of Windows

4.1.1 Construction of windows and relation between windows

The windows of FXGP/WIN-E can be divided into six types as shown below. Each window group can display two or more windows at the same time, and the active window can be switched in each group to proceed to the next window. Minimize the unused windows to keep it on screen until you use it. The minimized window looks like an icon.

- **Programming window group**
  - Ladder View
  - Instruction View
  - SFC View
  - Inner Ladder View

- **Comment window group**
  - Device Name
  - Device Comment
  - Block Comment
  - Coil Comment

- **Register window**

- **Device list window group**
  - Contact / Coil list
  - Device used list
  - TC setting list

- **Device monitor window**

- **Sampling trace window**
4.1.2 Handling of opened FXGP/WIN-E softwares at a time

In the FXGP/WIN-E, up two or more program files can open at a time. When either of the following operations is executed while the FXGP/WIN-E has been already started up and a program file is open, the second FXGP/WIN-E program can be started up.

- Started up a FXGP/WIN-E.
- Select [File (F)] → [New (N)].
- Select [File (F)] → [Open (O)].

Each of opened FXGP/WIN-E software at a time acts as an independent program file when changing over the active window. Or such programs can be displayed at a time when the window size is adjusted as shown in the figure below.

Among different application windows, programs and comments can be shared by using the cut & paste operation.
4.1.3 Split window

The ladder program edit, list program edit, comment and register windows can be split.
Split the window into two; upper and lower windows. These windows can display the respective sections.

Example of a ladder program edit window (in monitoring mode)

Move the split handle using the mouse to the split position.
Adjust the split position to adjust the upper and lower areas.

Use the scroll bar of each window to select the section to be displayed.

After you edit a ladder diagram in a split window, store the changed data, and then move to another window.
4.1.4 Selecting a window from tool menu

Select every work window of the FXGP/WIN-E from the menu bar. Because the menu bar is always optimized according to the contents of work, some menu items cannot be selected on the active work window.

View menu

PLC menu

Monitor/Test menu

Device monitor window (Refer to Section 4.6.)

Sampling trace window (Refer to Section 4.6.)

Device list window group (Refer to Section 4.5.)

Register window (Refer to Section 4.4.)

Programming window group (Refer to Section 4.2.)

Comment window group (Refer to Section 4.3.)

View menu

PLC menu

Monitor/Test menu
4.2 Functions of the Programming Window Group: View

The programming windows displays or edits programs. When a ladder or SFC program edit window is displayed, monitor the operation of the PLC.

Ladder View

Main functions:
- Displays ladder circuits.
- Creates or edits ladder circuits.
- Monitors the operation of the PLC.
- Displays or stores comments.
- Writes data during run mode.
- Prints ladder diagrams.

Instruction View

Main functions:
- Displays the instruction list.
- Creates or edits the instruction list.
- Displays or stores comments.
- Prints the instruction list.

SFC View

Main functions:
- Displays ladder circuits using the SFC format.
- Creates or edits SFC diagrams.
- Monitors operation of the PLC using the SFC diagram.
- Displays or stores comments.
- Prints the SFC diagrams Execute View (V) and then Inner Ladder View (A) in the SFC program edit window to display the inner state or transition ladder circuit.
4.3 Functions of the Comment Window Group: View → Comment View

The comment windows displays, stores, or edits the device names and comments.

Device comment / Device name

Main functions:

Device name
- Stores and edits device names.
- Displays device names.
- Prints device names.

A device name can be stored for each device number. Device names are can be used instead of the device numbers when creating a program or displaying a program.

Device comment
- Stores or edits device comments.
- Displays device comments.
- Prints device comments.

Device comments are added to the device numbers. Device comments are attached to all devices when the appropriate program is displayed.
Block comment

Main functions:
- Stores and edits block comments.
- Displays block comment.
A block comment can be stored for each circuit block.

Coil comment

Main functions:
- Stores or edits coil comments.
- Displays coil comments.
A coil comments can be stored for each OUT, SET, RST and applied instruction.
4.4 Functions of the Register Window: View → Register View

The register window displays data or file registers read from the PLC. Also, the register window edits data or file registers. On the completion of data editing, FXGP/WIN-E writes edited data to the PLC.

Examples of displayed windows

16-bit table type

Main functions:
- Displays or edits data or file registers read from the PLC.
- Creates or edits data or file registers, and writes the created or edited data to the PLC.
- Prints register data informat.

32-bit line type

There are two or more optional register display methods. If a different display method is specified, the displayed screen may differ from the example shown in the left figure.
4.5 Functions of the Device List Window Group: View →

The device list windows search for devices (X, Y, M, S, T, C, D, P, I, N, V, Z, etc.) incorporated into the PLC and display the devices that are used in programs.

**Contact/Coil list**

Main functions:
- Displays step numbers to clarify where the contacts and the output coils of the specified devices are used in the program.
- Displays device names and comments.
- Searches the program for specified contact or output symbols.
- Prints the list.

**Device used list**

Main functions:
- Displays whether the specified contacts and output coils are used in the program.
  (Specify a device, and conditions of 24 contacts and coils started from the specified device will be displayed.)
- Prints the list.

**TC setting list**

Main functions:
- Displays the timer or counter setting values written in the program.
  (Specify a device, and the setting values of 24 timers and counters started from the specified device will be displayed.)
- Prints the list.
4.6 Functions of the Sampling Trace Window Group: PLC → Sampling Trace

The sampling trace windows to display the device on/ off operation and data change detected by the sampling trace function. A time chart will be used as the display format.

Example of displayed window

Main functions:
- Displays the operation history of the specified device. The on/ off operation of the bit devices and the numeric values of the word devices will be displayed.
- Displays the detailed operation of the bar position.
- Prints the sampling trace result.
4.7 Functions of Device Monitor Window: Monitor/Test

Use the device monitor window to monitor the operation of the PLC devices on the screen.

Entry device monitor

Main functions:
- Monitors operation of the input relay (X), output relay (Y), auxiliary relay (M), state (S), timer (T), counter (C), data register (D), and index registers (V and Z).
- Up to 48 device numbers can be stored.
- The data register display type can be selected from the following types: 16/32 bit, binary, decimal, hexadecimal, ASCII, and floating point display types.
MEMO
5. Guidance of Main Operations

This section classifies, among explanation of operation methods and menu commands of the FXGP/WIN-E, functions and operations often used by keywords, and summarizes the execution method for each item. The contents described here may require a different operation or prerequisite depending on the actual operation status. Refer to this section as basic operations for the FXGP/WIN-E software.

5.1 Startup/Edit/window display

[Starting up the FXGP/WIN-E]
Choose the "FXGP/WIN-E" icon in the "MELSEC-F FX application" in the "Start Menu → program". (Refer to Section 3.1)

[Starting up two or more FXGP/WIN-E programs]
While one or two FXGP/WIN-E programs are running, click again the "FXGP/WIN-E" icon or execute [File (F)] → [New (N)] → [Open (O)]. (Refer to Sections 4.1.2 and 6.1.1.)

[Terminating the FXGP/WIN-E]
Choose [File (F)] → [Exit (X)]. (Refer to Sections 3.4 and 6.1.12.)

[Changing the display size of a ladder circuit or list on the edit window]
Choose [View (V)] → [Zoom (Z)]. Or [Option (O)] → [Font (F)]. (Refer to Sections 6.5.14 and 6.8.12.)

[Displaying the edit window in the split status]
Adjust the split handle provided at the bottom of the edit window in the vertical direction to split the screen. (Refer to Section 4.1.3.)

[Editing two or more programs at a time]
Start up two or more FXGP/WIN-E applications, then edit them while changing over the application window. Or edit them while collating them displayed side by side on the screen. (Refer to Section 4.1.2.)

[Changing over two or more windows efficiently]
In the Windows, use the key combinations "[GRPH] + [TAB]", "[GRPH] + [ESC]" and "[CTRL] + [TAB]" to change over the windows and change over the active window efficiently. (Refer to the Windows manual.)

[Changing the edit window type]
Choose the edit window type in [View (V)] menu. (Refer to Section 6.5.)
5.2 Program

[Creating a new program]
Choose [File (F)] → [New (N)]. (Refer to Section 6.1.1.)

[All-clearing a program]
Choose [Tools (T)] → [All clear (A)]. (Refer to Section 6.3.6.)

[Transferring a program to the PLC]
Choose [PLC (P)] → [Transfer (T)]. (Refer to Section 6.6.1.)

[Reading a program from a file]
Choose [File (F)] → [Open (O)]. (Refer to Section 6.1.2.)

[Saving a program to a file]
Choose [File (F)] → [Save (S)] (or [Save as (A)]). (Refer to Sections 6.1.4 and 6.1.5.)

[Checking for errors in a program]
Choose [Option (O)] → [Program check (C)]. (Refer to Section 6.8.1.)

[Printing a program]
Display the window of item to be printed, then choose [File (F)] → [Print (P)]. When printing two or more items at a time, execute [Print All (T)]. (Refer to Sections 6.1.6 and 6.1.7.)

[Setting/changing the program memory capacity]
Choose [Option (O)] → [Parameter Settings (P)]. (Refer to Section 6.8.2.)

[Overwriting NOP instructions to a program]
Choose [Edit (E)] → [NOP overwrite (W)] from the list program edit window. (Refer to Section 6.2.9.)

[Inserting NOP instructions into a program]
Choose [Edit (E)] → [NOP insert (S)] from the list program edit window. (Refer to Section 6.2.10.)

[Removing NOP instructions from a program]
Choose [Edit (E)] → [NOP remove (E)] from the list program edit window. (Refer to Section 6.2.11.)

[Displaying the program on the specified step]
Choose [Search (S)] → [Go to step (O)]. (Refer to Section 6.4.6.)

[Searching and displaying the specified device number]
Choose [Search (S)] → [Device name search (D)] (or [Contact/Coil search (O)]). (Refer to Sections 6.4.3 and 6.4.5.)

[Searching and displaying the specified the instruction, Contact or Coil]
Choose [Search (S)] → [Instruction search (I)] (or [Contact/Coil Search (O)]). (Refer to Sections 6.4.4 and 6.4.5.)

[Displaying program on the set position]
Select [Search (S)] → [Tag Set (G)] to store an arbitrary program position as the tag position. Select [Tag jump (J)] to display the program portion in the stored tag position. (Refer to Sections 6.4.13 and 6.4.14.)

[Replacing a device No.]
Choose [Search (S)] → [Replace Device (V)]. (Refer to Section 6.4.10.)

[Exchanging an a-/b-contact]
Choose [Search (S)] → [Change AB Contact (A)]. (Refer to Section 6.4.11.)

[Exchanging a device Number]
Choose [Search (S)] → [Exchange Device (E)]. (Refer to Section 6.4.12.)
### 5.3 Ladder circuit

**[Displaying the ladder program edit window]**
Choose [View (V)] → [Ladder view (L)]. (Refer to Section 6.5.1.)

**[Editing a ladder circuit]**
Pressing a function key or choosing symbol from [Tools (T)] menu on the ladder program edit window. (Refer to Sections 6.3 and 7.2.)

**[Editing a ladder circuit symbol by an instruction word program]**
Put the cursor in a symbol input position on the ladder program edit window, then input a instruction word from the keyboard in the same way as inputs to a list. (Refer to Section 7.2.2.)

**[Printing a ladder format]**
Choose [File (F)] → [Print (P)] from the ladder program edit window. When printing two or more items at a time, choose [Print All (T)]. (Refer to Sections 6.1.6 and 6.1.7.)

**[Converting a ladder circuit and handling a ladder error]**
Pressing the [f4] or choosing [Tools (T)] → [Convert (C)] from the ladder program edit window. (Refer to Sections 6.3.7 and 7.2.3.) When a ladder error occurs, modify the program to establish the ladder circuit. When destroying the contents of change and terminating the conversion mode, first, open the list program edit window, close the ladder program edit window once. (Refer to Sections 6.2.6, 6.2.7 and 7.2.3.)

**[Specifying a range assignment by program circuit blocks]**
Put the cursor in the range assignment start position, "[SHIFT] + [↑]/[↓]", "[SHIFT] + mouse dragging" or "[Edit (E)] → [Block select (B)] → [Up (U)]/[Down (D)]" after convert circuit a ladder. (Refer to Sections 6.2.8 and 7.2.4.)

**[Specifying a range assignment by ladder symbol]**
Put the cursor in the range assignment start position, then drag the mouse to the range assignment end position. (Refer to Section 7.2.4.)

**[Copying and pasting a ladder circuit]**
Put the cursor on a symbol to be copied or specify a range to be copied, then choose [Edit (E)] → [Copy (C)] (or [Paste (P)]). (Refer to Sections 6.2.8 and 7.2.4.)

**[Inserting a blank line for new ladder circuit]**
Put the cursor in an insertion position, then choose [Edit (E)] → [Line insert (I)]. (Refer to Section 6.2.7.)

**[Deleting the ladder circuit block]**
Put the cursor in a deletion position, select a ladder circuit block to be deleted by operating "[SHIFT] + [↑]/[↓]", "[SHIFT] + mouse dragging" or "[Edit (E)] → [Select Block (B)]", then choose [Edit (E)] → [Cut (T)] (or [Delete (D)]) or [DEL]. (Refer to Sections 6.2.8 and 7.2.4.)

**[Deleting a Instruction symbol]**
Put the cursor on a symbol to be deleted, then choose [Edit (E)] → [Cut (T)] (or [Delete (D)]). Or the [DEL] and [BS] keys are available also. (Refer to Sections 6.2.2, 6.2.5 and 7.2.4.)

**[Switching over the overwrite/insert mode for making program]**
Press the [INS] key on the ladder program edit window. The input characteristics are displayed at the lower right corner of the screen. (Refer to Section 7.2.4.)

**[Deleting a vertical line symbol]**
Put the cursor at the upper right corner of a vertical line, then pressing "[SHIFT] + [f8]", choosing "[Tools (T)] → [Line (W)]" or "[ | DEL] on the tool pallet". (Refer to Sections 6.3.4, 6.5.8 and 7.2.4.)

**[Inputting the pointer "P" or "I"]**
Put the cursor on the left side of a bus bar (that is, at the left edge of the screen), then press the [P] or [I] key. (Refer to Section 7.2.1.)
[Inputting horizontal lines/vertical lines continuously]
[GRPH] + [→]/[←]: Inputs horizontal lines. (Refer to Section 7.2.1.)
[GRPH] + [↑]/[↓]: Inputs vertical lines. (Refer to Section 7.2.1.)

[Deleting horizontal lines/vertical lines continuously]
[CTRL] + [GRPH] + [→]/[←]: Deletes horizontal lines. (Refer to Section 7.2.4.)
[CTRL] + [GRPH] + [↑]/[↓]: Deletes vertical lines. (Refer to Section 7.2.4.)

[Destroying the contents of ladder circuit edition]
Choose [Edit (E)] → [Edit cancel (E)], before converting ladder program. (Refer to Section 6.2.17.)

5.4 List

[Displaying the list program edit window]
Choose [View (V)] → [Instruction list view (I)]. (Refer to Section 6.5.2.)

[Editing a list]
Input an instruction word directly on the list program edit window. Or using a function key or [Tools (T)] → [Instruction (I)]. (Refer to Sections 6.3.5 and 7.3.2.)

[Printing a list]
Choose [File (F)] → [Print (P)] on the list program edit window. When printing two or more items at a time, execute [Print All (T)]. (Refer to Sections 6.1.6 and 6.1.7.)

5.5 SFC

[Displaying the SFC program edit window]
Choose [View (V)] → [SFC view (S)]. (Refer to Section 6.5.3.)

[Editing an SFC diagram]
Using function keys on the SFC program edit window. (Refer to Sections 6.3 and 8.2.)

[Converting an SFC program]
Press the function key [f4] or choose [Tools (T)] → [Convert (C)] on the SFC program edit window. (Refer to Sections 6.3.7 and 8.2.3.)

[Printing an SFC diagram]
Choose [File (F)] → [Print (P)] on the SFC program edit window. When printing two or more items at a time, choose [Print All (T)]. (Refer to Sections 6.1.6 and 6.1.7.)

5.6 Instruction input

[Inputting a program in an device name comment]
In programming, a device No. such as X0 can be input in an device name comment. During the input operation, input to the X0 an device name registered to the X0 while adding the "*" symbol on either side. Example: LS1; *LS1* is an example of device name registered to the X0. (Refer to Sections 7.2.1 and 7.3.1.)

[Inputting an applied instruction by selecting it from a list]
On the ladder program edit window, choose [Tools (T)] → [Function (F)] → [Reference (R)].
In a list program edit window, choose [Tools (T)] → [Instruction (I)].
(Refer to Sections 6.3.3 and 6.3.5.)
5.7 PLC

[Selecting the PLC type]
When creating a new file, when reading (up-loading) a program from the PLC, or when reading a file in the DOS version, the PLC type setting dialog box is displayed upon necessity. (Refer to Sections 6.1.1, 6.1.2 and 6.6.1.)

[Changing the PLC type]
Choose [Options (O)] → [PLC type change (H)]. (Refer to Section 6.8.9.)

[Writing (down-loading) a program to the PLC]
Choose [PLC (P)] → [Transfers (T)]. (Refer to Section 6.6.1.)

[Writing (down-loading) a register (data register/file register/RAM file register) to the PLC]
Choose [PLC (P)] → [Register data transfers (R)]. (Refer to Section 6.6.2.)

[Clearing the program, word device or bit devices in the PLC]
Choose [PLC (P)] → [PLC memory Clear (P)]. (Refer to Section 6.6.3.)

[Checking error status in the PLC]
Choose [PLC (P)] → [PLC diagnosis (D)]. (Refer to Section 6.6.8.)

[Checking the PLC operation time]
Choose [PLC (P)] → [PLC diagnosis (D)]. (Refer to Section 6.6.8.)

[Registering/changing the password for password protection in/to the PLC]
Choose [PLC (P)] → [PLC keyboard current, delete (K)]. (Refer to Section 6.6.5.)

[Changing the setting value of a timer/counter in the PLC]
Choose [Monitor/Test (M)] → [Change the setting value (C)]. (Refer to Section 6.7.7.)
Select one target device on the ladder program monitor window, then click the right button of the mouse to display the shortcut menu. (Refer to Section 6.7.1.)

[Changing the current value of a timer/counter/register in the PLC]
Choose [Monitor/Test (M)] → [Change the current values (C)]. (Refer to Section 6.7.8.)
Select one target device on the ladder program monitor window, then click the right button of the mouse to (switching) display the shortcut menu. (Refer to Section 6.7.1.)

[Forcing the output to ON/OFF]
Choose [Monitor/Test (M)] → [Force Y Output (F)]. (Refer to Section 6.7.5.)

[Forcing a device to set/reset]
Choose [Monitor/Test (M)] → [Force ON/OFF (R)]. (Refer to Section 6.7.6.)
Select one target device on the ladder program monitor window, then click the right button of the mouse to display the shortcut menu. (Refer to Section 6.7.1.)

[Changing a program in RUN mode]
Change only one ladder circuit block on the ladder program edit window, then press "[SHIFT] + [f4]" or choose ["Tools (T)" → "Runtime program changes (U)"] without converting the ladder circuit block. (Refer to Section 6.6.6.)

[RUN/STOP the FX1S/FX1N/FX2N/FX1NC/FX2NC PLC]
Choose [PLC (P)] → [Remote RUN/STOP (O)]. (Refer to Section 6.6.7.)
5.8 Monitor

[Monitoring a ladder program]
Choose [PLC (P)] → [Start monitor (M)] on the ladder program edit window. (Refer to Section 6.7.1.)

[Monitoring an SFC diagram]
Choose [PLC (P)] → [Start monitor (M)] on the SFC program edit window. (Refer to Section 6.7.1.)

[Monitoring device status]
Choose [Monitor/Test (M)] → [Entry device monitor (cursor) (E)]. (Refer to Section 6.7.4.)
Select one target device on the ladder program monitor window, then click the right button of the mouse
to display the shortcut menu.

[Monitoring the value of the data register, timer or counter]
Choose [Monitor/Test (M)] → [Entry device monitor (T, C, D device) (T)]. (Refer to Section 6.7.4.)
Select one target device on the ladder circuit monitor screen, then click the right button of the mouse to
display the shortcut menu.

[Monitoring the SFC program automatically]
Choose [Monitor/Test (M)] → [Start auto monitor (A)] on the SFC program edit window.
(Refer to Section 6.7.3.)

[Stopping the monitor]
Choose [Monitor/Test (M)] → [Stop Monitor]. (Refer to Section 6.7.2.)

[Saving and reading the registered contents of the Entry device monitor]
Choose [File (F)] → [Export (E)] (or [Import (I)]) on the device monitor window. (Refer to Section 6.7.4.)

5.9 Comment

[Displaying a program with comments]
While the ladder/list/SFC program edit window is displayed, choose [View (V)] → [Comment display (M)].
(Refer to Section 6.5.12.)

[Printing a list of the device names or device comments]
Choose [View (V)] → [Comment view (C)] → [Device comment/Device name (D)], and display the device
name/device comment edit window. Then choose [File (F)] → [Print (P)] (or [Print All (T)] for printing out two or more items at a time). (Refer to Sections 6.1.6, 6.1.7 and 6.5.5.)

[Printing a program with a comment]
Choose [File (F)] → [Print (P)] (or [Print All (T)]) for printing out two or more items at a time), then specify
comment type to be printed on the print setting dialog box. (Refer to Sections 6.1.6 and 6.1.7.)

[Registering an device name to a device]
While the ladder or list program edit window, etc. is displayed, choose [Edit (E)] → [Device name (N)]. Or
choose [View (V)] → [Comment view (C)], then input device name at a time. (Refer to Sections 6.2.12
and 6.5.5.)

[Registering a device comment]
While the ladder program list program edit window, etc. is displayed, choose [Edit (E)] → [Device
comment (V)]. Or choose [View (V)] → [Comment view (C)], then input device comments at a time.
(Refer to Sections 6.2.13 and 6.5.5.)

[Registering a coil comment]
While the ladder program edit window is displayed, put the cursor on a coil for which a comment is to be
registered, then choose [Edit (E)] → [Coil Comment (O)]. (Refer to Section 6.2.14.)
[Registering a block comment]
While the ladder program edit window is displayed, put the cursor on a ladder circuit block for which a comment is to be registered, then choose [Edit (E)] ⇒ [Block comment (M)]. (Refer to Section 6.2.15.)

[Inputting a device comment efficiently while making program]
Choose [Options (O)] ⇒ [Preferences (I)], then add check mark to “Executes consecutively during instruction input.” By this setting, the dialog box for device comment input is displayed after instruction was inputted. (Refer to Section 6.8.10.)

[Clearing comments]
Choose [View (V)] ⇒ [Comment view (C)] to display the device name/device comment edit window. Then choose [Tools (T) ⇒ [All clear (A)] and then select the cleared comments type. (Refer to Sections 6.3.6 and 6.5.5.)

[Using an existing comment file]
To export a comment file, choose [File (F)] ⇒ [Export (E)] on the comment edit window. To import the existence comment file, choose [File (F)] ⇒ [Import (I)] on the comment window. (Refer to Section 6.5.5.)

5.10 Printer

[Printing (active window)]
While an edit window to be printed is displayed, choose [File (F)] ⇒ [Print (P)]. (Refer to Section 6.1.6.)

[Printing (two or more windows)]
While an arbitrary edit window is displayed, choose [File (F)] ⇒ [Print All (T)]. (Refer to Section 6.1.7.)

[Previewing the print result]
While an edit window to be previewed is displayed, choose [File (F)] ⇒ [Print preview (V)]. Or click “Preview (V)” button on the print setting dialog box. (Refer to Sections 6.1.9 and 6.1.6.)

[Selecting print items]
Choose [File (F)] ⇒ [Print (P)] (or [Print All (T)] for printing out two or more items at a time), then specify an item (or items) to be printed. (Refer to Sections 6.1.6 and 6.1.7.)

[Limiting the print range]
Choose [File (F)] ⇒ [Print (P)] (or [Print All (T)] for printing out two or more items at a time), then specify the range to be printed. (Refer to Sections 6.1.6 and 6.1.7.)

[Attaching the front cover or the parameter setting]
Choose [File (F)] ⇒ [Print (P)] (or [Print All (T)] for printing out two or more items at a time), then add check mark to check box of the “Title (I)” or “Parameter settings list (E).” (Refer to Sections 6.1.6 and 6.1.7.)

[Changing the print size]
Choose [File (F)] ⇒ [Print (P)] (or [Print All (T)] for printing out two or more items at a time), then choose size from “Scale” pull down menu. (Refer to Sections 6.1.6 and 6.1.7.)

[Setting the margin, header and footer of the print paper]
Choose [File (F)] ⇒ [Paper setup (G)]. (Refer to Section 6.1.8.)

[Setting the paper size, direction and paper feed position]
Choose [File (F)] ⇒ [Printer setup (G)]. (Refer to Section 6.1.10.)

[Printing according to the paper size]
Choose “Auto” from “Scale” pull down menu on the print setting dialog box. By this setting, printing is executed according to the lateral width of the specified paper. (Refer to Section 6.1.6.)
5.11 PC

[Connecting the PC to the PLC]
As the RS-232C/RS-422 conversion interface, use the FX-232AWC or FX-232AW. The connection cable depends on the PC and connected PLC model; Refer to the corresponding explanation item. (Refer to Section 1.2.3.)

[Connecting the PC to the ROM writer]
Connect the COM port (RS-232C) connector in the PC to the RS-232C port in the ROM writer with a cable FX-232CAB-1. (Refer to Sections 1.2.3 and 6.8.11.)

[Selecting an RS-232C port in the PC]
Choose [PLC (P)] → [Ports (S)]. (Refer to Section 6.6.10.)

[Changing the password registered with a program in the PC]
Choose [Options (O)] → [Entry Code Setting (Y)]. (Refer to Section 6.8.3.)

5.12 Data compatibility and conversion

[Reading data in the DOS version]
Choose [File (F)] → [Open (O)], then select “*.PMC” from “File Type (T)” pull down menu. (Refer to Sections 6.1.2 and 3.1.3.)

[Saving data in a DOS format file]
Choose [File (F)] → [Save As (A)], then select “*.PMC” from “File Type (T)” pull down menu. (Refer to Sections 6.1.2 and 3.1.1.)

[Handling comments in the program memory]
Comments can be transferred to device comments. In this case, comments to be written to the PLC need to set. (Refer to Section 1.6.)

5.13 Telephone line connection

[Downloading, uploading and monitoring with the PLC through the telephone line]
Use the remote maintenance of the PLC. (Refer to Section 9.1.1.)

[Sending and receiving data through the telephone line]
Use the file transfer function. (Refer to Section 9.1.2.)

[Connecting to the telephone line]
For remote maintenance refer to Section 9.2.1.
For file transfer, refer to Section 9.2.2.

[Modem setting]
Choose [Remote (R)] → [Environment (E)] → [Modem (M)]. (Refer to Section 9.3.4.)

[Connecting the telephone line]
Choose [Remote (R)] → [Connect (C)]. (Refer to Section 9.3.1.)

[Setting the FX1S/FX1N/FX2N/FX2NC PLC for connection to the telephone line]
Set the PLC for remote maintenance. (Refer to Section 9.4.)

Note
The remote maintenance cannot be supported on the following operating systems.
Windows NT 4.0 Workstation
Windows 2000
Windows XP
5.14 Others

[Open recent file]
Displays the history of the file opened in the past. Select the arbitrary file from the displayed history and clicking. The file that has been opened in the past can be opened again.
(Refer to Paragraphs 6.1.11 and 3.1.1.)

[Tracing the device status in PLC]
The FX/FX2C/FX2N/FX2NC PLC is equipped with the sampling trace function which traces the device status in the PLC. For the condition settings and result display of the sampling trace function, choose [PLC (P)] → [Sampling trace (M)]. (Refer to Paragraph 6.6.9.)

[Downloading the data register value to PLC from PC]
Choose [PLC (P)] → [Register data transfers (R)] to download the value of a data register and file register created in the PC to the PLC. Because a file register is stored in the program memory, it can be transferred also by [Write (W)]. (Refer to Paragraphs 6.5.6 and 6.6.2.)

[Setting the parameter]
Choose [Options (O)] → [Parameter setting (P)] to set parameters including the area to hold devices in the program step/file register area in the PLC. (Refer to Paragraph 6.8.2.)

[Setting the file register area]
Choose [Options (O)] → [Parameter Setting (P)]. (Refer to Paragraph 6.8.2.)

[Specifying a display font]
Choose [Options (O)] → [Font (F)]. Specify "MS Sans Serif" usually because something may be wrong with the display if an alphabetic font is selected. (Refer to Paragraph 6.8.12.)

[Using help file]
Select the [Help (H)] menu or pressing the function key (f1) to display help file. (Refer to Paragraph 6.10.)

[Checking the version]
Choose [Help (H)] → [About SW0PC-FXGP/WIN-E (A)]. (Refer to Paragraph 6.10.)
MEMO
6. **Menu Bar Commands**

This chapter describes the functions of the commands shown on each of the pull-down menus. The commands shown on the pull-down menu depend on the edit window currently active and the operation status. In addition, the function of the same command may be changed when the active window is switched.

**Description of this section**

This section describes all the commands of each pull-down menu. The command-valid windows and the operation status will be shown first for each command.

**Showing valid commands:**

<table>
<thead>
<tr>
<th>OPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Window or operation status**

OPN : Opening
L/ V : Ladder View
L/ M : Ladder Monitor
I/ V : Instruction View
S/ V : SFC View
S/ M : SFC Monitor
C/ V : Comment View
R/ V : Register View
D/ L : Contact/Coil list, Device used list, TC setting list
D/ M : Device Monitor
SMP : Sampling trace

Check mark showing valid command
6.1 **File Menu Functions**

6.1.1 **New**

Use this command to create new program files.

- Choose “File” and then “New”. The PLC Type Setting dialog box will appear on the display.
- Select a PLC type, and then click the “OK” button.

- Commands, internal devices, and number of steps usable for programming depend on the PLC type specified in the PLC Type Setting dialog box.
6.1.2 Open

Use this command to read out a program file from a floppy or hard disk.

- Choose “File” and then “Open”. The Open dialog box will appear on the display.
- From the File Type box, select the FXGP/WIN-E program (*.pmw) or DOS files (*.pmc).
- Check the items set in the window, and then click the “OK” button.
- Any file types shown in the File Type box can be read. The dimmed file types, cannot be read as they do not exist.
- The data in the DOS file will be converted into the FXGP/WIN-E data, and read.
- Any file types shown in the File Type box can be converted. The dimmed file types, however, cannot be converted as they do not exist.
- Check the items set in the window. Then, after that, select the PLC type from the PLC Type box, and click the “OK” button.
- When a program is opened, if the program includes comments stored in the program memory, the message shown in the left figure will appear.
- In the dialog box, click “Yes” to transfer comments to the FXGP/WIN-E device comment area. In addition, the comments transferred will be set as the device comments to be written to the PLC. (See Sec. 1.4 and Sec. 6.3.9.)
- If “No” is clicked in the message window, comments will be loaded in FXGP/WIN-E as program data, therefore the device comment area will not be subject to change. However, after loading the comments as program data, converting them into the device comments is an option. In this case, convert the comments into device comments with reference to Sec. 6.8.8.
Files read simultaneously

- Open a program file (*.PMW type file) by executing the Open and Close commands. All the related files will be read.
- Files to be read:

<table>
<thead>
<tr>
<th>Specified file name</th>
<th>Files to read</th>
</tr>
</thead>
<tbody>
<tr>
<td>TEST.PMW</td>
<td>TEST.PMW  Program file</td>
</tr>
<tr>
<td></td>
<td>TEST.COW  Comment file</td>
</tr>
<tr>
<td></td>
<td>TEST.DMW  Register file</td>
</tr>
<tr>
<td></td>
<td>TEST.PTW  Printer title file</td>
</tr>
</tbody>
</table>

As described above, specify TEST.PMW and execute Open, four files shown above will be read simultaneously. For this reason, always specify the *.PMW type file even if an alternate file other than the program file, such as the comment or register file is needed.

If the *.COW, *.DMW, or *.PTW file is deleted for some reason, only the existing files will be read. Note that if the *.PMW type file is deleted, no files will be read even if some files are stored.

To read the sampling trace file (*.STW), choose [PLC (P)] → [Sampling trance (M)] → [Read from result file (R)].
6.1.3 Close and Open

Use this command to close the current program file and open another existing file.

1) If the program is not changed:
   • Execute File and then Close and Open. The current file will be closed immediately.
   • After closing the file, the File Open dialog box will appear on the display (see Sec.6.1.2).

2) If the program is changed:
   Execute File and then Close and Open. One of the following dialog boxes will appear on the display. The dialog box will depend on whether the file name is specified.

   - If the file name is already specified, the message in the dialog box will prompt whether the data should be overwritten on the specified file.

   - If the data is new and has no file name, the message shown in the dialog box will prompt whether the data should be stored in the untitled file.

To store the program data, specify the directory and the file name, then click the OK button. If no file name is specified, the data will be stored to a temporary file, Untitl**.pmw.

For a detailed description of Save As dialog box, refer to Sec.6.1.5.
6.1.4 Save

Use this command to overwrite the currently-displayed program data in the specified file.

1) When an existing file is open
   Execute File and then Save. The program data will be overwritten immediately continuous.
   At the completion of overwrite, the program will not be closed, therefore, edit of the program is possible.

2) When a new file is open
   Execute File and then Save As. The Save As dialog box will appear on the display.

Specify the directory and the file name, then click the OK button.
If no file name is specified, the data will be stored to a temporary file, Untitled**.pmw.

Files to be stored at the same time

- Store the program data in a *.PMW type file by executing the Close and Open, Save, and Save As commands. All the related files will be created or updated.
- Files to be stored

<table>
<thead>
<tr>
<th>Specified file name</th>
<th>Files to be stored</th>
</tr>
</thead>
<tbody>
<tr>
<td>[TEST.PMW]</td>
<td>TEST.PMW Program file</td>
</tr>
<tr>
<td></td>
<td>TEST.COW Comment file</td>
</tr>
<tr>
<td></td>
<td>TEST.DMW Register file</td>
</tr>
<tr>
<td></td>
<td>TEST.PTW Printer title file</td>
</tr>
</tbody>
</table>

As described above, specify TEST.PMW and then execute Save, four files shown above will be created or updated at the same time. For this reason, always specify the *.PMW type even if you want to store a file other than the program file, such as the comment or register file.

To save the sampling trace file (*.STW), choose [PLC (P)] → [Sampling trace (M)] → [Write to result file (W)].
6.1.5 **Save As**

Use this command to store current program data displayed in the specified file.

- To store data, specify the drive and directory.
- Enter the file name using the keyboard, or select a file name from the list of existing files.
- Store the file in a new directory (folder), enter the new directory (folder) name in the File Name box together with the file name. The specified directory will be created, and the file will be stored to the new directory using the file name entered.

**Example:** C:\DATA1\TEST.PMW

If a directory non-existing on the C drive is specified, the directory will be created.

**How to assign a file name**

- Input a file name in up to 16 characters. The FXGP/WIN-E does not support long file names available in the Windows.
- Due to the restriction in the operating system, the following characters are not allowed in file names.

  . , ; " < > | / \ * ?
6.1.6 Print

Clicking the Print command, enables the data in the currently-active window to be printed. Therefore, if you click the Print command when the ladder program edit window is active, the ladder diagram will be printed. If you print two or more items, such as the ladder diagram, instruction list, device use list, etc., click Print All.

Relation between active window and items to be printed

<table>
<thead>
<tr>
<th>Programming window group</th>
<th>Print dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Ladder View</td>
<td>Print</td>
</tr>
<tr>
<td>• Instruction View</td>
<td>Print</td>
</tr>
<tr>
<td>• SFC View</td>
<td>Print</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Comment window group</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Device name comment window</td>
</tr>
<tr>
<td>• Device comment window</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Register window group</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Register window</td>
</tr>
<tr>
<td>The data register is displayed:</td>
</tr>
<tr>
<td>The file register is displayed:</td>
</tr>
<tr>
<td>The RAM file register is displayed:</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Device use list window group</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Contact/ coil list window</td>
</tr>
<tr>
<td>• Device use list window</td>
</tr>
<tr>
<td>• TC setting value list window</td>
</tr>
</tbody>
</table>

* The set data of each Print dialog box will be stored in the printer title file (*.PTW) when the program file is stored.

To print two or more items, click File and then All Print in the corresponding window.
Printing ladder diagram
This section describes how to print programs using the format of ladder diagrams. When the ladder program edit window is active, execute File and then Print.

Set the comment type to be printed.

Specify the contact devices for printing.
Specify the coil devices for printing.
Click this button to reduce the line spacing. The printing area of each page will be increased.

Click this button to print the title setting page. Before printing, set the title setting page by clicking Option and Printer Title.

(1)

Click this button to print the parameter setting page. Before printing, set the parameter setting page by clicking Option and Parameter Setting.

Select the device comment printing position; above or below the device symbol.
Set the device comment display size. If the size is set as shown in the figure, the device comment of 10 characters × 5 lines will be printed.
Set the coil comment display size. If the size is set as shown in the figure, the coil comment of 20 characters × 7 lines will be printed.

Click Copy Settings on the previous screen to display this screen. This screen displays the comment display data set in the program edit window.
Printing instruction list
This section describes how to print programs using list program format. When the list program edit window is active, execute File and then Print.

Set the comment type to be printed.
(2)
Specify the program step printing range.
Click this button to print the parameter setting page. Before printing, set the parameter setting page by clicking Option and Parameter Setting.
Click this button to print the title setting page. Before printing, set the title setting page by clicking Option and Printer Title.

Specify the comment type to be added to the program list.

Starts printing.
Reads the comment display data set in the program edit window. Click Copy Settings to display the comment display status set in the program edit window.
Displays the image of the printed document on the preview screen.
Specify the printing size. Specify "Auto" or a percentage between "50% and 150%" (in increments of 5%). Specifying Auto, adjusts the number of characters in one line automatically depending on the width of the specified printing sheet.
Printing SFC diagram

This section describes how to print programs using the format of SFC diagrams. When the SFC diagram edit window is active, execute File and then Print.

Set the comment type to print the SFC diagram.

Set the internal ladder circuit printing data.

Starts printing.

Reads the comment display data set in the program edit window. Click Copy Settings to display the comment display status set in the program edit window.

Displays the image of the printed document on the preview screen.

Specify the printing size. Specify "Auto" or a percentage between "50% and 150%" (in increments of 5%). Specifying auto, adjusts the number of characters in one line automatically depending on the width of the specified printing sheet.

Click this button to print the state internal ladder circuit using ladder format.

Click this button to reduce the line spacing. The printing area of each page will be increased.

Click this button to print the parameter setting page. Before printing, set the parameter setting page by clicking Option and Parameter Setting.

Click this button to print the title setting page. Before printing, set the title setting page by clicking Option and Printer Title.
Specify the comment type to be added to the SFC diagram.

Specify the comment type to be added to the inner ladder diagram.

Click Copy Settings on the previous screen to display this screen. This screen displays the comment display data set in the SFC program edit window.

Click Copy Settings on the previous screen to display this screen. This screen displays the comment display data set in the inner ladder program edit window.
Printing Device comment / Device names
This section describes how to print the list of Device comments/Device names. When the device name window is active, click File and then Print.

Specify the device printing range.

Click this button not to print the unused devices in the program.

Click this button to print the parameter setting page. Before printing, set the parameter setting page by clicking Option and Parameter Setting.

Click this button to print the title setting page. Before printing, set the title setting page by clicking Option and Printer Title.

Specify the printing range.

Displays the image of the printed document on the preview screen. Click this button to use 2 line printing.

Click this button to use 2 line printing.

Specify the printing size. Specify "Auto" or a percentage between "50% and 150%" (in increments of 5%). Specifying auto, adjust the number of characters in one line automatically depending on the width of the specified printing sheet.

Starts printing.
Printing contact/coil list
This section describes how to print the contact/coil list. The list shows the program steps that use contacts or coils of devices. When the contact/coil list window is active, execute File and then Print.

Printing device use list
This section describes how to print the device used list. The list shows whether the contacts and coils of devices are used in the program. When the device use list window is active, click File and then Print.

To set data in the device used list printing dialog box, refer to “Printing contact/coil list” as described above.
Printing TC setting list

This section describes how to print the TC setting list. The list shows the timer/counter setting values used in the program. When the TC setting list window is active, click File and then Print.

To set data in the TC setting list printing dialog box, refer to “Printing contact/coil list” as described above.

Printing Register list

Print the list of current data register values. To print this list, activate the data register window. While displaying the data register window, click File and then Print.

To set the printing data in this window, refer to the data setting method as described in Sec. 6.5.6 “Register View”.
6.1.7 Print All

The Print command described in the previous section is valid only for the active window. The Print All command described in this section, however, can print all the specified items in the specified order while ignoring the active window. Execute File and then Print All. Execute these commands in any edit window.

- To store a printing item to the print list, position the cursor on the desired item in the Item List box. Then, click \( \text{✓} \) to move as item to the Print List box.
- To delete an item from as print list, position the cursor on the item in the Print List box. Then, click \( \text{✓} \) to delete as item from the print list and move it to the Item List box.
- The items will be printed in the order of items set in the Print List box. To change the order of items in the Print List box, position the cursor on the desired item, and click either the \( \text{[} \) or \( \text{]} \) buttons. The selected item will be moved up or down within the box to change the item order.
6.1.8 Page Setup

Before printing use this command to set page settings. For example, set the margin, header, footer, and page number printing position.

Use the Printer Setup command to set the paper size and printing direction.

Set the data for the header and footer without their own appropriate windows, then click Option and Printer Title. The header and footer will be printed at the upper and lower sections of the page as specified in the respective windows.
6.1.9 **Print Preview**

Use this command to display the image of the printed document on the preview screen. The image shown on the preview screen depends on the data set in the printing condition setting dialog box, Page Setup window, and Printer Setup window. To view the preview screen, open the related window, then click File and Print Preview.

Click this button to open the printing condition setting dialog box of the corresponding work window. Click this button to go to the next page.

Click this button to go to the previous page.

Switches the number of pages displayed on the screen. You can select 1 page or 2 pages.

Click this button to enlarge the screen size.

Click this button to reduce the screen size.

Displays the image of the printed document.
Clicking print and print all will allow for the preview screened to be viewed. Click Print and then Print All.

If the preview screen reveals that the paper size is too small to contain all the data, adjust the page data as follows:
- Click Page Setup to open the Page Setup window, then adjust the margins.
- Click Printer Setup to open the Printer Setup window, then adjust the paper size and printing direction.
- Open the printing condition setting dialog box of the corresponding item, and then adjust the zoom rate.
6.1.10 Printer Setup

Use this command to set the printer type, paper size, and printing direction.

Displays the main printer set by the Windows control panel.

You can select any printer from those stored in Windows.

Select the printing direction. Specify the paper size and paper feed method.

Click this button to open the detailed printer data setting dialog box. Data setting depends on the printer. Refer to the instruction manual of the printer to set data.

Click File to display the file use history. Four files previously used will be displayed in the order of time elapsing. Click one of these files, to directly open the file.

6.1.11 Displaying file use history

Click File to display the file use history. Four files previously used will be displayed in the order of time elapsing. Click one of these files, to directly open the file.
6.1.12 Exit

Use this command to exit FXGP/WIN-E.

Select File and Exit to leave FXGP/WIN-E.

If a file is not stored.

If all the files are stored.

Exit

Note

- FXGP/WIN-E can open two or more application windows simultaneously.

Note that the Exit command is valid only for the active application window. If two or more programs are activated, end the programs by activating the application windows.
6.2 Edit Menu Functions

The Edit menu has various commands as shown below. Note that the function of the same command may be changed when the active window is changed.

1) Cut-and-paste functions used for ladder diagrams, instruction lists, etc.
2) Cut-and-paste functions used for comments in character strings.
3) Line insert and delete functions used for ladder diagrams
4) All edit functions for NOP instruction used in editing lists
5) Comment storing and edit functions

Note

<How the cut & paste function works in the Windows environment>

- In the Windows environment, various editions are allowed using the cut & paste, copy and deletion functions. The outline of such operations are as shown below.

1) a-contact [LD, AND]
2) b-contact [LDI, ANI]
3) Parallel a-contact [OR]
4) Parallel b-contact [ORI]
5) Load/And pulse contact [LDP, ANP]
6) Load/And falling pulse contact [LDF, ANF]
7) OR pulse contact [ORP]
8) OR falling pulse contact [ORF]
9) OUT coil [OUT]
10) Special coil [SET, RST, or applid instruction, etc.]
11) Horizontal line
12) Vertical line
13) INV instruction [INV]
14) Vertical line deletion

* Because data transferred to the clipboard is expressed in a special format, its contents are not displayed even if the clipboard is opened.
### Menu Bar Commands 6

<table>
<thead>
<tr>
<th>OPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

#### 6.2.1 Undo

Undo the last operation to return to the previous condition.

#### 6.2.2 Cut

Cuts the selected program or characters.
The cut program or characters will be stored to the clip board, therefore, paste the cut program or characters to another place.

#### 6.2.3 Copy

Copies the selected program and characters to the Windows clip board.
The copied data can be pasted to another place using the Paste command.

#### 6.2.4 Paste

Pastes the programs and characters to the cursor position only if the data is stored to the Windows clip board via the Cut or Paste command.

#### 6.2.5 Delete

Deletes the selected program and characters.
The deleted data will not be stored to the Windows clip board. For this reason, the Paste command will not be valid for deleted data.

---

### Note

- The following command will not be valid in various windows.
  - **Undo**: Invalid in the SFC diagram edit windows.
  - **Copy**: Invalid in the device name comment and SFC diagram edit windows.
  - **Cut**: Invalid in the SFC diagram edit window.
  - **Paste**: Invalid in the SFC diagram edit window.
6.2.6 Line Delete

Use this function to delete the right side of the cursor position. After deleting, enter a new program into the null section, or edit the ladder circuit so that the ladder circuit block is valid. After that, click Convert. Note, this command cannot be used for any one-line ladder circuit block in the program step-completed status. To delete such one-line ladder circuit block, two or more ladder circuits, use the Block Select command described later, and then execute Delete.

Position the cursor in any position along the line.

Execute Edit and then Line Delete.

In this condition, execute Tools and then Convert if the intention to only delete are line.
If the circuit is not complete, complete the circuit first, then execute Tools and then Convert.

The ladder circuit will be determined after conversion.

Remedy for Ladder conversion error

If a circuit error is detected after executing the ladder circuit conversion, correct the circuit, then convert the circuit to determine the Ladder program.
To delete the circuit data you edited and to cancel the ladder diagram editing mode, click Edit and then Edit Cancel. Or execute Edit Cancel using the right button on the mouse. Note that after executing Edit Cancel, all the circuit data that was edited in the ladder diagram window will be deleted if the data is not converted.
6.2.7 Line Insert

Use this command to insert a null line above the specified position.

Position the cursor on the line. A null line will be inserted just above the cursor-positioned line.

Execute Edit and then Line Insert.

A null line will be inserted directly above the cursor-positioned line. To insert two or more null lines, simply repeated Line Insert.

Enter a necessary circuit in the null line, then execute Tools and then Convert. The circuit will be determined after conversion.

**Line insert into step 0**

If a null line is in front of step 0 or at the top line of the Ladder program, be sure to enter new program there, then convert the ladder diagram of the circuit.

If there is a null section, execution of conversion will cause a circuit error. If a circuit error is displayed after the conversion, click the control menu box at the upper left corner of the window to close the window, then open the window to display the ladder diagram again.

Be careful! When you close the ladder diagram window, all the edited data will be erased if it is not converted.
6.2.8 Block Select

Use this command to specify a ladder circuit block above or below the cursor position. This command can also be executed using the "+" keys or keys + mouse dragging.

For the specified block, the following commands will be valid:
- Edit → Cut : Cuts out the specified block, and then stores it in the clip board.
- Edit → Copy : Copies the specified block in the clip board.
- Edit → Delete: Deletes the specified block.

Specify the ladder circuit block above the cursor including the cursor position.
Specify the ladder circuit block below the cursor including the cursor position.
Position the cursor on a line to specify a block.

Execute Up.

The cursor-positioned block will be specified.

Execute Up again.

The block just above the currently-specified block will be added to the currently-specified block. Repeatedly execute the Up command, to increase the specified block area in the upper direction (lower direction if the Down command is executed).

At the completion of block specification, execute Cut, Copy, or Delete command. When the Cut or Delete command is executed, the cut or deleted result will be stored in the program software, therefore, it is not necessary to convert the program.
6.2.9 NOP Overwrite

Use this command to overwrite the NOP instructions in the specified range of steps at a time. All the instructions currently stored in the specified range will be replaced with the NOP instructions.

6.2.10 NOP Insert

Use this command to insert NOP instructions to the specified range of steps. When NOP instructions are inserted, the instructions currently set in the specified range will be shifted in the lower direction depending on the specified number of steps. In addition, the block and coil comments will be shifted the instructions. If the number of steps exceeds the specified upper limit number, the insertion of NOP instructions will not be possible.
6.2.11 NOP Remove

Use this command to erase all the NOP instructions from the entire program area or the specified range of the steps. The non-erased instructions will be shifted in the upper direction. The step numbers of the non-erased instructions will be reduced depending on the number of erased steps. In addition, the block and coil comments will also be shifted following the shifted instructions.

**Note**
Specify the step range using the cursor on the list edit screen, thus, the specified step range will be automatically displayed in the Setting Range box of the corresponding dialog box.
6.2.12 Device Name

Use this command to store the name of the selected device.

To store a device name, position the cursor on the device and then execute Edit and then Device Name.

- Number of characters: Up to 8 characters can be used for the device name.
- Character type: Alphanumeric characters and symbols (+ - * / = . ? # $ % & : ; _)

In programming mode, device names can use in place of the device numbers, such as X000 and M10. For this reason, use of the same names for two or more devices will not be possible.

You can also store the device name by sequentially executing View, Comment View, and then Device Name.

Example:

Device names can be displayed in the programs in place of the device numbers.

Device names and device comments are added to the device numbers. For this reason, when a step is subject to change or the cut-and-paste command is executed, device names and comments will be erased or moved together with the respective device numbers.
6.2.13 Device Comment

Use this command to store the device comments for the selected device.
To store a device comment, position the cursor on the device in the ladder diagram display window, and then execute Edit and then Device Comment.

- Number of characters: Up to 50 characters can be used for the device comment.

- After inputting ladder circuit symbols on the ladder circuit edit screen, the device comment input window can be displayed consecutively. (Refer to Section 6.8.10.)
- Device comments can be edited in a list by choosing [View (V)] → [Comment (C)] → [Device Comment (D)].
- A device comment executed by this command is controlled on the peripheral equipment side. When making a comment to be written to the PLC, observe the following cautions, and refer to section 1.4 and section 6.3.9.
- Cautions on inputting a comment to be written to the PLC
  1) When data should be shared by the A6GPP, A7PHP and programming software in the DOS version, input a comment in the following range.
     Number of characters : 15
     Character type : Numbers, alphabets and some symbols (., -, +, ? and =)
  2) If a comment is displayed in peripheral equipment not supporting characters of the comment, such characters may be displayed abnormally. If a comment exceeds 16 characters, only the portion up to 16 characters is written to the PLC, and the 17th character and later are ignored.
6.2.14 **Coil Comment**

Use this command to store coil comments for the selected output and application instructions. To store a coil comment for an output or application instruction in the ladder program edit window, position the cursor on the instruction or in front of the instruction, and then execute Edit and then Coil Comment.

- To store a coil comment, use any number of characters and any character type.
- Enter coil comments at the completion of a ladder circuit conversion. If the ladder circuit conversion is not complete, no coil comment can be entered.
- To copy a coil comment, specify the copy range and then execute Ctrl+C (cut). After that, execute Ctrl+V (paste) in the copy-to comment dialog box.

![Coil Comment Dialog](image)

6.2.15 **Block Comment**

Use this command to store block comments for the cursor-positioned ladder circuit block. To store a block comment for a ladder circuit block in the ladder program edit window, position the cursor at any position of the ladder circuit block, and then execute Edit and then Block Comment.

- To store a block comment, use any number of characters and any character type.
- Block coil comments at the completion of ladder circuit block conversion. If ladder circuit block conversion is not complete, no coil comment can be entered for the ladder circuit block.
- To copy a block comment, specify the copy range and then execute Ctrl+C (cut). Then, execute Ctrl+V (paste) in the copy-to comment dialog box.
Using the following ladder circuit and the machine can be started or stopped.

Coil comment and block comment

Coil and block comments can be added to step numbers if the steps include the corresponding coils or blocks. For this reason, if a step is subject to change due to a coil or block insertion or deletion, the corresponding coil or block comment will be also inserted or deleted. In addition, if an instruction step or ladder circuit block itself is deleted, the comments stored in the step or block will be deleted at the same time.
6.2.16 Device Registration

Use this command to store device numbers in the device store/monitor screen. To store a device number, position the cursor at a desired position on the device monitor screen, and then execute Edit and then Device Registration. The device number will be stored in the cursor position on the screen.

- Enter the device number to be stored, changed, or deleted.
- Click this button to store the device number in the monitor screen.
- Deletes the device number from the Device box. The data set in the Number of Devices box, however, will not be deleted.
- You can store two or more device numbers starting from the number set in the Device box. Data entry range: 1 to 48.
6.2.17 Edit cancel

Use this command to delete the ladder circuit data that was edited in the ladder program edit window.

Before editing
(The Ladder circuit is already converted, therefore the Ladder circuit determined.)

Editing ladder diagram

Click Edit and then Edit Cancel.

After edit cancel
(The ladder diagram will return to the pre-editing condition.)
6.3 **Tools Menu Functions**

Use the commands in the Tools menu to enter symbols in ladder or SFC diagrams or to convert ladder circuit blocks in the diagrams.

---

**Note**

For preferential keyboard operation, use functions keys that have the same functions as the Tools menu commands.

Circuit symbols, instructions, and SFC diagrams are allocated to the functions keys, and these functions keys depend on the edit window.

**Function keys in ladder program edit window**

- Floating tool box
- Convert key
- Circuit symbol entry key
6.3.1 Contact

Use this command to enter the a-contact and b-contact.

Note that this command has the same function as function keys \( F_5 \) \((\uparrow\downarrow)\), \( F_6 \) \((\uparrow\downarrow)\), \( F_2 \) \((\uparrow\downarrow)\), and \( F_3 \) \((\uparrow\downarrow)\).

Applicable devices

X (input relay)  M (auxiliary relay)  T (timer)
Y (output relay)  S (state)  C (counter)

In making program, an device name can be used instead of a device No. (Refer to Section 7.2 and “Note” in the next page.)
### Entering contacts using Reference command

Click the Reference command. The following dialog box will appear on the display.

In this dialog box, the device names already stored will be displayed. Click a device name using the mouse button to enter the device.

<table>
<thead>
<tr>
<th>OPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **Switch the device type**
- **Shows the device names already stored.**
  Click the mouse button on a device name to enter the device.
6.3.2 Coil

Use this command to enter output coil instructions.

Note that this command has the same function as function key [F5] (-{-}).

- **Entering bit device**
  - **Applicable devices:**
    - Y (output relay)
    - M (auxiliary relay)
    - S (state)

- **Entering timer and counter**
  - **Applicable devices:**
    - T (timer)
    - C (counter)

- **Formats for data entry:**
  - T0 [space] K*** (Specifies a contact.)
  - T3 [space] D*** (Specifies an interval.)
  - C5 [space] K*** (Specifies a constant.)

- Use device names in place of the device numbers (see Sec.7.2 and the following Note).
- Use the Function command (as described in Sec.6.3.3) to enter the following special coil instructions:
  - SET/RST
  - PLS/PLF
  - MC/MCR
  - STL/RET
  - END
Entering coils using Reference command

Click the Reference command. The following dialog box will appear on the display. In this dialog box, the device names already stored will be displayed. Click a device name using the mouse button to enter the device.

Enter a device number, such as T* and C*, in this box. Direct entry is also possible.

Enter a constant, such as K** and D**, in this box. Direct entry is also possible.

Switch the device type. Shows the devices names already stored. Click the mouse button on a device name to enter the device.
6.3.3 Function

Use this command to enter application and special coil instructions. Note that this command has the same function as function key F8 (- [ ] -).

Entering special coil

Applicable instructions:
- SET/ RST
- PLS/ PLF
- MC/ MCR
- STL/ RET
- END

Formats for data entry:
- SET[space] Y5
- PLS[space] M200
- MC[space] N0[space] M30
- STL[space] S20

For the following instructions, it is not necessary to enter device numbers:
- RET, END

Entering application instructions

Formats for data entry:
- MOV[space] K200[space] D0
  (16-bit MOV instruction)
- MOVP[space] K200[space] D0
  (16-bit MOV instruction of pulse execution type)
- DMOV[space] K40000[space] D0
  (32-bit MOV instruction)
FX Series Programmable Controllers

Menu Bar Commands 6

<table>
<thead>
<tr>
<th>DPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

DMOV[P] K40000 [space] D0
(32-bit MOV instruction of pulse execution type)

FNC12[P] K200 [space] D0
(16-bit MOV instruction)

FNC12[P] K200 [space] D0
(16-bit MOV instruction of pulse execution type)

FNC12[P] K40000 [space] D0
(32-bit MOV instruction)

FNC12[P] K40000 [space] D0
(32-bit MOV instruction of pulse execution type)
Entering coils using Reference command:

Click the Reference command. The following dialog box will appear on the display. Using this dialog box, you can select instructions from the list, or look up the functions of operands.

Select an instruction from the list to enter an instruction in this box. In addition, directly enter an instruction or FNC number in this box.
Example: ZCP, DZCP, FNC11, FNC11P

Select an instruction.

Shows the instruction types.

Click this button to use the instruction as the 32-bit type or pulse execution type.

Describes the operand necessary for each instruction type. The system enters the data entry waiting status.

Specify operands, or enter device names.
6.3.4 Wire

Use this command to enter vertical and horizontal lines, INV instruction, or delete vertical lines.

Note that this command has the same function as function keys $\text{[Shft]} + \text{F9} \ (l)$, $\text{F8} \ (+)$, $\text{Shft} + \text{F7} \ (-/-)$, and $\text{Shft} + \text{F8} \ (l \ Delete)$.

---

Entering vertical line
A vertical line will be entered at the lower left section of the cursor.

Entering horizontal line
A horizontal line will be entered at the cursor position.

Entering INV instruction
An INV instruction will be entered at the cursor position.
<p>| | | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DPN</td>
<td>L/V</td>
<td>L/M</td>
<td>I/V</td>
<td>S/V</td>
<td>S/M</td>
<td>C/V</td>
<td>R/V</td>
<td>D/L</td>
<td>D/M</td>
<td>SMP</td>
<td></td>
</tr>
<tr>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Deleting vertical line

A vertical line will be deleted from the lower left section of the cursor.
6.3.5 Instruction

From the list edit screen, directly enter instructions and device numbers using the keyboard. Use the Instruction command to edit programs using lists or references displayed in the dialog box.

Select an instruction from the list to enter an if into this box. In addition, it directly enter an instruction or FNC number into this box.
Example: LD, AND, OUT, ZCP, DZCP, FNC11, FNCD11P

Shows the instruction types.
Select an instruction.
Click this button to use the instruction as either a 32-bit or pulse execution type.
Specify operands, or enter device names.
Describes the necessary operand for each instruction type. The system enters the data entry waiting status.
6.3.6 All Clear

Use this command to clear the active work window.

Clearing program area

Applicable windows:
- Ladder program edit window
- List program edit window

Clearing comment area

Applicable windows:
- Device name comment window
- Device comment window

To erase coil comments and block comments, open the device name comment window or device comment window. Note that the set comment data to be written in the PLC will be erased also.

Clearing register area

Applicable windows:
- Register window
  When data registers are displayed
  When file registers are displayed
  When RAM registers are displayed
6.3.7 Convert

Use this command to convert ladder or SFC program data into list program.

Note that this command has the same function as function key \( F_4 \) (Convert).

- If a ladder or SFC program created on screen is not converted, it is only a diagram, therefore it is not valid.
  To make the diagram valid, the diagram should be converted into a program (list program). If the list edit function is used for programming, thus, conversion will not be needed. This is due to the list edit mode, that requires a direct creation of instruction list by entering instructions.

- Convert the diagram when:
  1 ) The created data of the ladder or SFC diagram is checked.
  2 ) After creating a ladder or SFC diagram convert the diagram into instruction list, then edit the list.
  3 ) Close the ladder or SFC program edit window when minimizing the window, conversion will not be needed.
  4 ) Finish programming with FXGP/WIN-E by executing Close or Exit.

- Be careful! Non-converted ladder or SFC diagrams may be erased if an operation error is made.

- When "Convert and run time program changes" is selected via "Option → Preferences", "Run time program changes" is executed after "CNV F4" or "Tools → convert" is executed.

Conversion of ladder or SFC diagram into instruction list:

Reverse conversion will be performed to display the ladder diagram from instruction list.
6.3.8 Default comments for special M/D

Use this command to store default comments in the special auxiliary relay comment area (M8000 and onwards) or the Diagnostic register comment area (D8000 and onwards) using the device comment/name window.

If device comments are already stored in the specified area, executing this command will overwrite the default comments, therefore, device comments previously stored will be erased.

Specify the intended comments to be stored.

Example: Comments stored in special/diagnostic relay comment area
6.3.9 Comment settings

This command is used in the device comment/name window to specify the device comments that are to be written to the PLC.

To write the device comments to the PLC, 1 block or more of the comment area should be secured. To secure the comment area, click Option and then Parameter Settings.

Enter the same type of device in the From and To boxes. To specify two or more types of devices, such as input (X) and output relays (Y), select the devices for each type of device.

If the same device number is entered in the From and To boxes, only one device comment will be set.

To specify non-continuous device numbers, execute this command repeatedly. Or in the device comment/name window, click the right button of the mouse on each device.

Specifying a device that does not have a device comment, allows for the number of set device comments to be increased, and the free storage area will be reduced for the device comments. For this reason, do not specify any unnecessary devices.

Cautions on inputting a comment to be written to the PLC
1) When data should be shared by the A6GPP, A7PHP and programming software in the DOS version, input a comment in the following range.
   Number of characters: 15
   Character type: Numbers, alphabets and some symbols (., -, +, ? and =)

2) If a comment is displayed in peripheral equipment not supporting characters of the comment, such characters may be displayed abnormally. If a comment exceeds 16 characters, only the portion up to 16 characters is written to the PLC, and the 17th character and later are ignored.
Operation in device comment/device name window:

To specify device comments to be written to the program area of the PLC, click Tools and then, the setting of Comment Move to PLC. Or in the device comment/name window, click the right button of the mouse at the cursor position or after specifying the range.

After specifying the device comments to be written to the PLC an asterisk * will appear next to the corresponding device numbers.

When comments are transferred from the program area (where comments are read from the PLC or files are stored) to the device comment area, an asterisk * will appear next to the corresponding device numbers. (see Sec. 6.1.2 and Sec. 6.6.1).

Indicates the device comment storage capacity.
(Unit: comments)

Indicates the number of set comment devices that is to be written to the PLC. (Unit: comments)
**6.3.10 Setting of step of comment**

Use this command to correct the comment step indication in the block comment window or coil comment window (see Sec. 6.5.5).

After adding or deleting a program, the comment step numbers will be automatically adjusted, but the brackets showing the block/coil comment steps will not move automatically together with the step numbers.

For this reason, to enter comments in the block or coil comment windows after changing a program, be sure to execute this command to correct the bracket positions.
6.4 Search Menu Functions

The command functions of the Search menu can be classified into the following types:

1. Commands used for jumping to another place in the work window, such as Go to Top and Go to end and Tag jump
2. Commands used for searching comment character strings
3. Commands used for searching programs using device names, device numbers, and instruction symbols
4. Commands used for replacing character strings and device numbers
5. Commands used for inverting contact logic or device numbers

Relation between convert and search

Convert the diagram before using a search command in the ladder or SFC diagram editing status. If the ladder or SFC diagram is not converted, the diagram will not be valid as the program. For this reason, if a search command is preformed, a message will appear on the display to request a conversion.
6.4.1 **Go to Top, Go to End**

Use this command to move the cursor to the top or end of the document.

**Example: Going to top or end of ladder diagram**

![Ladder Diagram](image)

**Example: Going to top or end of instruction list**

```
0  LD  X000
1  OR  Y013
2  ANI  X002
3  OUT  Y013
4  OUT  T10  K200
7  OUT  C5  D20
10  LD  Y013
11  MOV  K1800  D1
16  SET  M30
17  RLS  M35
19  LD  X002

39  END
40  NOP
41  NOP
42  NOP
43  NOP
44  NOP
45  NOP
46  NOP
47  NOP
```
6.4.2  Device Name Search

Use this command to search the specified device name in the program.

Enter a device name with single quotation marks in this box.

Click this button to select a device name from the list.

Specify the search direction.

- Even if device names are not displayed on the screen, the corresponding device number will be searched.

6.4.3  Device Search

Use this command to search the specified device number in the program.

Enter the device number.

Click this button to select a device number from the list.

Specify the search direction.

Even if the device numbers are not displayed on the screen, the device corresponding to the set device number will be searched upon.
6.4.4 Instruction Search

Use this command to search the specified instruction symbol.

Enter an instruction in this box. Example: LD, AND, OUT, SET, MOV, DM0VP, FNC12, FNCD12P, etc.

Specify the search direction.

To search the program by specifying an instruction and device number, use the Contact/Coil Search command as described on the next page.

6.4.5 Contact/Coil Search

Use this command to search the program for the specified contact symbol and device number.

Click this button to select a contact symbol from the list.

Click this button to select a device number from the list.

Specify the search direction.

Enter a device number in this box.
6.4.6 Go to Step

Use this command to go to the specified program step.

Enter a step number in this box. Click this button to select a device number from the list.

6.4.7 Go to State

Use this command to go to the specified state in the SFC diagram edit window.

Enter the state number in this box. Click this button to select a state number from the list.
6.4.8 Character Search

Use this command to search the specified character string.

Enter a character string.

Specify the search direction.

Click this button to recognize capital letters and small letters as different characters in the search operation.

6.4.9 Character Exchange

Use this command to find and replace the specified character string.

Enter the character string you want to find.

Enter the character string to be replaced with the above character string.

Click the Select button to sequentially find and replace the character strings. The dialog box will appear each time, and ask if replacement of the characters string is required. Click the Replace All button to replace all the character strings at one time.
6.4.10 Change Device Number

Use this command to replace the specified device numbers to other numbers.
Applicable devices: X, Y, M, S, T, C, and D

Enter the same type of devices in the Find What and Replace With boxes.
Examples: X→X, Y→Y, M→M, T→T, D→D, etc.

Devices cannot be replaced if the number of steps differ from each other.

1) M0 to M1535 ↔ M1536 to M3071 (For FX2N, FX2NC series PLC family PLC only)
2) 16-bit counter ↔ 32-bit counter (Common to the FX family PLC)
6.4.11 Change Bit Device

Use this command to invert the logic of the contact instructions for the specified device numbers.

Applicable devices: X, Y, M, S, T, and C

Click the Select button to sequentially find and replace devices. The dialog box will appear each time, and to replace the appropriate prompt the user device.

Click the Replace All button to replace all the devices at one time.

Change pattern:
- LD → LDI
- LDI → LD
- AND → AND
- ANI → AND
- OR → ORI
- ORI → OR

6.4.12 Swap Device Number

Use this command to swap the specified device numbers with each other.

Applicable devices: X, Y, M, S, T, C, and D

Click the Select button to sequentially find and replace the devices. The dialog box will appear each time, and prompt the user to swap the device.

Click the Replace All button to replace all the devices at a time. The device numbers included in the application instructions will be also replaced.

Enter the same type of devices in these boxes to ensure device replacement to the same type.

Examples:
X↔X, Y↔Y, M↔M, T↔T, D↔D, etc.

Devices cannot be replaced if the number of steps differ from each other.

1) M0 to M1535 ↔ M1536 to M3071 (For FX2N, FX2NC series PLC controller only)
2) 16-bit counter ↔ 32-bit counter (Common to the FX family PLC)
6.4.13 Tag Set

This command is used to set the tag for Tag Jump. In the ladder program edit window, the first step number in the cursor-positioned ladder circuit block will be stored as the tag. In the list program edit window, the cursor-positioned step number will be stored as the tag.

Stores step 75 as the tag.

Stores step 74 as the tag.

6.4.14 Tag Jump

Use this command to jump to the tag position.

Select a tag from the list. Up to 10 tags can be stored in the list. If the eleventh tag is stored, then, the oldest tag is stored, then will be deleted.
6.5 View Menu Functions

The commands on the View menu enable the user to switch work windows or display the selected items.

Windows that can be switched by View menu commands

- Programming window group
- Comment window group
- Overlapped windows are shown in the figure. Note that only one of the overlapped windows can be displayed on the screen.
- Register window
- Device list window group

In addition, for the SFC program edit window, the inner ladder program edit window will be displayed.
6.5.1 Ladder View

Use this command to display the ladder program edit window.

Functions of ladder program edit window:
1. Displaying and editing existing programs (see Sec.7.2.4)
2. Creating and editing new ladder circuits. (see Sec.7.2.4)
3. Storing and displaying comments (see Sec.6.2.12, 6.2.15, and 6.5.12)
4. Displaying ladder diagrams so that operator can monitor the operation of the PLC (see Sec.6.7.1)
5. Writing a program in run mode (see Sec.6.6.1)
6. Printing ladder diagrams (see Sec.6.1.6 and 6.1.7)
6.5.2 Instruction View

Use this command to display the instruction list program edit window.

Displays the instructions.

Displays the device numbers and application instruction operands.

Program number display, indication

Edit window

Displays the PLC model.

Displays the program step. Number of steps used / Total number of steps

Function key guidance for instruction entry

Press the Shift key to display the sub-guidance.

Functions of list program edit window:
1. Display and edit existing programs (see Sec.7.3.2)
2. Creating and editing new instruction lists. (see Sec.7.3.2)
3. Displaying comments (see Sec.6.5.12)
4. Printing instruction lists (see Sec.6.1.6 and 6.1.7)
6.5.3 SFC View

Use this command to display the SFC diagram edit window. The inner ladder program edit windows for ladder blocks, states, transitions can be also displayed.

**SFC diagram**

- **Edit window**
- **Displays the coordinates of the cursor position.**
- **Function key guidance:** Use this guidance to enter SFC symbols.
- **Displays the PLC model.**

Press the Shift key to display the sub-guidance.

**Functions of SFC diagram edit window:**
1. Displaying and editing SFC diagrams for the existing programs (see Sec.8.2.4)
2. Creating and editing new SFC diagrams (see Sec.8.2.4)
3. Displaying, creating, and editing inner ladder diagrams (see Sec.8.2.3 and 6.5.4)
4. Displaying comments (see Sec.6.5.12)
5. Displaying SFC diagrams so that operator can monitor the operation of the PLC (see Sec.6.7.2 and 6.7.3)
6. Printing SFC diagrams (see Sec.6.1.6 and 6.1.7)
6.5.4 Inner Ladder View

Use this command to display the inner ladder program edit windows. In this window, the inner ladder program of ladder blocks, states, transitions are displayable.

Position the cursor on a SFC symbol in the SFC diagram edit window, then execute View and Inner Ladder View.

For a detailed description of the inner ladder program, refer to Sec. 8.2.3 "Creating SFC diagrams" and Sec. 7.2 "Creating Ladder program".

Execute View then the inner ladder view to display the inner ladder diagram of the cursor positioned symbol.
6.5.5 Comment View

Use this command to display the device name or comment edit window. Using these windows, store and edit the device names and comments.

Saving and reading comment files exclusively

A comment file can be saved with a different name. An existing comment file can be read into the program file that is currently opened.

When the comment window is selected, perform the following operation:

- Saving a comment file: File → Export
- Reading an existing comment file: File → Import

When importing or exporting a comment, the comment type to be processed can be selected. If there are comment types which should not be imported or exported, uncheck the check boxes of corresponding comment types.

When a program is saved or read, a comment file is usually processed together. The export or import operation is required when a comment file is needed to be processed independently.

(See Sec.6-1-2, 6-1-4)
Device Comment/Device name

The list of Device comments and names will be displayed in the window. Using this window, store, edit, or print the Device comments and names. For a detailed description of Device comments and names, refer to Sec.6.2.12 and 6.2.13.

Enter the device number to be displayed first in the list.

Click this button to display all the devices while ignoring the PLC model. The unstored device numbers in the PLC will be displayed in red.

Double-click in the device number column to designate a number. The set Device dialog box shown above will appear on the display.

Functions of Device comment and name edit window:
1. Display list of device comments already stored
2. Storing and editing device comments (In the ladder program edit window, click Edit and then Device Comments to individually store the device comments.)
3. Storing and editing device names (In the ladder program edit window, click Edit and then Device Name to individually store the names.)
4. Printing device comments (see Sec.6.1.6 and 6.1.7)

Specifying comments to be written to PLC:
The device comments specified can be stored in the parameter-set program area of the PLC (see Sec. 1.4, Sec. 6.2.13, and Sec. 6.3.9).
Block Comment
The list of block comments will be displayed in the block comment window. For a detailed description of block comments, refer to Sec. 6.2.15.

Enter the first device number to be displayed from the list.

Double-click in the device number column to designate a number. The Designate Device dialog box shown above will appear on the display.

Block comment step numbers will be displayed in brackets [ ].

The block comment storage positions are controlled by the first step numbers of the Ladder ladder circuit blocks, therefore use the first step numbers to display or store the block comments.
After inserting or deleting a program, the step numbers will be automatically corrected. The brackets [ ] of the block comment step numbers, however, will not move automatically. To correct the bracket positions, click Edit and then Setting of Step of Comment (see Sec. 6.3.10).

Functions of block comment edit window:
1. Displays the list of block comments already stored.
2. Stores and edits block comments. (If you use the ladder program edit window, you can individually store each block comment by clicking an Edit and then Block Comment.)
Coil Comment

The list of coil comments will be displayed in the coil comment window. For a detailed description of coil comments, refer to Sec. 6.2.14.

Enter the device number to be displayed first in the list.

Double-click in the device number column to designate a number. The Designate Device dialog box shown above will appear on the display.

The step No. which is the target of a coil comment is displayed inside [ ]

The coil comment storage positions are controlled by the step numbers of the output control instructions, therefore, use the step numbers of the instructions to display or store the coil comments.

After inserting or deleting a program, the step numbers will be automatically corrected. The brackets [ ] of the coil comment step numbers, will not move automatically. To correct the bracket positions, click Edit and then Setting of Step of Comment (see Sec. 6.3.10).

Functions of coil comment edit window:
1. Displays the list of coil comments.
2. Stores and edits coil comments.
6.5.6 Register View

Use this command to display the register edit window.

Enter the register number to be displayed first in the window.

- Select the display type.
- Select the numeric value display mode.

Click this button to display all the devices while ignoring the PLC model. The unstored device numbers in the PLC will be displayed in red.

Functions of the register edit window:
1. Display and editing data register data or file register data read out from PLC
2. Creating and editing data or file register data to be written to the PLC
Example: 16bit Register view

**Binary data, table type**

Double-click the device number column. The display setting dialog box will appear on the display.

You can edit the numeric values of the data cell.

**Decimal data, table type**

**Hexadecimal data, table type**

**ASCII data, table type**

**Line type**
Example: 32bit Register view
Binary data, table type

You can edit the numeric values of the data cell.
Double-click the device number column. The display setting dialog box will appear on the display.

Decimal data, table type

Hexadecimal data, table type
Functions of register edit window:
1. Display and edit the contents of the read data registers and file registers from the PLC.
2. Create and edit the contents of data registers and file registers to be written to the PLC.
6.5.7 Tool Bar Status Bar Function Keys

Use these commands to change the application window display conditions.

Click Tool Bar to erase or redisplay the tool bar.

Click the Function Keys to erase or redisplay the function key guidance.

Click the Status Bar to erase or redisplay the status bar.

Functions of toolbar icons

(1) New (see Sec.6.1.1)  (10) Go to End (see Sec.6.4.1)
(2) Open (see Sec.6.1.2)  (11) Device Name Search (see Sec.6.4.2)
(3) Save (see Sec.6.1.4)  (12) Device Search (see Sec.6.4.3)
(4) Print (see Sec.6.1.6)  (13) Instruction Search (see Sec.6.4.4)
(5) Cut (see Sec.6.2.2)  (14) Contact/Coil Search (see Sec.6.4.5)
(6) Copy (see Sec.6.2.3)  (15) Go to Step (see Sec.6.4.6)
(7) Paste (see Sec.6.2.4)  (16) Search Next
(8) Convert (see Sec.6.3.7)  (17) Preferences (see Sec.6.8.10)
(9) Go to Top (see Sec.6.4.1)  (18) Help (see Sec.6.10)

(19) Ladder view (see Sec.6.1.1)  (23) Comment display (see Sec.6.5.12)
(20) Instruction view (see Sec.6.5.2)  (24) Start monitor (see Sec.6.7.1)
(21) Comment view (see Sec.6.5.5)  (25) Stop monitor (see Sec.6.7.2)
(22) Register view (see Sec.6.5.6)
6.5.8 Palette

Use this command to erase or redisplay the tool palette in the ladder program edit window.

Various symbols, such as contacts, lines, and output coils, used for creating ladder diagrams are located in the tool palette. Click the mouse button on a symbol in the tool palette to select the symbol. This palette is a floating type. The palette, therefore, can be moved to another position so that the user can easily use the mouse. These symbols (contact, line, or coil symbols) can be also entered if the Tools command or function keys in place of the tool palette is used. The advantage of the tool palette is that changes to the ladder circuit symbols without erasing the device entry dialog box is possible.

<Functions of the tool palette>

1) a-contact [LD, AND]  2) b-contact [LDI, ANI]
3) Parallel a-contact [OR]  4) Parallel b-contact [ORI]
5) Load/And pulse contact [LDP, ANP]  6) Load/And falling pulse contact [LDF, ANF]
7) OR pulse contact [ORP]  8) OR falling pulse contact [ORF]
9) OUT coil [OUT]  10) Special coil [SET, RST, or applid instruction, etc.]
11) Horizontal line  12) Vertical line
13) INV instruction [INV]  14) Vertical line deletion
6.5.9 **Contact/Coil List**

This command displays the associated step number for the selected device.

Enter the device number. The selected device number in the program window will be initially displayed.

Use these buttons to scroll up and down the screen.

Use these buttons to switch device. 

\[ X \rightarrow Y \rightarrow M \rightarrow S \rightarrow T \rightarrow C \rightarrow D \rightarrow P \rightarrow I \rightarrow N \rightarrow V \rightarrow Z \]

Displays the comment on the specified device.

6.5.10 **Device Used List**

Use this command to display the contact/coil conditions of 24 devices. Specify the first device number to determine the 24 devices.

Enter the device number. The selected device number in the program window will be initially displayed.

The symbol ( ) will be displayed if the device uses coils. No symbol will be displayed if the device uses no coils.

The numeric value indicates the number of coils.

The symbol - | - will be displayed if the device uses a contact. No symbol will be displayed if the device uses no contact.

E1: No contact is used. Only coils are used.

E2: No coils are used. Only a contact is used.
6.5.11 TC Setting List

Use this command to display the timer and counter values that are set in the program.

The timer and counter values that are set in the program by constants will be displayed on the screen above. To check the values indirectly set by the data register, etc., use the monitoring function or the data register display function.
6.5.12 Comment display

Use this function to specify the comments to be displayed in the ladder, instruction list, or SFC program edit windows.

Ladder program edit window

Specify the type of comments to be added to the ladder diagram.

Select the device comment display position; above the symbol or below the symbol.

Set the device comment display size. If the size is set as shown in the figure, the device comment of 10 characters × 5 lines will be printed.

Set the coil comment display size. If the size is set as shown in the figure, the coil comment consisting of 20 characters × 7 lines will be printed.

Example: If all types of comments are specified

Example: If device names are displayed in place of device numbers
List program edit window

Specify the type of comments to be added to the program list.

Example: If all types of comments are specified

- Coil comment
- Block comment
- Device name

Example: If device names are displayed in place of the device numbers
Specify the type of comments to be added to the SFC diagram.

Example: If all types of comments are specified

- **Device comment**
  - Display range: 0 Rows x 0 Lines
- **Device number**
  - Display range: 0 Rows x 0 Lines
- **Device name**
  - Display range: 0 Rows x 0 Lines

Unused
6.5.13 Display Setting

Use this command to specify the data register display size and device comment display style for the device store/monitor screen.

Select the data display method.

Click this box to display device comments on the device store/monitor screen.

6.5.14 Zoom

Use this command to enlarge or reduce the characters displayed in the window.

- Click Custom to specify the font size in the range of 50% to 150% in increments of 5%.
- To enlarge or reduce characters displayed in the window, change the font size by clicking Option and then Font.
- The font size specified by the Zoom command will not affect the printed character size. To change the printed character size, click Scale in the printing data setting dialog box.
6.6 PLC Menu Functions

Use the commands on the PLC menu to execute online functions, such as data transfer to/from the PLC, PLC operation check, and setting/displaying sampling trace data.

Connection to PLC:
Correctly connect the PC to the PLC while referring to Sec.1.2.3 "System configuration".

Solving communication error:

1) Check that the power source is supplied to the PLC.
   If no power is supplied, turn on the power of the PLC, and then restart the operation.

2) Check the model names of the cable and the RS-232C/RS-422 interface unit connecting the PC to the PLC while referring to Sec.1.2.3 "System configuration".
   If the wrong cable or interface unit is used, replace it with the right one. If the cable or interface unit is incorrectly connected please correct the correction.

3) Check the looseness of all the connectors.
   To prevent problems caused by looseness, tighten all the connectors, and then restart operation.

4) Check the communication port setting conditions for the communication port for the PC side. For a detailed description of the communication port, refer to Sec.6.6.10 "Ports".

5) If you have another peripheral unit of the FX family PLC, connect it in place of the current unit, and then communicate with the PLC.
   If the peripheral unit provides proper communication, ascertain if the PC main body, cable, or interface unit, is defective. In this case, please contact the nearest Mitsubishi electric distributor.
6.6.1 Transfers

Use this command to read programs from the PLC, write programs to the PLC, or collate program data.

The program in the PC is compared with the program in the PLC to verify that all the steps contain the same data. If there are steps containing different data, a list of data error steps will appear (see the figure below).

Click on an error step. The step data stored in the PC and step data stored in the PLC are displayed, therefore you can see the difference between them.

Note: If an instruction uses two or more steps, there may not be any difference in the data of an error step between the PC and the PLC.

Verify conditions
Memory: Internal memory, RAM/EPROM/EEPROM (protect switch on or off) cassette
PLC operation mode: Run or stop mode
Program transfer operation

- Use Parameter and Program (File Register, comment) to transfer all the programs at one time. Note that it takes 3 to 4 minutes to transfer a program of 1.6 K steps to the FX-EEPROM-16.
- If a keyword is stored, the Keyword dialog box will appear on the display. Enter the keyword. If the wrong keyword is entered, then the entire operation will be stopped.
- When a program is transferred from the PC to the PLC, program verification will be automatically executed after has been written the program. To skip the program verification step, click Preference (see Sec. 6.8.10). The Preference window will appear. In the Automatically Verify box of this window, click the “No” button.
- If PLC type in PC is in discord with PLC, the following dialog boxes are displayed. When downloading/uploading the program data to/from PLC in the force, click “YES” button. If the download/upload would not be executed correctly, the program should be downloaded/uploaded to/from the PLC after matching the PLC type by the PLC type change.

Control of parameter-set comments

- If a program has parameter-set comments, FXGP/WIN-E will read these comments as the device comments. In addition, these device comments will be regarded comments to be written to the PLC. (See Sec. 1.4 and Sec. 5.5.5.)
- The device comments regarded as the comments to be written to the PLC will be written to the program area of the PLC. (See Sec. 1.4, Sec. 6.2 13, and Sec. 6.3.9.)
6.6.2 Register Data Transfers

Use this command to read register data from the PLC, write register data to the PLC, or collate register data.

Collates the program from the PC with that of the PLC.

**Verify conditions**
- Memory: Internal memory, RAM/EPROM/EEPROM (protect switch on or off) cassette
- PLC operation mode: Run or stop mode

Specify the item to be collated.

**Writing conditions**
- Memory: Internal memory, RAM/EEPROM (protect switch off to write file register data/protect switch on to write the other register data) cassette
- PLC operation mode: Stop mode (writing is impossible in run mode)

Specify the item to be written.

**Reading conditions**
- Memory: Internal memory, RAM/EPROM/EEPROM (protect switch on or off) cassette
- PLC operation mode: Run or stop mode

Specify the items to be read.

Click this button to read out data.

**Read**

Specify the item to be collated.

**Verify**

Click this button to write data.
Note

- If the keyword is stored, the Keyword dialog box will appear on the display. Enter the keyword. If a wrong keyword is entered, operation will be stopped.

- To use file registers, set the correct parameter to ensure enough free area. To use the RAM file register data, turn on the special auxiliary relay (M8074) on the PLC side. The file register and RAM file register will be valid only if the PLC containing these register functions is selected.
6.6.3 PLC Memory Clear

Use this command to clear the memory of the PLC via the PC in the online mode. Click this button to clear the program memory of the PLC. (Programs + file registers + parameters)

Command execution conditions
Memory: Internal memory, RAM/ EEPROM (protect switch off) cassette
PLC operation mode: Stop mode (execution impossible in run mode)

Click this button to turn off all the bit devices (X, Y, M, S, T, and C). In addition, clicking this button will reset the current timer and counter values to zero.

Click this button to clear all the data registers (D), file registers (D), and RAM file registers (D).

Command execution conditions
Memory: All memories
PLC operation mode: Stop mode (execution impossible in run mode)

Click this button to set the data. If the communication data is still not set in D8120, the values shown in the left figure will appear on the Serial Setting screen.

If communication data is already set in the D8120, the set values will appear on the Serial Setting screen.

Click OK to directly write the set values in the D8120 of the PLC. In addition, the same data will be written in the data register area on the PC side. For this reason, when you use the Register Data Transfer command to transfer all the register data to the PLC, the D8120 data set on this screen will be written in the PLC again.

Command execution conditions
Memory: Internal memory, RAM/ EPROM/ EEPROM (protect switch on or off) cassette
PLC operation mode: Run or stop mode
6.6.5 PLC Keyword Current or Delete

Use this command to store the keyword to the program memory of the PLC. Store the keyword if you want to protect the programs from being erased by mistake (due to overwrite) or stolen.

Click this button to store the keyword.

```
<table>
<thead>
<tr>
<th>OPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

**Store**

Enter a keyword in the New Keyword box to store the keyword.

**Change**

Enter an old keyword in the Old Keyword box, and then enter a new keyword in the New Keyword box. Then, press the OK button to change the old keyword to the new keyword.

To delete a keyword, enter the keyword in the Old Keyword box, and then enter 8 characters of spaces. Then, press the OK button.

**Command execution conditions**

- Characters used for keyword: Alphanumeric characters of A to F and 0 to 9
- Number of characters: 8 characters (An error will be detected if the number of characters is less than 8.)
- Memory: Internal memory, RAM/EPROM/EEPROM (protect switch on or off) cassette PLC operation mode: Run or stop mode

**When the registered keyword is unknown**

In the case of an unknown keyword, the keyword cannot be changed or canceled. When deleting an entire program including the keyword, execute “PLC → PLC memory clear”.

**Setting a keyword protection level for peripheral online units**

If the peripheral units enable online operation with the PLC FX-10P, FX-20P, etc., set the protection level for the keyword with the appropriate device. There are three levels of protection as described below. Protect the programs from being monitored or modified by online units, via setting keyword of the optimum protection level.

- **All protected (No peripheral unit enables operation.):**
  
  ![Keywords](image)

  Enter an alphanumeric character other than A, B, or C.

- **Protection from copying (Monitoring, data modify, etc.will be inhibited.):**

  ![Keywords](image)

- **Protection from overwriting (Reading, monitoring, data modify, etc.will be inhibited.):**

  ![Keywords](image)

In the empty boxes □, enter alphanumeric characters to determine the keyword. Use alphanumeric characters from A from F and 0 to 9.
Keyword check and entry

- If a keyword is set, enter the keyword at the start of the next operation.
  The system checks the entered keyword. If a wrong the keyword is entered, a dialog box will appear on the display, and request the correct keyword.
  The keyword will be checked,
  1) When programs are read from the PLC, when programs are written to the PLC, or when programs in the PLC are collated, a check of the keyword is performed.
  2) When programs are read from the memory cassette installed on the ROM writer, or when programs in the memory cassette are collated.
  The system will not check the keyword, when file data stored on floppy disks or hard disk are used, a check of the keyword not needed.

- Enter the keyword,
  1) When a change or delete to keyword using a PLC is performed.
  2) When using a the PLC or ROM writer for data reading or writing.
    If a keyword is set for the PLC or ROM cassette, the keyword entry dialog box will appear on the display for when programs are read from the PLC or ROM cassette. If the right keyword is entered, the programs will be read.
    If a keyword is set for the PLC, the keyword entry dialog box will appear on the display when data is written to the PLC. If the wrong keyword is entered, no data will be written to the PLC.
    To write data to the ROM writer, data in the EPROM cassette should be erased using ultraviolet ray. For this reason, the keyword entry dialog box will not appear on the display.
    If the keyword stored in the PLC differs from that of the PC, the keyword in the PLC will have priority. For this reason, if the keyword entry dialog box appears an writing data (to transfer programs), enter the keyword for the PLC.

- In the offline mode, click Option and then Keyword Setting to store a keyword in the PC only, to change the keyword stored in the PC, or to delete the keyword from the PC. When using Option and Keyword Setting, the password held in the PC will be changed, but the password in the PLC will not be changed.
6.6.6  Runtime Program Changes

When the PLC is in the run or stop mode, use this command to change programs in the ladder program edit window. Changed programs will be directly written to the program memory of the PLC.

Data writing method

1) Using this command, modifying the existing ladder circuit in the ladder program edit window (add, insert, or delete units of ladder symbols), and inserting or adding ladder blocks (but ladder block delete is not possible) is possible. Such a modification range is limited to one ladder block. If two or more blocks are modified at a time, the program cannot be written in the program memory in the run mode. For data writing conditions in the run mode, refer to the next page.

2) Press the \[\text{F4}\] keys (RUN CNV) or PLC and Runtime Program Change to write the changed data in the program memory in the run mode.

Caution

- If a program is changed in the run mode, the PLC will change the control sequence. Carefully change programs in the run mode for the safety reasons.
  For a detailed description, refer to the operation manual of the PLC that describes how to write data in the run mode.
  Before starting the operation, be sure to check that the same programs are stored in both the PLC and the PC.
  If the operation is started with differing programs, then the programs stored in the PLC may be destroyed.
- When "Convert and run time program changes" is selected by "Option → Preferences", "Run time program changes" are executed also after "CNV F4" or "Tools → convert" is executed.
- Carefully write a pulse application instructions (with a P) in the ladder diagram. This is because the instruction written in the ladder circuit will be executed only if the input condition is ON.
Condition for program change

Hardware
Model: FX series (version 2.1 or above)
  FX2C series
  FX0N series (version 1.10 or above)
  FX1S, FX1N series
  FX3N, FX3NC series
Memory type:
  FX2N, FX2NC: Internal RAM, optional RAM cassette, or optional EEPROM cassette (protect switch off)
  FX1S, FX1N: Internal EEPROM or optional EEPROM cassette (protect switch off)
  FX, FX2C: Internal RAM or optional RAM cassette
  FX0N: Internal EEPROM
PLC operation mode: Run or stop mode

Program
Items common to the FX, FX2C, FX0N, FX1S, FX1N, FX2N and FX2NC series PLC:
1) When a ladder circuit is changed, only one ladder circuit block at a time is possible. In addition, before and after changes, the number of program steps included in the block should be 127 or less (including the NOP just after the ladder circuit block, but for the final block, excluding the NOP just after the block). Changes to programs, use of the Transfers command to transfer all the programs.
2) When modifying a ladder circuit block requires the label P or I should not be added, deleted, or changed.
3) If a ladder circuit block before or after a modification includes a high-speed counter C235-C255 output instruction (OUT) or application instruction FNC 90-98, the modification to the block will not be possible.
4) When modifying a ladder circuit block, no 1 ms timers can be inserted.

Notes regarding use of the FX (version 3.07 or above) or FX2C series PLC:
1) For new instructions, inserting substitute instructions in the program, or replacing new instructions with substitute instructions is prohibited. If substitute instructions are located in the program, they will not function in the run mode.
2) For the above PLC, the CMP, ZCP, and MOV commands (FNC10 through FNC12) and ADD, SUB, MUL, DIV, INC, and DEC commands (FNC20 through FNC25) ensure high-speed operation only if the digits of word devices are specified or if no indexes are used for modification. However, these commands, will not ensure high-speed operation when data is written or inserted in the run mode.
3) For the FX (version 3.07 or more) and FX2C series, the application OFF command time is reduced. However, if data is written or inserted in the run mode, this time reduction function will not be valid, and the command OFF time will be increased by approximately 60% for the FX (version 2.30 or less) series. At the completion of data editing in the run mode, change the mode of the PLC to stop and then run again. The above functions 1) through 3) will be valid again.
Notes regarding use of the FX series PLC (version 2.1 to version 2.30):

1) Application instructions or device numbers added by the FX series PLC (version 3.07 or more) will be written to the program memory of the PLC. At this moment, the system will not check these instructions, and the PLC will continue operating. However, when the mode of the PLC is switched to stop and then run again, the system will check the programs. When the PROG-ELED indicator lamp flashes, correct the corresponding instructions or device numbers, and then transfer all the acceptable programs at one time.

2) Even if a device number invalid for the FX series (version 3.07 or more) is specified by the operand of the application instruction, the instruction will be written to the program memory of the PLC. At this moment, an operation error (wrong device number) will be detected for this instruction. The PLC will continue operate while ignoring the error.

When the mode of the PLC is switched to stop and then run again, the system will check the programs, and the PROG-ELED indicator lamp will flash. Correct the operand of the application instruction, and then transfer all the programs at one time.

Notes regarding use of the FX0N series PLC (version 1.10 or above):

1) If a device number invalid for the FX0N is written, the message "Ladder diagram creation error" will appear on the display, and the program will not be changed.

2) The FX0N cannot execute any pulse type application instructions. If such an instruction is used, "Writing error" will appear on the display, and the program will not be changed.

3) Even if an invalid application instruction for the FX0N series is inserted, the instruction will be written to the program memory of the PLC. At this moment, the system will not check the instruction, and the PLC will continue to operate.

However, when the mode of the PLC is switched from stop and then run again, the system will check the programs. When the PROG-E LED indicator lamp flashes, correct the corresponding instruction, and then transfer all the acceptable programs at one time.

4) If an invalid device number for the FX0N series is specified by the operand of the application instruction, the instruction will be written to the program memory of the PLC. At this moment, an operation error (wrong device number) will be detected for this instruction. However, the PLC will continue operate while ignoring the error.

When the mode of the PLC is switched from stop and then run again, the system will check the programs, and the PROG-ELED indicator lamp will flash, correct the operand of the application instruction, and then transfer all the programs at one time.

For a detailed description, refer to the hardware manual of the PLC.

Writing data in run mode

- Even if the number of program steps is reduced by a change in the program, the PLC will not reduce the total number of steps, but will add NOP instructions to balance the number of steps.

Before change

<table>
<thead>
<tr>
<th>X0</th>
<th>Y0</th>
</tr>
</thead>
</table>

After change

<table>
<thead>
<tr>
<th>X0</th>
<th>Y0</th>
</tr>
</thead>
</table>

Step 1 will be NOP.

- If the number of program steps is increased by change in the program, programs will be inserted to balance the number of steps.

Before change

<table>
<thead>
<tr>
<th>X0</th>
<th>Y0</th>
</tr>
</thead>
</table>

After change

<table>
<thead>
<tr>
<th>X0</th>
<th>X1</th>
<th>Y0</th>
</tr>
</thead>
</table>

OR X1 will be inserted in step 1.
6.6.7 Remote Run/Stop

Use this command to run or stop the FX1S, FX1N, FX2N, FX2NC series PLC using the PC. For these operations (remote run and stop), the special auxiliary relays M8035 (forced run mode), M8036 (formed run), and M8037 (forced stop) will be controlled. Note that remote stop will be valid even if the RUN/STOP switch of the PLCs is at the RUN position.

Select Run or Stop, and then click the OK button.

6.6.8 PLC Diagnostics

Use this function to display the scan time (operation cycle) and error detected on the PLC connected to the PC.

Displays the PLC operation status.

For a detailed description of error codes, refer to the APPENDIX.
6.6.9 Sampling Trace

Use this command to sample data at the specified time under the appropriate trigger conditions. Sampling trace will be executed by the PLC. The FXGP/WIN-E will set the sampling conditions and display the result of trace.

Applicable PLCs: FX, FX2C and FX2N, FX2NC series

Click this command to set the sampling conditions.

Click this command to transfer the set data to the PLC.

Click this command to display the sampling results.

Click this command to store or read out the sampling results.
Setting Parameters

Use this command to specify the devices selected for a sampling trace, and also specify the tracing time and the number of tracing times.

In addition, use a device as the trigger for tracing.

**Applicable devices:**
- **Contact:** X, Y, M, S, T, C
- **Coil:** T, C (Y, M*1)
- **Current Value:** T, C, D, Z, V

*1: Devices Y and M can be stored in the Coil list. However, depending on the operation of the PLC, the coil on/off operation may not be sampled. For this reason, store devices Y and M in the Contact list.
Run

Use this command to transfer the sampling conditions to the PLC, or read the tracing results from the PLC. In addition, use this command to start or stop the tracing operation.

Click this button to transfer the set sampling conditions to the PLC connected to the PC.

Displays the tracing status.

Click this button to start sampling trace. While the PLC is in the tracing mode, "Start" will be inverted.

Operation while specifying a trigger:
Sampling will be performed while observing the specified tracing time until the trigger conditions are satisfied. When satisfied, sampling will be performed while observing the specified tracing time, and then completed when the number of tracing times equals the specified number (specified by Trace Count).

Click this button to perform forced stop of the sampling trace.

Click this button to read the results of sampling trace from the PLC. Use the Display Result command to display the results.
Display result

Use this command to display the results of the sampling trace read from the PLC.

Read from Result File

Use this command to read the results of sampling trace and the set conditions from the file.

Write to Result File

Use this command to store the results of sampling trace and the set conditions in a file.
6.6.10 Ports

This “Ports” dialog box sets the communication COM port (COM to COM9) and transfer speed (band rate) for connecting to PLC by RS-232C on the PC.

*19,200 bps* is available only in the FX1N/FX2N/FX2NC Series PLC. In any other PLC, the transfer speed is automatically set to “9,600 bps”.

Set the transfer speed to “9,600 bps” when using REMOTE MAINTENANCE FUNCTION.

Select the port from COM1 to COM9 considering the PC system configuration.

Note

- In a notebook PC equipped with infrared communication ports, the connection of the COM1 port may be set to an infrared port, not to an RS-232C connector.

In such a case, in addition to the setting described in this paragraph, change over the COM1 port from “infrared port” to “RS-232C connector” in the setting menu of the PC. While the COM1 port is connected to an infrared communication port, the FXGP/WIN-E cannot communicate with the PLC.
6.7 Monitor/Test Menu Functions

On the Monitor/Test menu, there are two types of commands; monitoring commands and testing commands. The monitoring commands enable the user to monitor operation of the PLC displayed in the ladder diagram, device, or SFC diagram window. The testing commands directly control the devices in the PLC and numeric values.

Connection to PLC

To execute commands of the Monitor/Test menu, the PC should be connected to the PLC. For a detailed description of connection, refer to Sec.6.6 "PLC Menu Functions".
6.7.1 Start monitor

This command to monitors operation of the PLC using the ladder or SFC diagram edit window.

- In the edit window, click Monitor/Test and then Start Monitor to begin monitoring operation of the PLC.
- Before monitoring operation of the circuits, check that the programs stored in the PC are the same as those of the PLC. If the programs are different, wrong monitoring results may be shown on the display.

Contacts connected and coils activated will be green.

Double-click the mouse button on an output instruction, such as a timer, counter, or application instruction, to modify the set value (see Sec.6.7.8).
Displaying current values on ladder circuit monitor

- The values of index-modified devices in application instructions will be displayed as follows:
  - Only the current values of index-modified devices will be displayed.
  - The current values of index-modified devices will not include the index modification result.
  - The current values of index registers (V and Z) will be displayed only if one index register (V or Z) is specified in the operand.
- The current values will be displayed using decimal numbers or hexadecimal numbers ("H" will be added to the top of the value).
To switch the current value display style between decimal and hexadecimal numbers, click Monitor/Test and then Display Change of Monitor Data (see Sec. 6.7.9).

Monitoring ladder circuits and operation of each device

Use Entry Device Monitor (described later) to monitor respective devices. Select a device, and you can monitor the following items at the same time:
- Operation of the contact and coils of the selected device
- Timer/counter setting value and current timer/counter value
- Current data register value
To monitor a device, click the right button of the mouse on the desired device in the ladder diagram. The shortcut menu will appear on the display as shown in the figure.
For a detailed description, refer to the description of each command.
6.7.2 Stop Monitor

Use this command to stop monitoring of the PLC operation. The ladder program edit window used for monitoring will return to the edit mode.

If the ladder program edit window is in the monitoring mode, the ladder circuit cannot be edited.

Editing can be performed, once monitoring has stopped.
6.7.3 Dynamic Monitor

This command automatically reads out the operating state data, and monitors operation of the states displayed in the SFC program.

The screen will be automatically scrolled up, down, rightward, or leftward as the active state is switched.

- The special diagnostic auxiliary relay M8047, must be on to enable automatic monitoring using the SFC program.
- If two or more states are active in the activate multiple flows simultaneously, use the [\(\bigtriangledown\)] and [\(\bigtriangledown\)] keys to switch the active state to be automatically monitored.

Automatic monitoring of translation branches:

To monitor the triple activate multiple flows simultaneously shown in the ladder diagram, press the [\(\bigtriangledown\)] key once to monitor the devices of the first branch, twice to monitor the devices of the second branch, and three times to monitor the devices of the third branch. (Up to 8 branches can be monitored.)
6.7.4 Entry Device Monitor

This command can be set to monitor a specified device. To use:
Enter a device number to specify the device. The following can be monitored.

- Operation of the contacts and coils of the specified devices
- Timer/counter setting values and current timer/counter values
- Current data register values

The device store/monitor window can overlap the ladder program edit window.

<table>
<thead>
<tr>
<th>OPN</th>
<th>L/V</th>
<th>L/M</th>
<th>I/V</th>
<th>S/V</th>
<th>S/M</th>
<th>C/V</th>
<th>R/V</th>
<th>D/L</th>
<th>D/M</th>
<th>SMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

Device number

Displays the timer counter setting value.

Displays the timer counter setting value.

Displays the current values of the timer counter, data register, and index register.

Displays device comments.

Indicates that the coil is turned on.

Indicates that the contact is closed.

Applicable devices
X, Y, M, S, T, C, D, V, Z

Number of storage points
48 points, maximum

Saving and reading the information on registered devices

The element symbols registered in "Entry device monitor" can be saved as a registration monitor file, and can later be read to the current program file.

When saving a registration monitor file: File → Export
When reading an existing registration monitor file: File → Import

Display style:

- The data register (D) values can be displayed using binary numbers, hexadecimal numbers, ASCII numbers, or floating-point representation. In addition, the display size can be switched between the 16-bit and 32-bit sizes. For the other types of devices, decimal numbers will be used.
- Device comments can be displayed together with the registered devices (see Sec. 6.5.13). To display device comments, click View and then Display Setting, or click the right button of the mouse in the device store/monitor window, and then click Display Setting.
New device storage
To store a new device, position the cursor at the desired position, and then open the device storage dialog box using one of the following methods.
1) Directly enter the device name using the keyboard.
2) When the cursor is at the desired position, press the Enter key.
3) Double-click the mouse button on the desired position.

Device storage dialog box

Device number to be stored, modified, or deleted.

Stores the device in the monitor screen.

Deletes the device number entered in the Device box. The data in the Number of Devices box, however, will not be deleted.

Enter a number to specify the number of devices to be stored. This is the total number of devices including the device specified in the device box. The numbers 1 through 48 can be entered in this box.

Select a data register display size. The data register display size (16-bit or 32-bit size) can be also switched using the mouse in the device store/monitor window.

Stores new devices after erasing all the devices currently stored when marked.

Stored device change or delete
To change or delete a device once stored, position the cursor on the desired device, and then open the device storage dialog box using one of the three methods described above New device storage.

Positioning the cursor on the desired device, and then pressing the Enter key will also delete a device.
Other operations using the device store/monitor screen

The data register having character "L" will be displayed using the 32-bit size. Double-click the current value of a data register. The display size of the data register will be switched between the 16-bit and 32-bit sizes.

The following shortcut menu will appear when the right button of the mouse is clicked on an item displayed on the screen.

Forced setting or resetting of the corresponding bit device can be performed. In addition, the current value of the corresponding word device can be reset to zero. (See Sec. 6.7.6)

The current value of the corresponding timer (T), counter (C), or data register can be modified. (See Sec. 6.7.7)

The data register display size and whether the device comments should be displayed can be specified. (See Sec. 6.5.13)

Entering and monitoring devices using ladder diagram monitoring screen:

When the ladder program monitor window is open, the Entry Device Monitor (T,C,D device) and Entry Device Monitor (Cursor) commands will be displayed in addition to the Entry Device Monitor command described before.

The functions of these commands are described below:

- **Function of Entry Device Monitor (T,C,D device):**
  Started from the cursor position, up to 10 devices (data register : D, timer : T, counter : C) will be copied from the ladder diagram monitor window, and then pasted at the cursor position of the Entry Device Monitor screen.

- **Function of Entry Device Monitor (Cursor):**
  The device selected inverted by the cursor will be copied from the ladder diagram monitor window, and then pasted at the cursor position of the Entry Device Monitor screen.

  To execute this function, you can also use the shortcut key by clicking the right button of the mouse in the ladder program monitor window.
6.7.5 Forced Y Output

This command performs forced on/off operation of the output relay (Y) in the PLC.

Enter a device number in this box.

Click the ON or OFF button to determine the type of device operation.

Click this button to execute the forced on/off operation.

Execution conditions

Applicable device: Y

PLC operation mode: Run or stop mode

- This command is executed for only one operation cycle of the PLC. In the run mode, therefore, forced on/off will be valid for the latch circuit and SET/RST circuit.
- If the PLC is in the stop mode, or if the output unused in the program is specified, the forced output command will be held.
- This command can turn on the specified output relay even if no programs are stored in the PLC. This command, therefore, can be used for operation check, etc. at the completion of wiring.

Displays the operation history.
6.7.6 Forced On/Off

This command performs forced on/off of the specified bit device in the PLC. This command can also reset the current value of the specified word device to zero.

Enter a device number.

Click the ON or OFF button to determine the type of device

Click this button to execute the forced on/off operation.

Displays the operation history.

### Execution conditions

#### Applicable devices:
- X, Y, M, S, T, C (forced on/off)
- T, C, D, Z, V (current value clear)

#### PLC operation mode:
- Run or stop mode
  - This command is executed for only one operation cycle of the PLC. In the run mode, therefore, forced on/off will be valid for the latch circuits and SET/RST circuit, and current value clear will be valid for the T, C, D, Z, and V.
  - If the PLC is in the stop mode, or if the output unused in the program is specified, the forced on/off command will be held.
  - The current value of the specified file register cannot be reset to zero if the program memory in the PLC is the EPROM cassette. If the EEPROM cassette is used, set the protect switch to off before executing this command.
6.7.7 Change Current Values

This command modifies the current value of timers (T), counters (C), or data registers (D) of the PLC.

Enter a device number.

Enter the value to be modified. (For a detailed description, refer to the description below.)

Execution conditions

Applicable devices: T, C, D, Z, V
PLC operation mode: Run or stop mode

Click this button to execute modification of the current value.

Select data register type; 16 bits or 32 bits. Note that a 32-bit register consists of two 16-bit registers.
Example: When D0 is specified
If you specify 16 bits, the data of the D0 only will be modified.
If you specify 32 bits, the data of the D1 and D0 will be modified.
32 bits can be specified for the data registers (D) only.

Displays the operation history.

The current value of the specified file register cannot be modified if the program memory of the PLC is the EPROM cassette.
If the EEPROM cassette is used, set the protect switch to off before executing this command.
Current value setting range and applicable characters

<table>
<thead>
<tr>
<th>Device</th>
<th>Setting range and applicable characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>K0 to K32,767 (decimal data)</td>
</tr>
<tr>
<td>C0-C199</td>
<td>K0 to K32,767 (decimal data)</td>
</tr>
<tr>
<td>High Speed</td>
<td>K-2,147,483,648 to K2,147,483,647 (decimal data)</td>
</tr>
<tr>
<td>Counter</td>
<td>K-32,768 to K32,767 (decimal data)</td>
</tr>
<tr>
<td>D(16 bits)</td>
<td>K-2,147,483,648 to K2,147,483,647 (decimal data)</td>
</tr>
<tr>
<td>D(32 bits)</td>
<td>K-2,147,483,648 to K2,147,483,647 (decimal data)</td>
</tr>
<tr>
<td>Z,V</td>
<td>K-32,768 to K32,767 (decimal data)</td>
</tr>
</tbody>
</table>

Binary data entry: B****  
Decimal data entry: K****  
Hexadecimal data entry: H****  
ASCII data entry: A****

The first character is an alphabetic character to show the data type.
6.7.8 Change Setting Values

This command changes the timer (T) and counter (C) setting values, constants (K, H) used as the operands of the instructions, or device numbers of the data registers (D) or index registers (V, Z).

Command execution conditions

- **Applicable devices**: T and C (change in constant K or device number of indirectly specified data register)
  - K and H in application instruction (constant change)
  - D, V, Z in application instruction (change in device number)
- **Memory**: Internal memory, RAM/ EEPROM (protect switch off) cassette
- **PLC operation mode**: Run or stop mode

- If the specified instruction in the PC is different from the instruction in the PLC, writing data will be inhibited. Correct the step in the program, and then execute this command.
- No value can be changed if the new value specifies a different type or device. Specify the same type and do not change the total number of steps.
- When the ladder program edit window is in the monitoring mode, position the cursor on an output instruction, and then click Monitor/Test and then Change Setting Values, or double-click on the output instruction. The following dialog box will appear on the display.

Changing timer/counter setting value

- **Change the constant of the operand or device number of the data register.**
- **Change the constant.**
- **This type of operand cannot be changed.**
- **The instruction symbol set in this box cannot be changed.**

Changing application instruction:

- **Example 1**
- **Example 2**

![Dialog box for changing setting values](image-url)
6.7.9 Display change of monitor data (†††)

This command changes the current value display style for the ladder diagram monitor window. Each time the command is executed, the current value display style will be changed between decimal number display style and hexadecimal number display style (see Sec. 6.7.1).

Decimal numbers displayed in ladder diagram (initial values)

![Ladder diagram showing decimal numbers displayed](image)

Hexadecimal numbers displayed in ladder diagram ("H" is added to the top of each value.)

![Ladder diagram showing hexadecimal numbers displayed](image)
6.8 Option Menu Functions

On the Option menu, there are various commands that are not directly related to the active window or current work. Connect to ROM writer, if a command related to it is used.

Two similar commands

The PLC menu and the Option menu have similar commands as described below:

<table>
<thead>
<tr>
<th>PLC</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>→ PLC Diagnostics</td>
<td>→ Program Check</td>
<td>When a program is started with the PLC in the run mode, the PLC will check the program. The PC will display the detected error and operation status. The PC checks the programs stored in its own memory. If an error is detected, the PC will display the error portion.</td>
</tr>
<tr>
<td>PLC Keyword Current or Delete</td>
<td>Keyword Setting</td>
<td>This command can change or delete the keyword stored in the PLC. This command can change the keyword stored in the PC only. The keyword stored in the PLC will not be changed even if the controller is connected to the PC.</td>
</tr>
</tbody>
</table>
### 6.8.1 Program Check

This command checks the programs stored in the PC for syntax errors, double coils, and ladder circuit errors. If an error is detected, the step with an error will be displayed on the screen.

<table>
<thead>
<tr>
<th>Check</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax error</td>
<td>Checks the instruction codes and instruction formats. The check result will be displayed on the screen.</td>
</tr>
<tr>
<td>Double coil</td>
<td>Checks the device symbols and device numbers in the program for double use of output instructions (OUT, SET, PLS, PLF, MC, RST) or labels (P, I). The check result will be displayed on the screen.</td>
</tr>
<tr>
<td>Circuit</td>
<td>Checks the instructions in programs for circuit structural errors. The check result will be displayed on the screen. The error message displayed on the screen depends on the error type as described in the following table.</td>
</tr>
</tbody>
</table>

#### Error message

<table>
<thead>
<tr>
<th>Error message</th>
<th>Description</th>
<th>Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder error</td>
<td>There is a circuit that cannot be converted. Examples:</td>
<td>Check the ladder diagram, and correct it.</td>
</tr>
<tr>
<td></td>
<td>• A wrong instruction is used as the first instruction of the circuit.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The first instruction should be LD, LDI, or STL.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Over-stacking</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Wraparound circuit</td>
<td></td>
</tr>
<tr>
<td>Label error</td>
<td>Label instructions (P) are not used properly. Examples: CALL and P0 are used, but label P0 does not exist?</td>
<td>Check the labels, and correct label instructions.</td>
</tr>
<tr>
<td>Step ladder</td>
<td>The number of STL instructions was not appropriate, or the structure of the STL circuit is not appropriate. Examples: Nine consecutive STL instructions or more are set.</td>
<td>Check the STL instruction circuit, and correct the ladder diagram.</td>
</tr>
<tr>
<td>Program error</td>
<td>The subroutine program was not created properly. Examples:</td>
<td>Check the CALL and SRET instruction circuits, and correct the ladder diagram.</td>
</tr>
<tr>
<td></td>
<td>• The subroutine program is created at a wrong position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The subroutine is over-nested.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• An restricted instruction is detected in the subroutine.</td>
<td></td>
</tr>
<tr>
<td>Interrupt</td>
<td>The interrupt program was located not created properly.</td>
<td>Check the IRET, EI, and DI instruction circuits, and correct the ladder diagram.</td>
</tr>
<tr>
<td>Program error</td>
<td>Examples:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The interrupt program is located at a wrong position.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• No IRET instruction is set.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• An restricted instruction is detected in the interrupt program.</td>
<td></td>
</tr>
<tr>
<td>FOR-NEXT</td>
<td>The FOR-NEXT program was not created properly. Examples:</td>
<td>Check the loop instruction and correct the circuit.</td>
</tr>
<tr>
<td>Program error</td>
<td>• Syntax error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Over-nesting</td>
<td></td>
</tr>
</tbody>
</table>
6.8.2 Parameter Settings

This command sets the parameters for the PLC. The parameter-set items and parameter setting ranges depend on the type of the PLC as described below.

Change these values to change the devices in the power failure preventive range. The setting range depends on the PLC type. Refer to the instruction manual of your PLC. If the manual describes that the power failure preventive range should be fixed to the specified range, do not change the device numbers initially set.

The programs are stored in the program memory of the PLC. The program memory can be classified into two types; internal memory incorporated in the PLC and optional memory installed whenever necessary. You can allocate the memory area for various purposes by setting parameters. Specifically, the memory area can be allocated to comments*1, file registers, etc. for the PLC FX0N, FX, FX2C and FX2N series.

In one block comment area, comments for 50 devices can be written to the PLC. However, the allowable number of characters per comment is up to 16. If a comment consists of 17 or more characters, the 17th character and later are ignored when the comment is written to the PLC.
### Setting range

**Table 6.2**

<table>
<thead>
<tr>
<th>Unit: step</th>
<th>Memory type</th>
<th>Optional memory cassette or board</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Initial memory</td>
<td>4K step</td>
</tr>
<tr>
<td>Model</td>
<td>Setting data type</td>
<td></td>
</tr>
<tr>
<td>FX0</td>
<td>Program 0.8K</td>
<td></td>
</tr>
<tr>
<td>FX0S</td>
<td>File register</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>Fixed parameter</td>
</tr>
<tr>
<td>FX0N</td>
<td>Program 0-2K</td>
<td>0-2K</td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K</td>
</tr>
<tr>
<td>FX2N</td>
<td>Program 0-2K</td>
<td>0-4K</td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K</td>
</tr>
<tr>
<td>FX1S</td>
<td>Program 0-2K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-1.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K</td>
</tr>
<tr>
<td>FX1N</td>
<td>Program 0-8K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-7K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>7.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K/4K/8K</td>
</tr>
<tr>
<td>FX1NC</td>
<td>Program 0-8K</td>
<td></td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-7K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-7.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K/4K/8K</td>
</tr>
<tr>
<td>FX2N</td>
<td>Program 0-8K</td>
<td>0-4K</td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-7K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-7.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K/4K/8K</td>
</tr>
<tr>
<td>FX2NC</td>
<td>Program 0-8K</td>
<td>0-4K</td>
</tr>
<tr>
<td></td>
<td>File register</td>
<td>0-7K</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>0-7.5K</td>
</tr>
<tr>
<td></td>
<td>Total memory capacity</td>
<td>2K/4K/8K</td>
</tr>
</tbody>
</table>
1) The FX-EEPROM-4, FX-EEPROM-8 and FX-EPROM-8 are available in the FX2C, FX0N and FX2N Series.

2) The FX-EEPROM-4C and FX-EEPROM-8C are available in the FX, FX2C and FX0N Series. The clock function is available also in the FX, FX0N and FX2C Series. When using the clock function in the FX0N Series, however, an optional battery FX0N-40B is required.

3) The FX2NC-EEPROM-4C, FX2NC-EEPROM-16, FX2NC-EEPROM-16C and FX2NC-ROM-CE1 are available only in the FX2NC Series.

4) The FX-RAM-8C is available in the FX and FX2C Series. The clock function is available also in the FX and FX2C Series.

5) The FX1N-EEPROM-8L is available in the FX1S and FX1N Series.

6) The FX-RAM-8 is available in the FX, FX2C and FX2N Series.

7) The FX-EEPROM-16 and FX2N-ROM-E1 are available only in the FX2N Series.

**Default parameters setting**

**Table: 6.3**

<table>
<thead>
<tr>
<th>Item</th>
<th>Default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory capacity</td>
<td></td>
</tr>
<tr>
<td>Memory capacity</td>
<td>2000 steps</td>
</tr>
<tr>
<td>File register*1</td>
<td>0000</td>
</tr>
<tr>
<td>Comment area*2</td>
<td>0000</td>
</tr>
<tr>
<td>Program (only view)</td>
<td>2000 steps³</td>
</tr>
<tr>
<td>File register (only view)</td>
<td>0 words*4</td>
</tr>
<tr>
<td>Latch range*5</td>
<td></td>
</tr>
<tr>
<td>Auxiliary relay [M]</td>
<td>500-1023</td>
</tr>
<tr>
<td>State [S]</td>
<td>500-999</td>
</tr>
<tr>
<td>Counter (16bit) [C]</td>
<td>100-199</td>
</tr>
<tr>
<td>Counter (32bit) [C]</td>
<td>220-255</td>
</tr>
<tr>
<td>Data register [D]</td>
<td>200-511</td>
</tr>
</tbody>
</table>

*1 File register is set 500 words/block. A block consumes 500 steps from memory capacity.

*2 Comment area is set 50 comment/block. A block consumes 500 steps from memory capacity.

*3 Actual program capacity is 800 steps for FX0 and FX0S series PLC.

*4 FX0 and FX0S series PLC cannot support File resister.

*5 FX, FX2C, FX2N and FX2NC series PLC can set the following range for each device.

**Table: 6.4**

<table>
<thead>
<tr>
<th>Device</th>
<th>Setting range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auxiliary relay</td>
<td>0-1023</td>
</tr>
<tr>
<td>State</td>
<td>0-999</td>
</tr>
<tr>
<td>Counter (16bit)</td>
<td>0-199</td>
</tr>
<tr>
<td>Counter (32bit)</td>
<td>200-255</td>
</tr>
<tr>
<td>Data register</td>
<td>0-511</td>
</tr>
</tbody>
</table>
6.8.3 Keyword Setting

This command can be used to store, change, or delete the keyword for the program stored in the PC. The set keyword will not affect the keyword stored in the PLC.

For a detailed description of the keyword, refer to Sec. 6.6.5 “PLC Keyword Current or delete”.

6.8.4 PLC’s Mode Setting

This command is used to set parameters for the battery-less mode, modem, and RUN terminal.

Click ON button to disable the memory backup battery on the FX2N, FX2NC series PLCs.

Enter data in this box to use a modem.
None, User entry mode, AIWA (PV-AF288), OMRON (ME3314B)

Specify the a device in this box to which the external run/stop signal is input.
X0 to X17 (X0 to X7 for FX2N-16M and FX2NC-16M Type)

Click the Yes button to enable the external run/stop signal to an FX1S, FX1N, FX2N and FX2NC series PLC.
6.8.5 Serial Setting (Parameter)

Serial communication settings will be stored in the parameter memory of the FX1S, FX1N, FX2N and FX2NC series PLC, and copied to the special diagnostic registers D8120 (communication format), D8121 (station number setting), and D8129 (overtime judgment value).

The values shown below will be loaded as the initial values, if the parameters are not set manually this dialog box will appear on the display to ask whether the initial values should be changed.

The dialog box to the left will appear on the display to ask whether or not the initial values should be changed. The values shown below will be loaded as default values if the user does not set the parameters manually.

- **RS instruction, Link (Computer Link)**: 7, 8
- **None, Odd, Even**: 1, 2
- **Click this button to erase the set parameters. (Each register value will be reset to zero.)**: None
- **OFF, ON**: Normal/RS-485, Modem/RS-232C
- **OFF, ON**: No
- **Yes**: Normal/RS-485, Modem/RS-232C
- **00h - 0FH (00)**: 1 - 255 (1)
- **_: Initial condition**
6.8.6 Printer Title

Use this command to set the title to be printed on a document.

Enter a title in this box. Up to 12 characters can be changed.

Example: Title change

Document printed

1. Title Test Program No.1

2. Machine Type: KAZ-HA-1M

3. Controller FX2N-64MR

4. User ABCD CORPORATION

5. Version A

6. Designer B******

7. Maker August 1997

8. Date C******

9. Approver D****
6.8.7 Device range Setting

Device ranges are specified for the PLC, however device ranges can be specified using this command.

After setting device ranges, any out-of-range devices cannot be entered even if the PLC stores the device numbers.
This function is valid when you enter or check programs.
6.8.8 Comment Move

This command converts the DOS type comments stored in the program area to the FXGP/WIN-E type comments. The converted comments are stored in files (*.COW). In addition, the converted comments can be displayed on the screen and edited.

For a detailed description of the DOS type comments controlled by the FXGP/WIN-E, refer to Sec.1.4.

Flowchart for comment conversion

- If a device has a device comment already stored, the new comment will be overwritten by the previous comment when comment conversion is executed.
- After comment conversion, the comments stored in the program area may be unnecessary. If they are unnecessary, click Parameter Setting and then Comment Area. After that, set the number of blocks to "0" to delete the comments from the program area.
- After conversion, the converted device comments will be regarded as comments not to be written to the PLC. To write device comments to the PLC, specify the range and refer to Sec. 6.3.9.
6.8.9 PLC Type Change

Change the model recognition in a program.

The interface to select a change destination model is displayed.

Select a model to change the current model to the selected mode.

Click “OK” button

When [Yes (Y)] is selected, all device ranges are available in the change destination model (newly selected model).

When [No (N)] is selected, inputs to only a device range specified for the previously selected model or a device range set through [Options (O) → Assign Device (D)] are enabled in the change destination model.

When special restriction is not required in devices available in the change destination model, select [Yes (Y)].

(Select [Yes (Y)] usually.) When applying the device range available in the previously selected model to the change destination model, select [No (N)].

Change from an upper-level model to a lower-level model

- Changing from an upper-level to a lower-level PLC will not automatically adjust the current program for incompatibilities with newer instructions or devices. The program can be corrected before or after the PLC type has been changed. If the program is not corrected, a program error will occur when the program is transferred to the PLC.

- Parameters can also cause problems when trying to change the PLC type. If a parameter setting is not compatible with the PLC that has been selected, the message “parameter error” will be displayed and the change will be aborted. In this case, the parameter setting should be adjusted to a setting compatible with the new PLC type.
6.8.10 Preferences

This command sets the operation environment for the FXGP/WIN-E.

1) Selecting the Yes option will cause the device comment entry dialog box to appear when a circuit symbol is entered in the ladder diagram edit window. Selecting the No option will not allow the device comment entry dialog box to appear automatically when editing the ladder diagram. The Edit command or the comment window should be used to enter device comments in this case.

2) Click the Yes button in the Automatically Verify box. After that, if you write programs in the PLC, the programs will be automatically collated. If you click the No button, programs can be written in the PLC, but no collation will be performed. (see Sec.6.6.1)

3) Selecting Yes will synchronize the ladder and list views so that the cursor position in the ladder diagram will indicate the step to display at the top of the list view window, and vice versa. Selecting No will disable this feature but selecting Refresh from the Window menu will synchronize the two views again.

4) Select the line type (Regular or Bold) for the ladder circuit display. The line type selected here is valid for display of Ladder view and printout of ladder circuit diagrams. (see Sec.6.9)

5) Selecting "Convert and runtime program changes" will write the program changes to the PLC during RUN status when CNV (F4) or "Tools → Convert" is executed as described in "5.6.6 Runtime Program Changes." "Convert only" should be selected when write in RUN status should not execute after a circuit has been changed or if a PLC is not connected.

6) If the current file has comments in the program, a confirmation message will appear and ask the user whether or not the comments should be transferred to the device comment area. The comments in the device comment area will be overwritten without confirmation if the "Hide Message" option is selected.
6.8.11 EPROM Transfer

This command reads, writes, or collates the program data using the optional EPROM type memory cassette or EPROM IC installed on a ROM writer. This transfer requires a personal computer attached to a general-purpose ROM writer via an RS-232C cable with the EPROM type memory cassette or EPROM IC install on the ROM writer.

Connection method: Refer to Sec.1.2.3 “System configuration”.

ROM writer: PECKER-11 manufactured by AVAL, or the equivalent ROM writer (Intel hex used as data transfer format)

Applicable memory cassette: FX-EPROM-8 (Note that ROM adapter FX-ROM-SOC-1 (optional) is needed.)

Data transfer: Program memory clear (parameters, programs, comments, file registers)

Read
Reads out data from the ROM writer, and stores the data in the memory of the PC. To read data, the appropriate PLC model name should be chosen, then reading can be executed. If the keyword is stored in the ROM, keyword entry dialog box will appear on the display. The operator will need to know the keyword to proceed.

Write
Transfers the data stored in the program memory area of the PC to the memory of the ROM writer.

Verify
Collates the data stored in the memory of the PC with the data stored in the memory of the ROM writer.

Regarding ROM writer

Generally, when reading, the ROM writer reads out the data from the ROM and stores the data in its memory. When writing to the EPROM, the data transferred from the PC is stored in the memory of the ROM writer.

For a detailed description of the ROM writer, refer to the instruction manual of the ROM writer.
6.8.12 Font

This command sets the font for the FXGP/WIN-E.

Changing the font size in this window adjusts the size of the symbols displayed in the ladder diagram or the characters displayed in the instruction list.

Also, the Zoom (Z) command changes the size of the displayed symbols and characters.

Initial setting (Recommendation)

- Font: MS sans serif
- Font Style: Bold
- Size: 7
6.9 Window Menu Functions

The commands on the Window menu, changes the current window display method.

Example: Overlapped windows

Example: Cascaded windows and filed windows

The windows currently open are shown on the pull-down menu. Click the mouse button on a window name to select the window.

Refresh synchronizes the program steps of the ladder program edit window and the list program edit window using the cursor as the reference position (see Sec.6.8.10).
6.10 Help Menu Functions

The Help screen describes how to operate the FXGP/WIN-E and how to use various functions.

Displays the Help screen.

Displays the FXGP/WIN-E software version number.
7. Creating Ladder and Instruction Programs

This section describes the main operations necessary for creating or editing ladder programs or instruction programs and the main items necessary for programming.

7.1 Use of Programming Window

- To create a ladder program, open the ladder program edit window. Click File and then New or click View and then Ladder View to open the ladder program edit window. To create or edit ladder circuit, use the symbols allocated to the function keys, and the Tools command on the Edit menu.

- To create a instruction program, open the instruction list program edit window. Click File and then New or click View and the Instruction View to open the instruction edit window. To create or edit instruction lists, use the symbols allocated to the function keys, and the commands on the menu bar.

- The main difference between the ladder program edit window and the instruction list program edit window is that the instruction entered in the instruction list will be valid, but the instructions entered in the ladder diagram is not valid until it is converted and set in the instruction list. The figure to the left shows both the list program edit window and the corresponding ladder program edit window filed to fit one screen.

For the reasons described above, the same program will be shown in both windows at the completion of the ladder circuit conversion, or at the completion of the creation of 1 ladder circuit block. Both windows may be synchronized by clicking the Options, then Preferences, and selecting Synchronous mode, or by clicking Window, followed by Refresh.
7.2 Creating Ladder Programs

7.2.1 Main operations necessary for entering ladder circuit symbols

There are two symbol entry methods. One is to use the symbols allocated to the function keys of the ladder program edit window, and the other is to use the Tools command on the menu. For both methods a dialog box will appear for entering data.

Entering contact symbol (method 1)
Using instruction entry dialog box:

Entering a-contact symbol (LD, AND, OR)
• \([-\)\] (F5 or tool pallet)
• Tools \(\rightarrow\) Contact \(\rightarrow\) \([-\)\]
  To use this symbol as the OR, enter additional vertical lines.

Directly entering OR symbol
• \([-\)\] (Shift + F5 or tool pallet)

Entering a-contact symbol (LDI, AND, ORI)
• \([-\)\] (F6 or tool pallet)
• Tools \(\rightarrow\) Contact \(\rightarrow\) \([-\)\]
  To use this symbol as the ORI, enter additional vertical lines.

Directly entering ORI symbol
• \([-\)\] (Shift + F5 or tool pallet)

Applicable devices:
  X (input relay)  M (auxiliary relay)  T (timer)
  Y (output relay) S (state)  C (counter)

Data entry method 1
Entering device number

Data entry method 2
Entering device name

Device symbol
Device number

Device name stored for
X, Y, M, T or C
Entering contact symbol (method 2)

Using instruction entry dialog box:

**Entering rise detection symbol (LDP, ANDP, ORP)**
- \([\text{T}]\) (F2 or tool pallet)
- Tools → Contact → \([\text{P}]\)
To use this symbol as the ORP, enter additional vertical lines.

**Directly entering ORP symbol**
- (Shift + F2 or tool pallet)

**For LDP, ANDP, and ORP instructions**

- \([\text{T}]\)
- \([\text{P}]\)

**For ORP instruction only**

- \([\text{P}]\)

**Entering fall detection symbol (LDF, ANDF, ORF)**
- \([\text{F}]\) (F3 or tool pallet)
- Tools → Contact → \([\text{F}]\)
To use this symbol as the ORF, enter additional vertical lines.

**Directly entering ORF symbol**
- (Shift + F3 or tool pallet)

**For LDF, ANDF, and ORF Instructions**

- \([\text{F}]\)

**For ORF Instruction only**

- \([\text{F}]\)

**Applicable devices:**
- X (input relay)  M (auxiliary relay)  T (timer)
- Y (output relay)  S (state)  C (counter)

**Data entry method 1**

Entering device number

- X  D  ←
  - Device number
  - Device symbol

**Data entry method 2**

Entering device name

- L  S  1  D
  - Device name stored for X, Y, M, S, T or C
**Entering coil symbol**

Using instruction entry dialog box:

- **F7** (F7 or tool pallet)
- Tools → Coils

**Applicable devices:**
- Y (output relay)
- S (state)
- T (timer)
- M (auxiliary relay)
- C (counter)

**Data entry method 1: Entering device number:**

- **Y** D →
  - Device symbol (Y, M or S)
  - Device number
  
- **T** 0 SPACE K 1 →
  - Device symbol (T or C)
  - Device number
  - Specifying constant using decimal number

**Data entry method 2: Entering device name:**

- **RY** 1 →
  - Device name stored for Y, M or S
  
- **WAIT** 1 K 1 →
  - Device name stored for T or C
  - Specifying constant using decimal number

**Data entry method 3: Entering both device number and device name:**

- **T** 0 SPACE 1 0 S →
  - Device symbol (T or C)
  - Device number
  - Device name stored for indirectly specified data register

- **WAIT** 1 D 0 →
  - Device name stored for T or C
  - Indirectly specifying constant using data register
**Entering special coil symbol**

Using instruction entry dialog box:

- (F8 or tool pallet)
- Tools → Function

**Applicable instructions:**

- SET/RST
- PLS/PLF
- MC/MCR
- STL/RET
- END

**Data entry method:** Entering special coil by specifying device number:

- **SET/RST instruction**
  - Device symbol: SET, Y, M, S
  - Device number

- **PLS/PLF instruction**
  - Device symbol: Y, M
  - Device number

- **MC instruction**
  - Device symbol: Y, M
  - Device number

- **MCR instruction**
  - Nesting level

- **STL instruction**
  - Device numbers

Regarding the data entry method, just described device names can be entered in place of the device symbols.
For the device name entry method, refer to Entering contact symbol or Entering coil symbol described on the previous pages.
Entering application instruction

Using instruction entry dialog box:

- \( \text{F8} \text{ or tool pallet} \)
- Tools → Function

Data entry method 1: Entering application instruction by specifying instruction word:

16-bit MOV instruction

\[
\begin{array}{c}
\text{M} \quad \text{O} \quad \text{V} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{S} \quad \text{P} \quad \text{A} \quad \text{C} \quad \text{E} \\
\text{Operands}
\end{array}
\begin{array}{c}
\text{K} \quad \text{1} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

16-bit MOV instruction of pulse execution type

\[
\begin{array}{c}
\text{M} \quad \text{O} \quad \text{V} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{S} \quad \text{P} \quad \text{A} \quad \text{C} \quad \text{E} \\
\text{Operands}
\end{array}
\begin{array}{c}
\text{K} \quad \text{1} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

32-bit MOV instruction

\[
\begin{array}{c}
\text{D} \quad \text{M} \quad \text{O} \quad \text{V} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{S} \quad \text{P} \quad \text{A} \quad \text{C} \quad \text{E} \\
\text{Operands}
\end{array}
\begin{array}{c}
\text{K} \quad \text{4} \quad \text{0} \quad \text{0} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

32-bit MOV instruction of pulse execution type

\[
\begin{array}{c}
\text{D} \quad \text{M} \quad \text{O} \quad \text{V} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{S} \quad \text{P} \quad \text{A} \quad \text{C} \quad \text{E} \\
\text{Operands}
\end{array}
\begin{array}{c}
\text{K} \quad \text{4} \quad \text{0} \quad \text{0} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

Data entry method 1: Entering application instruction by specifying FNC.number:

16-bit MOV instruction

\[
\begin{array}{c}
\text{F} \quad \text{N} \quad \text{C} \\
\text{FNC. No.}
\end{array}
\begin{array}{c}
\text{I} \quad \text{N} \quad \text{S} \quad \text{T} \quad \text{R} \quad \text{I} \quad \text{C} \quad \text{T} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{K} \quad \text{1} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

16-bit MOV instruction of pulse execution type

\[
\begin{array}{c}
\text{F} \quad \text{N} \quad \text{C} \\
\text{FNC. No.}
\end{array}
\begin{array}{c}
\text{I} \quad \text{N} \quad \text{S} \quad \text{T} \quad \text{R} \quad \text{I} \quad \text{C} \quad \text{T} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{K} \quad \text{1} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

32-bit MOV instruction

\[
\begin{array}{c}
\text{F} \quad \text{N} \quad \text{C} \\
\text{FNC. No.}
\end{array}
\begin{array}{c}
\text{I} \quad \text{N} \quad \text{S} \quad \text{T} \quad \text{R} \quad \text{I} \quad \text{C} \quad \text{T} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{K} \quad \text{4} \quad \text{0} \quad \text{0} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

32-bit MOV instruction of pulse execution type

\[
\begin{array}{c}
\text{F} \quad \text{N} \quad \text{C} \\
\text{FNC. No.}
\end{array}
\begin{array}{c}
\text{I} \quad \text{N} \quad \text{S} \quad \text{T} \quad \text{R} \quad \text{I} \quad \text{C} \quad \text{T} \\
\text{Instruction word}
\end{array}
\begin{array}{c}
\text{K} \quad \text{4} \quad \text{0} \quad \text{0} \quad \text{0} \\
\text{Operand 1}
\end{array}
\begin{array}{c}
\text{K} \quad \text{D} \\
\text{Operand 2}
\end{array}
\]

Regarding the data entry method, just described device names can be entered in place of the operands. For the device name entry method, refer to Entering contact symbol or Entering coil symbol described on the previous pages.
Entering an instruction using the Reference command

Clicking the Reference button in the contact, coil, special coil, or application instruction entry dialog box displays a list of device names and application instructions to choose from. Section 6.3 "Tools" contains a detailed description of operation in each dialog box.

Displays selected instruction.
Example: ZCP, DZCP, FNC11, FNCD11P

These boxes will become active depending on the number of operands required for the instruction.

Displays the instruction types
Options

Operand and device name list.
Entering INV instruction

One of the following operations can be used to enter the INV instruction in the ladder circuit.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description of motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift + [F7] (→/←)</td>
<td>The INV instruction will be entered.</td>
</tr>
<tr>
<td>Tool pallet (→/←)</td>
<td></td>
</tr>
<tr>
<td>[ Tools ] → [ Wire ] → [→/←(1)]</td>
<td></td>
</tr>
<tr>
<td>[N] [V]</td>
<td></td>
</tr>
</tbody>
</table>

Entering horizontal line:

One of the following operations can be used to enter a horizontal line in the ladder circuit.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description of motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>[F9] (→)</td>
<td>A horizontal line will be entered.</td>
</tr>
<tr>
<td>←</td>
<td></td>
</tr>
<tr>
<td>Tool pallet (→)</td>
<td>A horizontal line will be entered.</td>
</tr>
<tr>
<td>[ Tools ] → [ Wire ] → [→]</td>
<td></td>
</tr>
<tr>
<td>A, N, B</td>
<td></td>
</tr>
<tr>
<td>A, N, 9, K1 ~ K1, 1</td>
<td>The specified number of horizontal lines will be entered. (The number is specified by K.)</td>
</tr>
<tr>
<td>Alt + → / ←</td>
<td>A continuous line of desired length can be drawn rightward or leftward.</td>
</tr>
</tbody>
</table>
### Entering vertical line

A continuous line of desired length can be drawn upward or downward.

![Diagram of vertical line]

One of the following operations can be used to enter a vertical line in the ladder circuit.

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description of motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>↑Shift + P9 (I)</td>
<td>A vertical line will be entered.</td>
</tr>
<tr>
<td>↑Shift + I</td>
<td></td>
</tr>
<tr>
<td>Tool pallet (I)</td>
<td></td>
</tr>
<tr>
<td>[ Tools ]→[ Wire ]→[ I ]</td>
<td></td>
</tr>
<tr>
<td>ORB</td>
<td></td>
</tr>
<tr>
<td>ORB K1~K49</td>
<td>The specified number of vertical lines will be entered. (The number is specified by K.)</td>
</tr>
<tr>
<td>Alt + ↑ / ↓</td>
<td>A continuous line of desired length can be drawn upward or downward.</td>
</tr>
</tbody>
</table>
**Entering special instruction**

**Entering label P or I:**
Position the cursor on the left side of the bus in the ladder diagram, and then press the P or I key. The label entry dialog box will appear on the display.

![Label dialog box]

**Manual setting of ladder circuit turning point:**
Double-click the turning point number, or position the cursor on the turning point, and then press the K key. The Turning Point dialog box will appear on the display. Using this dialog box, you can change the turning point number automatically sampled.

The turning point number can be set in the range of 0 to 255.
7.2.2 Instruction type ladder circuit entry

In the ladder program edit window, you can enter ladder circuit symbols using the methods described before. In addition, you can also enter instructions, such as AND and OUT, to edit ladder diagrams (Instruction type entry method).

Applicable instructions:
LD, LDI, LDP, LDF  PLS, PLF
AND, ANI, ANDP, ANDF  STL, RET, MC, MCR
OR, ORI, ORP, ORF  INV, ANB, ORB, P, I
OUT, SET, RST  Application instructions (FNC numbers or instruction words)

Data entry method:
Refer to the data entry methods described in Sec.7.3.1.

Ladder diagram drawing concept and symbol conversion:
All the instruction words entered will be converted into ladder circuit symbols, and then displayed on the screen. This method can be used together with the ladder circuit symbol entry method described before.

<table>
<thead>
<tr>
<th>Instruction word / Keyboard operation</th>
<th>Symbol to be drawn on ladder diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD, AND</td>
<td></td>
</tr>
<tr>
<td>LDI, ANI</td>
<td></td>
</tr>
<tr>
<td>LDP, ANDP</td>
<td></td>
</tr>
<tr>
<td>LDF, ANDF</td>
<td></td>
</tr>
<tr>
<td>OR/ ORI</td>
<td></td>
</tr>
<tr>
<td>ORP/ ORF</td>
<td></td>
</tr>
<tr>
<td>INV</td>
<td></td>
</tr>
<tr>
<td>ANB</td>
<td></td>
</tr>
<tr>
<td>ANB K1 to K11</td>
<td>(1 horizontal line)</td>
</tr>
<tr>
<td>Alt + / / / (Continuous horizontal line of desired length)</td>
<td></td>
</tr>
<tr>
<td>ORB</td>
<td>(1 vertical line)</td>
</tr>
<tr>
<td>ORB K1 to K49</td>
<td>(1 to 49 continuous vertical lines)</td>
</tr>
<tr>
<td>Alt + / / (Continuous vertical line of desired length)</td>
<td></td>
</tr>
</tbody>
</table>

For application instructions other than the ones above, simply enter the FNC numbers (example: FNC12 K1 D0) or instruction words (example: MOV K1 D0). The application instructions entered will be written in the ladder diagram.

Program conversion:
For a ladder program created with the instruction type entry method, it is necessary to convert the ladder program into a list program.
If the ladder program edit window is closed before completing conversion, the program will be erased (see Sec.7.2.3).
In the ladder program edit window, position the cursor where the new ladder circuit symbol should be located. Then, enter the first character of the instruction word. The instruction word entry box will appear.

Press the key to confirm the instruction word.

Press the key to confirm the instruction word.

Press the key to confirm the instruction word.

Press the key to confirm the instruction word.

Press the key to confirm the instruction word.

Press the key to confirm the instruction word.

The program will be updated at the completion of conversion.
7.2.3 Essentials for programming

Use the ladder program edit window to create ladder programs. Editing of the ladder circuit can be done in this window.

Conversion

- The ladder circuit ladder diagrams created in the ladder program edit window should be converted into instruction lists.
- If the ladder program edit window is closed before completing conversion, the programs created in the ladder diagram will be erased.
- If programs are created in the list program edit window, conversion will not be necessary. This is because instruction words are directly entered in the instruction lists.
- In the ladder diagram, non-converted sections will be dimmed in units of lines. At the completion of conversion, the dimmed section will be changed to normal, and the program step numbers will be determined.

- Press the **CNV** (F4) key, or click Tools and then Convert to convert the ladder diagram into an instruction list.
- Conversion can be executed only if the ladder circuit block is complete. If you execute conversion without completing the ladder circuit block or with a wrong program, an error message will appear on the display, and conversion will not be performed.
- If an error message appears, correct the error, and then execute conversion again.
- After determination of the step number, if you delete the entire ladder circuit block by individually deleting the symbols or using the Line Delete command, be sure to enter a new ladder circuit in the null section. If no ladder circuit is entered, a ladder circuit error will be detected at ladder diagram conversion.

To delete the entire block after determination of step number, specify the block range using the **[SHI]** + ![Function Key Image](image.png) + dragging mouse, or Block Select command, and then click the Cut or Delete command or press the Delete key.

To cancel the ladder diagram delete or edit operation, click the control menu box at the upper left corner of the ladder diagram window. The window will be closed. After that, open the window again to display the ladder diagram.

Be careful! When you close the ladder diagram window, all the edited data will be erased if they are not converted.

- Conversion can be executed for two or more ladder circuit blocks at a time. Note that up to 200 lines can be converted at a time. When the number of non-converted lines exceeds 200, a message will appear on the display, and request conversion.

- Up to 50 lines of ladder circuit blocks can be programmed in the ladder program edit window. This means that the 51st and the subsequent lines cannot be entered. If you use the list program edit window for programming, the 51st and subsequent lines will not be displayed, either. In addition, these excessive lines cannot be printed.

If the DOS version peripheral unit, A6GPP/PHP, or GP-80 is used for printing of ladder diagrams, limit the number of lines to 24 because these peripheral units cannot print more lines.
- After conversion of the MC (master control) or MCR (master control reset) instruction, the ladder display style of the FXGP/WIN-E V1.** will differ from that of the DOS version peripherals and A6GPP. The difference in the display style is shown below:

<table>
<thead>
<tr>
<th>SW1PC- FXGPEE (DOS)</th>
<th>FXGP/WIN-E (V1.**)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FXGP/WIN-E (V2.00 or later)</td>
<td>A6GPP</td>
</tr>
</tbody>
</table>

```
N0 M0

[ MC N0 M0 ]

[ MCR N0 ]

[ MC N0 M0 ]

[ MCR N0 ]
```


Use of double coil
It is possible to enter two or more OUT instructions for the same coil. However, operation of the PLC will be more complicated.
At the completion of programming, click Option and then Program Check to check the program for double coils.

Automatic ladder circuit turning
- Up to 11 contacts in series can be entered in each line. The 12th contact will be automatically sent to the next line. If a coil instruction is entered at the 12th point, it will be also sent to the next line. Such ladder circuit turning can be performed up to 20 times, and up to 211 contacts can be entered. Turning point numbers 0 to 255 can be allocated to the turning points. These numbers can be manually changed (see Sec.7.2.1).
- If the STL (step ladder) instruction is in the ladder diagram, ladder circuit turning will not be possible for the program following the STL instruction.
  In addition, ladder circuit turning will not be possible for the internal ladder circuit drawn in the SFC program edit window.

Unacceptable ladder diagram
The ladder circuit blocks marked with "×" cannot be converted. Correct such unacceptable blocks into those marked with "O", and then convert them.
7.2.4 Creating ladder circuit ladder diagram

Creating new ladder diagram
Click File and then New to create a new ladder circuit ladder diagram. To clear all the ladder circuits stored, click Tools and then All Clear.

Creating ladder diagram
Use the ladder circuit symbols allocated to function keys, tool pallet, list type entry method, or Tools command to create ladder diagrams. For the ladder circuit symbol entry method, refer to Sec.7.2.1 "Main operations necessary for entering ladder circuit symbols".

- Non-converted ladder circuit blocks in the ladder program will be dimmed.
- When conversion is executed, the ladder program displayed on the screen will be converted into an instruction list.
- At the completion of conversion, the program steps will be determined, omitting any empty spaces and adjusting circuit layout. In addition, dimmed blocks will be changed to normal.
- Even after conversion, automatic writing to the memory of the PLC can be executed in the run mode (see Sec. 6.6.6 and Sec. 6.8.10).
Editing

To edit the specified range, click Edit, and then click Cut, Copy, Paste, or Delete.

Press the Insert key to change the data entry mode from Overwrite to Insert, or vice versa.

Function keys (or click the mouse button on the desired function key to use the function.)

Indicates the number of steps used/total number of steps.

Pressing the Enter key on a contact or output coil, or double-clicking the mouse button on a contact or output coil will cause the instruction change dialog box to appear on the display. If changes need to be made, Enter new data.

Various functions of right mouse button

Click the right button of the mouse on the ladder diagram to perform following operations:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Cancels the last operation.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes the graphic from the cursor position or specified range.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the graphic from the cursor position or specified range.</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes the Clipboard data (graphic data temporarily stored) on the cursor position.</td>
</tr>
<tr>
<td>Edit cancel</td>
<td>Deletes the ladder diagram just edited.</td>
</tr>
</tbody>
</table>
### Editing (after conversion)

**Keys and commands used for editing ladder diagram**

<table>
<thead>
<tr>
<th>Item</th>
<th>Editing</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range specity</td>
<td>Specifies the edit range in units of symbols in the circuit block.</td>
<td>Drag the mouse to specify the range in units of symbols.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Ctrl) + (←) / (→) / (↑) / (↓)</td>
</tr>
<tr>
<td></td>
<td>Specifies the edit range in units of circuit blocks.</td>
<td>(↑Shift) + (↑) / (↓)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(↑Shift) + mouse dragging</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edit → Block Select</td>
</tr>
<tr>
<td>Symbol delete</td>
<td>Deletes the cursor-positioned symbol.</td>
<td>(Delete)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edit → Delete</td>
</tr>
<tr>
<td></td>
<td>Deletes to the left of the cursor.</td>
<td>(Shift) + (space)</td>
</tr>
<tr>
<td></td>
<td>Deletes a vertical line.</td>
<td>Tools → Wire → IDEL</td>
</tr>
<tr>
<td></td>
<td>Deletes a line or symbol.</td>
<td>Tool pallet (IDEK)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Ctrl) + (Alt) + (←) / (→) / (↑) / (↓)</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies symbols in the specified range.</td>
<td>Edit → Copy</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Ctrl) + (C)</td>
</tr>
<tr>
<td>Paste</td>
<td>Pastes data sent from the clip board.</td>
<td>Edit → Paste</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(Ctrl) + (V)</td>
</tr>
<tr>
<td>Line edit</td>
<td>Inserts one line at the cursor position.</td>
<td>Edit → Line Insert</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(↑Shift) + (Left)</td>
</tr>
<tr>
<td></td>
<td>Deletes the cursor-positioned line (right side of the cursor).</td>
<td>Edit → Line Delete</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(↑Shift) + (Delete)</td>
</tr>
<tr>
<td>Block delete</td>
<td>Deletes the step-number-determined circuit blocks.</td>
<td>Specify the edit range in units of blocks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Edit → Cut or Delete</td>
</tr>
<tr>
<td>Edit cancel</td>
<td>Deletes the ladder diagram you edited.</td>
<td>Edit → Edit Cancel</td>
</tr>
<tr>
<td>Undo</td>
<td>Cancels the last operation, and returns to the previous condition.</td>
<td>Edit → Undo</td>
</tr>
<tr>
<td></td>
<td>(Ladder circuit block conversion operation, however, will not be cancelled.)</td>
<td>(Ctrl) + (Z)</td>
</tr>
<tr>
<td>Scroll</td>
<td>Scrolls the screen (or moves the cursor).</td>
<td>Scroll bar</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(↑) / (↓)</td>
</tr>
<tr>
<td></td>
<td>Jumps to the specified position.</td>
<td>Search → Top, end, device, instruction/coil, step number, tag</td>
</tr>
<tr>
<td>Device Change</td>
<td>Changes devices.</td>
<td>Search → Replace, a-contact/b-contact change, convert</td>
</tr>
<tr>
<td>Comment</td>
<td>Enter or changes comments.</td>
<td>Edit → Device name, device comment, coil comment, block comment</td>
</tr>
</tbody>
</table>
Note regarding ladder circuit block delete

If step numbers are already determined for the ladder circuit blocks, you can delete the blocks by following the procedure below:

1) If you want to delete ladder circuit blocks, specify the delete range using the mouse dragging, or Block Select command.

2) Click Cut or Delete, or press the Delete key to delete the specified blocks. When deleted, the corresponding instructions will be also deleted from the instruction list. It is, therefore, not necessary to convert the changed ladder diagram into an instruction list.

After deleting a step-number-determined entire ladder circuit block in units of symbols or using the Line Delete command, be sure to enter a new ladder program in the blank line. If a line remains blank, a conversion error will be detected. To delete an entire ladder circuit block, be sure to follow the above procedure.

To cancel the ladder diagram delete or edit operation, click the control menu box at the upper left corner of the ladder program edit window. The window will be closed. After that, open the window again to display the ladder diagram.

Be careful.
When you close the ladder program edit window, all the edited data will be erased if they are not converted.
7.3 Creating Instruction List Program

7.3.1 Main operations necessary for entering instruction words

Entering contact instruction

Instruction word entry method and ladder program displayed:

[LD] (Load, Initial logical operation contact type NO <normally open>)

\[
\text{LD instruction} \quad \text{Function key} \quad \text{Device number} \quad \text{Device symbol}
\]

\[
\begin{array}{c|c|c|c}
\text{LDI} & \text{X} & \text{X} & \text{LDI} \\
\text{ANI} & \text{X} & \text{X} & \text{ANI}
\end{array}
\]

[AND] (AND, Serial connection of NO <normally open contact>)

\[
\text{AND instruction} \quad \text{Function key} \quad \text{Device number} \quad \text{Device symbol}
\]

\[
\begin{array}{c|c|c|c}
\text{LDI} & \text{X} & \text{X} & \text{LDI} \\
\text{ANI} & \text{X} & \text{X} & \text{ANI}
\end{array}
\]

Devices applicable to LD, LDI, AND, ANI instructions:

- X (input relay)
- M (auxiliary relay)
- T (timer)
- Y (output relay)
- S (state)
- C (counter)
Instruction word entry method and ladder diagram displayed:

[LDP] (Load pulse, Initial logical operation - Rising edge pulse)

\[
\text{LDP instruction} \quad \text{Device number} \quad \text{Device symbol}
\]

Ladder program displayed:

\[
\begin{array}{c}
\text{X000} \\
\text{LDP} \\
\text{X001} \\
\text{ANDP}
\end{array}
\]

[ANDP] (AND pulse, Serial connection of Rising edge pulse)

\[
\text{ANDP instruction} \quad \text{Device number} \quad \text{Device symbol}
\]

Ladder program displayed:

\[
\begin{array}{c}
\text{X000} \\
\text{LDF} \\
\text{X001} \\
\text{ANDF}
\end{array}
\]

[LDF] (Load falling, Initial logical operation Falling/trailing edge pulse)

\[
\text{LDF instruction} \quad \text{Device number} \quad \text{Device symbol}
\]

Ladder program displayed:

\[
\begin{array}{c}
\text{X000} \\
\text{LDF} \\
\text{X001} \\
\text{ANDF}
\end{array}
\]

[ANDF] (AND falling, Serial connection of Falling/trailing edge pulse)

\[
\text{ANDF instruction} \quad \text{Device number} \quad \text{Device symbol}
\]

Device applicable to LDP, LDF, ANDP and ANDF instructions:

<table>
<thead>
<tr>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>input relay</td>
</tr>
<tr>
<td>M</td>
<td>auxiliary relay</td>
</tr>
<tr>
<td>T</td>
<td>timer</td>
</tr>
<tr>
<td>Y</td>
<td>output relay</td>
</tr>
<tr>
<td>S</td>
<td>state</td>
</tr>
<tr>
<td>C</td>
<td>counter</td>
</tr>
</tbody>
</table>
Instruction word entry method and ladder program displayed:

[OR] (OR, Parallel connection of NO <normally open> contacts)

OR instruction

Device number
Device symbol

or (OR)

Device number
Device symbol

[ORI] (OR inverse, Parallel connection of NC <normally closed> contacts)

ORI instruction

Function key

Device number
Device symbol

[ORP] (OR pulse, Parallel connection of Rising edge pulse)

ORP instruction

Device number
Device symbol

[ORF] (OR falling, Parallel connection of Falling/trailing edge pulse)

ORF instruction

Device applicable to OR, ORI, ORP and ORF instructions:

X (input relay)    M (auxiliary relay)    T (timer)
Y (output relay)   S (state)             C (counter)
Instruction word entry method and ladder program displayed

[STL] (Step ladder, step ladder operation contact type NO <normally open>)

STL instruction
Device number
Device symbol

Ladder program display:

Device applicable to STL instructions:
S (State)

Instruction word entry method: Specifying device name
To specify the device, enter a device name in place of a device number.

Example:

Instruction word
Device name stored for X, Y, M, S, T and C

Function key
for entering instruction word
Entering coil instruction

Instruction word entry method and ladder program displayed:

[OUT] (Output, Final logical operation type coil drive)

```
[OUT] T 0  K100
[OUT] C 1  D50
```

Ladder program display:

Device applicable to OUT instructions:

- Y (output relay)
- S (state)
- T (timer)
- M (auxiliary relay)
- C (counter)
Instruction word entry method: Specifying device name
To specify the device, enter a device name in place of a device number.

Example:

```
OUT   SPACE   R   Y   1   ↓
```

OUT instruction
Device name stored for Y, M and S

```
F7  (OUT)   R   Y   1   ↓
```
Function key
Device name stored for Y, M and S

```
OUT   SPACE   C   1   ↓   1   0   S   ↓
```

OUT instruction
Device number
Device symbol T or C
Device name stored for data register used for indirect specification

```
OUT   SPACE   W   A   I   T   SPACE   1   0   S   ↓
```

OUT instruction
Device name stored for T and C
Device name stored for data register used for indirect specification
Entering single instruction

Instruction word entry method and ladder program displayed

[ANB] (AND block, serial connection of multiple parallel ladder circuits)

\[
\text{ANB instruction} \quad \begin{array}{c}
\text{A} \quad \text{N} \quad \text{B} \quad \downarrow \\
\text{Function key}
\end{array}
\]

Ladder program displayed:

\[
\begin{array}{c}
X000 \quad \text{ANB} \quad X001 \\
\text{M0} \quad \text{M1}
\end{array}
\]

[ORB] (OR block, parallel connection between blocks)

\[
\text{ORB instruction} \quad \begin{array}{c}
\text{O} \quad \text{R} \quad \text{B} \quad \downarrow \\
\text{Function key}
\end{array}
\]

Ladder program displayed:

\[
\begin{array}{c}
X000 \quad X001 \\
\text{M0} \quad \text{M1} \quad \text{ORB}
\end{array}
\]

[MPS] (Point Store, Stores the current result of the internal PLC operations)

[MRD] (Read, Reads the current result of the internal PLC operations)

[MPP] (Pop, Pops [recalls and removes] the currently stored result)

\[
\text{MPS, MRD or MPP instruction}
\]

Ladder program displayed:

\[
\begin{array}{c}
X000 \quad \text{MPS} \quad X002 \\
\text{MPP} \quad \text{MRD} \quad X003
\end{array}
\]
Entering special coil or application instruction:

For the special coil and application instruction entry methods in the list program edit window, refer to those used in the ladder program edit window.

Special coil:
- [SET] (Set, Sets a bit device permanently ON)
- [RST] (Reset, Resets a bit device permanently OFF)
- [PLS] (Pulse, Rising edge pulse)
- [PLF] (Pulse, Falling/trailing edge pulse)
- [MC] (Master control, Denotes the start of a master control block)
- [MCR] (Master control reset, Denotes the end of a master control block)

Application instruction: FNC00- FNC246

For the above instruction entry method, refer to Sec.7.2.1 "Main operations necessary for entering ladder circuit symbols". Note that in the ladder program edit window, the data entry dialog box will appear so that you can directly enter the instruction word at the cursor position, but in the instruction list program edit window, this dialog box will not appear.
Instruction entry using Instruction command

In the instruction list program edit window, you can directly enter instruction words or device numbers in the cursor-positioned line using the keyboard. However, if you want to use lists or dialog boxes for easy programming, use the Instruction command.

This box displays the currently selected instruction or can be used to enter the instruction directly.
Example: LD, AND, OUT, ZCP, DZCP, FNC11, FNCD11P

The boxes contain necessary operands for the specified instruction.

Specify the operand or device names.
7.3.2 Creating instruction list

Creating new list
Click File and then New to create a new instruction list.
To clear all the ladder circuits stored, click Tools and then All Clear.

Creating/editing instruction list
In the instruction list program edit window, position the cursor and then enter an instruction word directly at
the cursor position, or use the ladder circuit symbols allocated to function keys or the Instruction command on
the Tools menu to create an instruction list.
For the instruction word entry method, refer to Sec.7.3.1.
For the instructions regarding programming, refer to Sec.7.3.2.

Keys and commands used for editing

Symbol delete:
Delete: Deletes the symbol at the cursor position.
NOP operation:
Edit: All write, all insert, all delete
Scroll:
• Page Up, Page Down, ↑, ↓, scroll bar
• Search: Top, end, device name, device, instruction, contact/ coil, step number, tag set, tag jump
Device change:
Search: Replace, a-contact/ b-contact change, convert
Comment entry:
To enter comments, use the All Entry screen by clicking View and then Comment.
Or enter comments in the ladder program edit window.
MEMO
8. Creating SFC Programs

SFC programming is simply entering symbols for devices and instructions in the SFC (Sequential Function Chart) to determine the flow of control. For a detailed description of SFC control, refer to the instruction manual of the PLC.

8.1 Description of SFC

8.1.1 Types of SFC

The SFC has a single flow. The single flow type program can control sequences of simple motions. If various input conditions are set or the operator enters various commands, use the selective branch or simultaneous branch type.

- **Single flow:**

  ![Single flow diagram](image1)

- **Selective branch:**

  ![Selective branch diagram](image2)

- **Simultaneous branch:**

  ![Simultaneous branch diagram](image3)
### 8.1.2 Program types

When creating programs using the SFC, the SFC sections and ladder diagram sections (inner ladders) should be separately programmed. The SFC type section consists of ladder blocks and state blocks. To create programs used for control, enter symbols, such as SET SO (ladder block), Y000 (state), and TRN (transition). These programs will be controlled as inner ladders.

#### SFC section:
To use a SFC for programming, enter SFC symbols to determine the flow.

#### Ladder section:
Create inner ladders in the ladder diagram to specify the control of each process, conditions to transfer to the next state, etc.

```
[LAD0] M8002 [SET S0] External processing

[STL] 0 (Y000) Driving
[TRN] 0 X000 (TRN) Transition SET S20
[TRN] 0 X001 (TRN) Transition SET S21

[STL] 20 (Y002) Driving
[STL] 21 (Y003) Driving
[TRN] 20 X002 (TRN) Transition SET S22
[TRN] 21 X003 (TRN) Transition SET S22
[STL] 22 (Y003) Driving
[TRN] 22 X004 (TRN) Transition OUT S0

[LAD1] [RET] External processing

[END]
```

When you create a ladder block after the state block, the FXGP/WIN-E will automatically enter the RET instruction. For this reason, do not enter any RET in the program.
8.1.3 Structure of SFC section

The rows, columns, and cursor position in the SFC section are described below:

Row number:
Respective states including ladder blocks have their own row numbers.

Column number:
Respective states have their own column numbers. Up to 16 columns can be used for programming.
8.2 Creating SFC Programs

8.2.1 Main operations necessary for entering SFC symbols

Use the function keys to enter these symbols in the SFC program.

<table>
<thead>
<tr>
<th>Item</th>
<th>Symbol displayed on screen</th>
<th>Function key</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder block</td>
<td><img src="image" alt="Ladder m" /></td>
<td><img src="image" alt="F6" /></td>
<td>m=ladder block number, automatically attached</td>
</tr>
<tr>
<td>Initial state</td>
<td><img src="image" alt="Sn" /></td>
<td><img src="image" alt="F6" /></td>
<td><img src="image" alt="F4" /></td>
</tr>
<tr>
<td>General state</td>
<td><img src="image" alt="Sn" /></td>
<td><img src="image" alt="F6" /></td>
<td><img src="image" alt="F4" /></td>
</tr>
<tr>
<td>Jump (loop)</td>
<td><img src="image" alt="Jump Sn" /></td>
<td><img src="image" alt="F6" /></td>
<td>Sn=S0 to S899.</td>
</tr>
<tr>
<td>Jump (reset)</td>
<td><img src="image" alt="Reset Sn" /></td>
<td><img src="image" alt="F7" /></td>
<td>Sn=S0 to S899.</td>
</tr>
<tr>
<td>Transition (transition condition)</td>
<td><img src="image" alt="Transition condition" /></td>
<td><img src="image" alt="F6" /></td>
<td>The transition condition will be written.</td>
</tr>
<tr>
<td>Vertical line</td>
<td><img src="image" alt="Vertical line" /></td>
<td><img src="image" alt="F9" /></td>
<td>Connects a state to another state.</td>
</tr>
<tr>
<td>Horizontal line</td>
<td><img src="image" alt="Horizontal line" /></td>
<td><img src="image" alt="F9" /></td>
<td>Automatically recognized as the selective or simultaneous branch line, and the recognition result depends on the symbol-written position.</td>
</tr>
<tr>
<td>Combined symbol</td>
<td></td>
<td><img src="image" alt="F5" /></td>
<td>Sn=S10 to S899.</td>
</tr>
<tr>
<td>State + transition</td>
<td><img src="image" alt="State + transition" /></td>
<td><img src="image" alt="F5" /></td>
<td>Automatically recognized as the selective or simultaneous branch line, and the recognition result depends on the symbol-written position.</td>
</tr>
</tbody>
</table>
8.2.2 Cursor position and entering symbol

The figure below show the symbols that can be entered in relation to the cursor position on the SFC program edit window. The selective branches or simultaneous branches will be automatically recognized by the connection position.

1) State entry position (creation of inner ladder), entry of jump symbol or creation of ladder block
2) Connection position where state and next step are connected to each other
3) Junction of selective branches and simultaneous branches
4) Transition entry position (creation of transition condition, creation of inner ladder)
5) Junction of simultaneous branches or selective branches

![Diagram showing cursor positions](image-url)
8.2.3 Main items necessary for creating SFC

Use of programming window
Open the SFC program edit window to use the SFC for programming.
Click View and then SFC to open the SFC program edit window.

Conversion
- After creating a SFC program and inner ladder program in the SFC program edit window, be sure to convert them into an instruction list.
- Non-converted programs will be erased when the SFC program edit window is closed.
- Press the CNV (F4) key, or click Tools and then Convert to convert programs.
- Be sure to convert both the inner ladder program and SFC.

Editing inner ladder diagram
- To display, create, or edit a ladder block or inner ladder of a state or transition, position the cursor and then click View and then Inner Ladder View.
- To edit a ladder block or inner ladder of a state.
- When creating a ladder block after the state block, FXGP/WIN-E will automatically enter the RET instruction. For this reason, a RET instruction should never be entered.

Sequence instructions usable for state:

<table>
<thead>
<tr>
<th>State</th>
<th>Instruction</th>
<th>LD/LDI/LDP/LDF, AND/ANI/ANDP/ANDF, OR/ORI/ORP/ORF,INV, OUT,SET,RST,PLS/PLF</th>
<th>ANB/ORB MPS/MRD/MPP</th>
<th>MC/MCR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial state, general state</td>
<td>Output operation</td>
<td>Usable</td>
<td>Usable</td>
<td>Unusable</td>
</tr>
<tr>
<td>Branch, junction, state</td>
<td>Transition operation</td>
<td>Usable</td>
<td>Usable</td>
<td>Unusable</td>
</tr>
</tbody>
</table>

- The STL instruction cannot be used in interrupt programs or subroutine programs.
- Use of jump instructions in the STL instruction is not inhibited. It is, however, recommended that jump instructions should not be used in the STL instruction. This is because operation will be too complicated.
- When the MC (master control) or MCR (master control reset) instruction is entered, the ladder will be displayed in the same way as the FXGP/WIN-E V1.** (see Sec. 7.2.3).
- When two or more transition conditions exist, these conditions should be programmed in one transition ladder circuit.

Enter all the transition conditions in one transition circuit.
- If no inner ladder is created for a state or transition, the state or transition will be marked with "***". When an inner ladder is created, the mark will disappear.
- The SFC can be created without the inner ladders firstly to determine the flow. Afterwards the inner ladders can be added. If the SFC without inner ladder program is converted, the instruction list of flow only will be created. This SFC can be displayed again, and then inner ladders can be added to the SFC to complete it.
- Dummy state entry method
  Follow the procedure below to enter a dummy state in the SFC:
  1) Enter a state symbol (symbol for dummy state).
     No program will be processed in this state, therefore it is not necessary to create an inner ladder. On the screen, there is an asterisk "***" to show that there is no inner ladder.
  2) Create a transition to go to the next state from the dummy state.

3) The dummy state is marked with "***", but convert the program ignoring the asterisk.
Remarks
To jump to the same state in the SFC, do not write the same jump state twice or more.
If you write the same jump state in two or more different places, the ladder circuit you created may not function properly.

Correct the ladder diagram as follows:

In the following ladder circuit, the same problem will occur. Do not write the same jump state twice or more.
8.2.4 Creating SFC

Creating new SFC
Click File and then New. Select SFC program edit window from the list of programming windows. Using the View menu to open the SFC program edit window is another option.

Creating SFC
Create a SFC using the ladder circuit symbols allocated to the function keys. For the SFC symbol entry method, refer to Sec. 8.2.1.

Editing

Keys and commands used for editing

Symbol delete:
•  key (cursor position)
•  Edit → Delete (cursor position)

Block insert:
•  Insert an initial state to add an SFC block.

Scroll:
•  , , , or  keys, scroll bar (screen scroll)
•  Search (top, end, device name, state number)

Inner ladder:
•  View → Inner Ladder (To edit inner ladders, refer to Sec. 7.2 or Sec. 7.2.3.)
MEMO
9. Remote Maintenance Using a Telephone Line

The FXGP/WIN-E has the remote access function that enables program transfer and monitoring through a telephone line. For this remote access function, the PC should be connected to the FX1S, FX1N, FX2N and FX2NC PLC via modems.

In addition, the FXGP/WIN-E has the file transfer functions that enables file sending and receiving between PC through the telephone line. As with the remote maintenance function, the PC should be connected to each other via modems. This function allows the user to send and receive programs, comment files, FXGP/WIN-E data files, and other general files to and from another computer.

9.1 System Configuration and Functions

9.1.1 Remote access to PLC

System configuration

*1: Be sure to use the cable specified by the modem manufacturer to connect the PC to the modem, or connect the PLC to the modem. The transfer speed will be fixed to 9,600 bps.

*2: The remote maintenance function cannot use on the WindowsNT 4.0, Windows 2000 or Windows XP.
Functions
The PC can be connected to the modem of the PLC through a telephone line. FXGP/WIN-E can automatically connect to the desired PLC by selecting the corresponding station from those stored in the PC. In addition, FXGP/WIN-E can manually connect the PC to the PLC by manually setting the telephone number of the PLC.
When connected, various commands on the PLC and Monitor/ Test menus will be valid.

These commands are listed below

Commands on PLC menu
- Transfers
- Register Data Transfers
- PLC Memory Clear
- Serial Setting (D8120)
- PLC Keyword Current or Delete
- Runtime Program Changes
- Remote Run/Stop
- Diagnostics
- Sampling Trace

Commands on Monitor/Test menu
- Start monitor
- Stop Monitor
- Dynamic Monitor
- Entry Device Monitor
- Forced Y Output
- Forced On/Off
- Change Current Values
- Change Setting Values
9.1.2 Sending/receiving files

System configuration

*1: Be sure to use the cable specified by the modem manufacturer to connect the PC to the modem.
*2: The remote maintenance function cannot use on the WindowsNT 4.0, Windows 2000 or Windows XP.
*3: The transfer speed will be fixed to 19,200 bps. If the RS-232C port of the PC cannot keep up with such high speed, this file sending/receiving function cannot be used. (For the transfer speed of the RS-232C port, refer to the operation manual of the PC.)

Functions

One of the PCs should act as the receiver. The other PC should be used to send one or more files specified on the screen to the desired directory of the receiver PC.
If the directory of the receiver PC is not specified, the received files will be stored in sub-directory FILE of the FXGP/WIN-E.
If a new directory is specified, the new directory will be created, and then the received files will be stored in that directory.
Transfer files from the receiver PC to the sender PC to change the transfer direction between the personal PCs.
FXGP/WIN-E files and general files can be sent and received to use this file transfer function.
9.1.3 Caution

1) If using the remote access system of the PLC frequently, it is recommended that the programs be password-protected. The password will prevent unauthorized users from illegal access to sequence programs. (See Sec.6.6.5 and Sec.6.8.3.)

2) During communication via the telephone line, if a call is placed to the number being currently used for communication, a communication error may occur, or the line will be disconnected.

3) If the telephone line is connected to the PC via other business phones or private branch exchange, the modem may not function properly due to wrong connector or signal type. For more information, contact the person in charge of the private telephone line.

4) Depending on the telephone line conditions or the field intensity of the portable telephone, communication may not be possible, or the line may be disconnected during communication. The file transfer function described in Sec.9.1.2 may not be valid if the wrong modem is connected to the PC, or the wrong PC is used.
9.2 Operation Procedures

9.2.1 Remote access to PLC

Connect PC with the FXGP/WIN-E to the PLC using the telephone line in order to enable remote access to the PLC.

**Access procedure**

1. **Setting up PLC for receiving programs**
   - Change the set parameters of the PLC to set up the modem. (See Sec.9.4.)
   - Turn off the power of the PLC.*1
   - Connect the modem and the telephone line to the RS-232C communication adapter/board of the FX2N PLC, and then turn on the power of the modem.*1 (See Sec.8.1.1)
   - Turn on the power of the PLC. The modem initialize command will be automatically output. The PLC is now ready for program receiving operation.

2. **Setting up PC for line connection**
   - Connect the modem and the telephone line to the PC. After that, sequentially turn on the power of the modem, and then the PC. (See Sec.9.1.1)
   - Start FXGP/WIN-E.
   - Sequentially click Remote, Environment, and then Modem. Specify the modem used for communication. (See Sec.9.3.4.)

3. **Connecting line**
   - Sequentially click Remote, Connect, and then To PLC to connect the PC to the PLC.*2 (See Sec.9.3.1.)
   - When connected, this timer will appear on the right side of the application program title to indicate the communication time.

4. **Accessing the PLC**
   - After line connection, access the PLC using the commands shown in Sec.9.1.1. You can use the remote PLC in the same way as the near- by PLC.*3
*1: Be sure to turn on the power of the modem first, and then that of the PLC. This is because the PLC will send the modem initialize command to the modem when the power of the PLC is turned on. If you turn on the power of the PLC without turning on the power of the modem, the modem initialize command will not be sent to the modem, therefore communication error will occur when you access to the remote PLC. After turning on the power of both units, if you turn off the power of the modem only, the initialize command will be canceled, therefore communication error will occur. In this case, turn off the power of both units, and then turn on the power of the modem first, and then that of the PLC.

*2: Be sure to use the To PLC command to connect the PC to the PLC. If you use the To File Transfer command, communication with the PLC will not be possible.

*3: If you access to the PLC immediately after line connection, a communication error may occur. This is because the modem is still not ready for communication. Wait several seconds, and then access the PLC.
9.2.2 File transfer

Connect the FXGP/WIN-E installed PC to another FXGP/WIN-E installed PC using the telephone line in order to enable file sending and receiving between these PCs.

Transfer procedure

1. Start the FXGP/WIN-E.

2. Connect the modem and the telephone line to the PC, and then turn on the power of the modem first, and then that of the PC. (See Sec.9.1.2.)

3. Click Remote, Environment, and then Modem. Specify the modem used for communication. (See Sec.9.3.4.)

4. Connect the modem and the telephone line to the PC, and then turn on the power of the modem first, and then that of the PC. (See Sec.9.1.2.)

5. Start the FXGP/WIN-E.

6. Click Remote, Environment, and then Modem. Specify the modem used for communication. (See Sec.9.3.4.)

7. Click Remote, Connect, and then To File Transfer to connect the PC to the receiver PC in the ready mode.*1 (See Sec.9.3.1.)

8. Connect the modem and the telephone line to the PC, and then turn on the power of the modem first, and then that of the PC. (See Sec.9.1.2.)

9. When connected, this timer will appear on the right side of the application program title to indicate the communication time.

*1: Be sure to click To File Transfer to connect to the receiver PC. If you click To PLC, the line will not be connected to the PC.
Sequentially click Remote, File Transfer, and then Transmit. Select files you would like to transmit, and then click the OK button.

Selection of two or more files:
- + clicking mouse (for selection of contiguous files)
- + clicking mouse (for selection of separate files)

(See Sec.9.3.3.)

Specify a directory of the receiver PC to clarify the file sending destination, and then click the OK button.

- If you select NO, the files will be stored in the sub-directory FILE of the FXGP/WIN-E on the receiving side.
- If you select YES, enter the full directory name in the Destination Directory field. If you specify a non-existing directory, the confirmation message "Create a new directory?" will appear on the display. If you select YES, a sub-directory will be created in the PC on the receiving side. If you select NO, file transfer will be canceled, and the telephone line will be disconnected.

(See Sec.9.3.3.)
While sending files, the system displays the current status of file sending operation.

File Transfer
Name: test-1.png
Size: 7168/8416
Number: 2/4

File sending is complete.

Click the OK button to set the receiver PC in the ready mode again.

To send more files, sequentially click Remote, File Transfer, and then Transmit. To quit sending files, click Remote and then Disconnect.

While receiving files, the system displays the current status of file receiving operation.

File Transfer
Name: test-1.png
Size: 4096/8416
Number: 2/4

File receiving is complete.

Click the OK button to set the receiver PC in the ready mode again.

To receive more files, leave the receiver PC in the ready mode. To quit receiving files, click the Cancel button. The telephone line will be disconnected.

File Transfer
Name
Size
Number

Click the OK button to set the receiver PC in the ready mode again.
9.3 Functions on Remote Menu

9.3.1 Connect

Click To PLC and then To File Transfer. The following line connection screen will appear on the display.

This screen is common to both commands TO PLC and TO File Transfer, and the data edited on this screen will be controlled in the same way by both commands. The transfer speed between the PC and the modem depends on the specified command; To PLC or To File Transfer. For this reason, select the right command, and then click the Connect button.

If a wrong connection command is selected for line connection, a communication error will occur during remote access to the PLC or during file transfer between PCs.

Select a remote station.
Line connection procedure (connection to remote station stored in the list)
Follow the procedure below to connect the telephone line to a remote station stored in the list.

1) Select Remote and then Connect. After that, select To PLC or To File Transfer depending on your purpose.

2) Click a remote station in the list to specify the station.

3) Click Yes.

4) The confirmation message "Connect to remote station?" will appear on the display. Select Yes.

5) The modem calls the remote station to connect the PC to the remote station.

Line connection procedure (connection to non-stored remote station)
Follow the procedure below to connect the telephone line to the desired remote station by directly entering the phone number in the Manual Connection dialog box.
The data entered in the Manual Connection dialog box will not be stored in the list, but will be logged in the communication log file.

1) Select Remote and then Connect. After that, select To PLC or To File Transfer depending on your purpose.

2) Click Manual.

3) The Manual Connection dialog box will appear on the display. Enter data in this dialog box.

- Enter the name in this box. The name will be logged in the communication log file as the remote station.
- Enter the phone number in this box. The modem will call the phone number.
- Click this button to connect the telephone line to the specified remote station.

Set data in these boxes if necessary.

For a detailed description of data items in this dialog box, refer to "Storing new remote station" described later.

4) Click the OK button.

5) The confirmation message "Connect to remote station?" will appear on the display. Select Yes.

6) The modem will call the specified remote station to connect the PC to the remote station.
Storing new remote station
Follow the procedure below to connect the telephone line to the remote station non-stored in the list.
1) Select Remote and then Connect. After that, select To PLC or To File Transfer depending on your purpose.
2) Click New Entry.
3) The Edit Connection Data dialog box will appear on the display. Enter data in this dialog box.

![Edit Connection Data dialog box]

Enter the name of a remote station in this box. You can use up to 64 characters to set the name of a remote station, however the number of characters displayed in this box is limited.

Enter the phone number of the remote station in this box.

Click this button to store the set data and exit from this screen.

Enter a numeric value in the Outside Line box to specify the extension number. The numeric values allowed in this box are 0 to 9. Only enter data here if an extension number such as "0+phone number" is needed. Enter null data if an extension number is not necessary.

4) Click the OK button.
5) Check the data set in the dialog box.
6) Click the OK button.
7) The confirmation message "Connect to remote station?" will appear on the display. Select Yes to connect the line to the specified remote station. Select No not to connect the line.
8) The new remote station is now stored in the list.

To store new data or modified data, be sure to follow steps 6) and 7) after entering data in the dialog box. To erase the data set in the dialog box after following steps 1) through 5), click the Cancel button or close the dialog box. The data entered will be erased, and the data currently stored will not be modified.
Changing remote station data
Follow the procedure below to change the remote station data stored in the list:
1) Select Remote and then Connect. Then, select To PLC or To File Transfer depending on your purpose.
2) Click the remote station to be changed.
3) Click the Change button.
4) Follow step 3 and subsequent steps described in "Storing new remote station" to change the remote station data.

Copying or deleting destination data
- Follow the procedure below to create another remote station using a remote station data stored in the list.
1) Select Remote and then Connect. Then, select To PLC or To File Transfer depending on your purpose.
2) Click the remote station to be copied or deleted.
3) Click the Copy button. (The data will not be deleted from the currently-displayed position.)
   Click the Cut button. (The data will be deleted from the currently-displayed position.)
4) Click the Paste button.
5) The copied or cut data will be pasted at the end line of the list.
6) Follow the procedure described in "Changing remote station data" to change the pasted data.

- Follow the procedure below to delete a remote station data from the list.
1) Click a remote station to be deleted.
2) Click the Delete button.
3) Click the OK button. The confirmation message "Connect to remote station?" will appear on the display. Select No.

If the Cancel button is clicked instead of the OK button, or if the dialog box is closed without clicking the OK button, the specified remote station will not be deleted.

Changing remote station order
Follow the procedure below to change the remote station order in the list:
1) Click a remote station in the list to change its position in the list.
2) Click the Up, Down, Top, or Bottom button to move the remote station data to the desired position.
3) Click the OK button. The confirmation message "Connect to remote station?" will appear on the display. Select No.

If you click the Cancel button in place of the OK button, or if you close the dialog box without clicking the OK button, the specified remote station will not be deleted.
9.3.2 Disconnect

Use this function to disconnect the telephone line on the transmitting side. If a communication or operation error occurs, or if FXGP/WIN-E is closed, the telephone line will be automatically disconnected. To manually disconnect the telephone line, click Disconnect.

To disconnect the telephone line on the receiving side in the file transfer mode, click Cancel in the To File Transfer dialog box.

How to disconnect the line after abnormal end of Windows or FXGP/WIN-E:
If abnormal end of the Windows or FXGP/WIN-E occurs, turn off the power of the modem to disconnect the telephone line. When the software ends abnormally, the PC cannot control the telephone line, therefore the line will not be disconnected automatically.
9.3.3 File transfer

Transmit
When the telephone line is connected, sequentially click Remote, File Transfer, and then Transmit.

1) Select files you would like to send.

Selection of two or more files:

- **Shift** + clicking mouse (for selection of continuous files)
- **Ctrl** + clicking mouse (for selection of separate files)

Files that can be sent: Data files created by FXGP/WIN-E and other general files

2) Specify a directory on the receiver PC to send files to the specified directory.

- If you select NO, the files will be stored in the sub-directory FILE of the FXGP/WIN-E on the receiving side.
- If you select YES, enter the full directory name in the Destination Directory field. If you specify a non-existing directory, the confirmation message "Create a new directory?" will appear on the display. If you select YES, a sub-directory will be created in the PC on the receiving side. If you select NO, file transfer will be canceled, and the telephone line will be disconnected.

For a detailed description of file transfer procedure, refer to Sec.9.2.2.
Receive
Sequentially click Remote, File Transfer, and then Receive.

![Image of the interface showing the option to initialise the modem to receive data.]

- Click this button not to set the receiving side in the ready mode.

![Image of the interface showing the file transfer options]

- Click this button to cancel file transfer. The telephone line will be disconnected.

The files will be stored in the specified directory, when files are sent from the PC on the sending side to the PC in the ready mode on the receiving side.
For a detailed description of file transfer procedure, refer to Sec. 9.2.2.
9.3.4 Environment → Modem

Specify and store a modem to be connected to the PC. To specify a modem, sequentially click Remote, Environment, and then Modem.

Selecting modem

Follow the procedure below to select the modem used for telephone line connection:

1 ) Click the modem name in the list. The modem name will be highlighted.

2 ) Click the OK button.
Storing new modem

Follow the procedure below to store a new modem in the list.

1) Click the New Entry button.
2) Enter data in the modem storage screen.

   Use numeric values 0 to 9 to set the number of re-dialing times.
   Use numeric values 0 to 999 to set the re-dialing intervals.
3) Click the OK button.
4) Click the OK button in the Modem dialog box.

If the Cancel button is clicked instead of the OK button, or if the dialog box is closed without clicking the OK button, the set data will be erased.
Initialize command setting:
Use the AT command developed by Heiz in the U.S. to initialize the modem.
For a detailed description of the AT command, refer to the operation manual of your modem.
The AT commands stored in this software set the modems as shown in the table below.
The set items and data depends on the modem type. For the set items and data, therefore, refer to the operation manual of the modem, if not using one of the modems below.

<table>
<thead>
<tr>
<th>Set item</th>
<th>PV-AF288(AIW A)</th>
<th>PV-AF3360(AIW A)</th>
<th>ME3314(OMRON)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting of command echo</td>
<td>E0 (not set)</td>
<td>E0 (not set)</td>
<td>E0 (not set)</td>
</tr>
<tr>
<td>Call frequency of auto-answering</td>
<td>S0=2 (twice)</td>
<td>S0=2 (twice)</td>
<td>S0=2 (twice)</td>
</tr>
<tr>
<td>Displaying result code</td>
<td>Q0 (displayed)</td>
<td>Q0 (displayed)</td>
<td>Q0 (displayed)</td>
</tr>
<tr>
<td>Type of result code</td>
<td>V1(characters, words)</td>
<td>V1(characters, words)</td>
<td>V1(characters, words)</td>
</tr>
<tr>
<td>Communication mode</td>
<td>&amp;M4(MNP auto)</td>
<td>&amp;M4(MNP auto)</td>
<td>S15=8(V,42bis)</td>
</tr>
<tr>
<td>Speed of terminal fixed dimension</td>
<td>\J0(fixed)</td>
<td>\J0(fixed)</td>
<td>\J0(fixed)</td>
</tr>
<tr>
<td>Flow control of transmission data</td>
<td></td>
<td></td>
<td>&amp;H0(not set)</td>
</tr>
<tr>
<td>Terminal flow control scheme</td>
<td>\Q0(not set)</td>
<td>\Q0(not set)</td>
<td>\Q0(not set)</td>
</tr>
<tr>
<td>Initialize to factory-set value</td>
<td>&amp;F(The FXGP/WIN-E will output the above AT command after outputting AT&amp;F.)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Changing set modem data
Follow the procedure below to change the modem data stored in the list:
1 ) Click the modem name to change the modem data.
2 ) Click the Change button.
3 ) Follow step 2) and the subsequent steps described in "Storing new modem" to change the modem data.

Copying or deleting set data
- Follow the procedure below to create another modem data using a modem data stored in the list:
  1 ) Click on a modem to copy or delete.
  2 ) Click the Copy button. (The data will not be deleted from the currently-displayed position.)
  3 ) Click the Cut button. (The data will be deleted from the currently-displayed position.)
  4 ) Click the Paste button.
  5 ) The copied or cut data will be pasted at the end line of the list.
- Follow the procedure described in "Changing set modem data" to change the pasted data.
  - To delete a modem data from the list, select a modem from the list, and then click the Delete button. After that, click the OK button.

If the Cancel button is clicked instead of the OK button, if the dialog box is closed without clicking the OK button, the specified modem data will not be deleted.

Changing modem order
Follow the procedure below to change the modem order in the list:
1 ) Click a modem in the list to change the position in the list.
2 ) Click the Up, Down, Top, or Bottom button to move the specified modem data to the desired position in the list.
3 ) Click the OK button.

If you click the Cancel button in place of the OK button, or if you close the dialog box without clicking the OK button, the modem order will not be changed.
9.3.5 **Environment → Logging File**

Use the Logging File command to specify whether the communication log file should be created. Sequentially click Remote, Environment, and then Logging File.

FXGP/WIN-E will automatically create the log file. To temporarily stop outputting of the log file, select No in the log file output dialog box. This No command will be valid until you quit the FXGP/WIN-E or cancel the No command. When the FXGP/WIN-E is activated next time, the log file will be output again.

After temporarily stopping the output, select Yes to output the log file again.

The log file will be stored in the sub-directory LOG of the FXGP/WIN-E installed directory (initial value = \FXGPWIN). The format of log file is shown below:

<table>
<thead>
<tr>
<th>File name:</th>
<th>97 07 10 LOG</th>
</tr>
</thead>
<tbody>
<tr>
<td>year, month, day</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Logged data:</th>
<th>Connect 97/07/18 15:10:21</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>ABCDEFG</td>
</tr>
<tr>
<td>Phone</td>
<td>123-123-1234</td>
</tr>
<tr>
<td>Disconnect 97/07/18 15:29:15</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>00:18:54</td>
</tr>
</tbody>
</table>

If the line is connected two or more times in one day, the communication data will be sequentially added in the same log file. Communication data will be logged in text files. A standard text editor can be used to read these files.
9.4 Data Setting on PLC Side for Remote Access

To access the remote FX1S, FX1N, FX2N and FX2NC PLC, set the parameters for the modem, and set communication data for the special diagnostic register.

Use the following programming software to enable modem settings for the PLC. The remote maintenance function cannot use on the WindowsNT 4.0, Windows 2000 or Windows XP.

- FX-PCS/WIN-E, version 1.00 or later (for Windows)
- GX Developer (SW□D5C-GPPW), version SW2 or later (for Windows)

Main setting

1) Read out the program from the FX1S, FX1N, FX2N and FX2NC PLC to the peripheral unit.
2) Activate the programming software, and click PLC's Mode Setting to select the modem used for communication.

Example: Modem setting using FXGP/WIN (See Sec.6.8.4.)

3) Set the D8120 (communication format) value to zero. The D8120 is one of the special diagnostic registers of the PLC.
   - If the current value of the D8120 is "0": It is not necessary to rewrite the D8120 value. Go to the next step.
   - If the D8120 value is written in the program: Change the program of the D8120 as follows so that the current value of the D8120 is set to "0".

   ```plaintext
   M8002
   Initial pulse
   MOV FNC 12 K0 D8120 K0 → D8120
   ```

4) Write all the programs and parameters for the FX1S, FX1N, FX2N and FX2NC series PLC.
5) If the programs are changed by following step 3), click RUN and then STOP to stop the PLC, and then reset the current values of the D8120 to zero.
Setting user setting mode
Select the User Setting Mode from the Modem Initialize pull-down menu (see step 2) of "Main setting"), and store the appropriate initialize commands for the modem as described below:

Initialize command format:
Use the AT command developed by Heiz in the U.S.
The general format of this command is shown below:

```
A T command+parameter command+parameter command+parameter ........... CR LF
```

For a detailed description of the AT command, refer to the operation manual of the modem.

Storing AT command in PLC:
If User Setting Mode in the PLC’s Mode Setting dialog box is selected as described before, the FX1S, FX1N, FX2N and FX2NC series PLC will send the AT&F command (command for resetting to factory-set values) and the data in D1000 through D1059 (modem initialize commands) to the modem via the RS-232C communication adapter/board at power-on of the PLC.
To use the user-set modem initialize commands, previously write the modem initialize commands in data registers D1000 through D1059 using the current value modify function of the peripheral unit or using the program.
Examples of modem initialize commands: ATE0S0 = 2Q1& D0& M4\Q0\JO& W

<table>
<thead>
<tr>
<th>Register number</th>
<th>ASCII code</th>
<th>Hexadecimal number</th>
<th>Register number</th>
<th>ASCII code</th>
<th>Hexadecimal number</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1000</td>
<td>A</td>
<td>41</td>
<td>D1013</td>
<td>&amp;</td>
<td>26</td>
</tr>
<tr>
<td>D1001</td>
<td>T</td>
<td>54</td>
<td>D1014</td>
<td>M</td>
<td>4D</td>
</tr>
<tr>
<td>D1002</td>
<td>E</td>
<td>45</td>
<td>D1015</td>
<td>\</td>
<td>5C</td>
</tr>
<tr>
<td>D1003</td>
<td>0</td>
<td>30</td>
<td>D1016</td>
<td>Q</td>
<td>51</td>
</tr>
<tr>
<td>D1004</td>
<td>S</td>
<td>53</td>
<td>D1017</td>
<td>\</td>
<td>30</td>
</tr>
<tr>
<td>D1005</td>
<td>=</td>
<td>3D</td>
<td>D1019</td>
<td>J</td>
<td>5C</td>
</tr>
<tr>
<td>D1006</td>
<td>0</td>
<td>30</td>
<td>D1020</td>
<td>M</td>
<td>4A</td>
</tr>
<tr>
<td>D1007</td>
<td>2</td>
<td>32</td>
<td>D1021</td>
<td>\</td>
<td>30</td>
</tr>
<tr>
<td>D1008</td>
<td>Q</td>
<td>51</td>
<td>D1022</td>
<td>&amp;</td>
<td>26</td>
</tr>
<tr>
<td>D1009</td>
<td>1</td>
<td>31</td>
<td>D1023</td>
<td>W</td>
<td>57</td>
</tr>
<tr>
<td>D1010</td>
<td>&amp;</td>
<td>26</td>
<td>D1024</td>
<td>CR</td>
<td>0D</td>
</tr>
<tr>
<td>D1011</td>
<td>D</td>
<td>44</td>
<td>D1025</td>
<td>LF</td>
<td>0A</td>
</tr>
</tbody>
</table>

Up to 60 points of user-set initialize commands can be read out sequentially from the D1000 to D1059. If "00" is read out, reading out of initialize commands will be stopped.
When creating programs, check that the data register area used for the other programs is not the area for these modem initialize commands.
**Description of modem setting data previously stored:**

The modem setting conditions of the AT command previously stored in the PLC are shown below. The modem setting conditions shown below are for reference. Actual conditions depend on the modem. Please refer to the operation manual of the modem being used.

<table>
<thead>
<tr>
<th>Setting item</th>
<th>PV-AF288 (AIWA)</th>
<th>ME3314 (OMRON)*1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting of command echo</td>
<td>E0 (not set)</td>
<td>E0 (not set)</td>
</tr>
<tr>
<td>Call frequency of auto-answering</td>
<td>S0 = 2 (twice)</td>
<td>S0 = 2 (twice)</td>
</tr>
<tr>
<td>Displaying result code</td>
<td>Q1 (not displayed)</td>
<td>Q1 (not displayed)</td>
</tr>
<tr>
<td>DTR control</td>
<td>&amp;D0 (always ON)</td>
<td>&amp;D0 (always ON)</td>
</tr>
<tr>
<td>Communication mode</td>
<td>&amp;M5 (V, 42 bis)</td>
<td>S15 = 8 (V, 42 bis)</td>
</tr>
<tr>
<td>Terminal flow control method</td>
<td>Q0 (not set)</td>
<td>&amp;R1 (not set)</td>
</tr>
<tr>
<td>Flow control of transmission data</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Speed of terminal fixed dimension</td>
<td>J0 (fixed)</td>
<td>—</td>
</tr>
<tr>
<td>Writing in nonvolatile memory</td>
<td>&amp;W</td>
<td>&amp;W</td>
</tr>
</tbody>
</table>

*1 : The AT command setting function for the ME3314 (OMRON) is added to the FX2N and FX2NC series PLC version 2.01 or later (manufacturing number 78**** or later).

**Programming data**

For a detailed description of the PLC and programs, refer to the following documents:
MEMO
Appendix A:
PLC Device Tables

For further information about device of the FX0, FX0S, FX0N, FX and FX2C Series PLC can be found in FX Programming Manual (Manual number: JY992D48301), about device of the FX1S, FX1N, FX2N and FX2NC Series PLC can be found in FX Programming Manual II (Manual number: JY992D88101).
## A-1: FX0/FX0S Series PLC

Latched devices range is fixed by PLC’s parameter. So that, these cannot be changed in the Parameter setting menu on FXGP/WIN-E.

### Table A-1: Device Table for FX0 and FX0S Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O configuration</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>496 points</td>
<td>M0 to M495</td>
</tr>
<tr>
<td>Latched</td>
<td>16 points</td>
<td>M496 to M511</td>
</tr>
<tr>
<td>(EEPROM Backed-up)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Special</td>
<td>56 points</td>
<td>From the range M6000 to M8255</td>
</tr>
<tr>
<td><strong>State relays (S coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>64 points</td>
<td>S0 to S63</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td><strong>Timers (T)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec</td>
<td>T0 to T55</td>
</tr>
<tr>
<td></td>
<td>56 points</td>
<td></td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec</td>
<td>T32 to T55 when special M coil M8028 is driven ON</td>
</tr>
<tr>
<td></td>
<td>24 points</td>
<td></td>
</tr>
<tr>
<td><strong>Counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Range: 1 to 32,767 counts</td>
<td>C0 to C15</td>
</tr>
<tr>
<td></td>
<td>14 points</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: 1 to 32,767 counts</td>
<td>C14 to C15</td>
</tr>
<tr>
<td></td>
<td>2 points (EEPROM Backed-up)</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C235 to C238, 4 points</td>
</tr>
<tr>
<td>FX0: Select upto four 1 phase counters with a combined counting frequency of 5kHz or less.</td>
<td>Note; C235 is latched (EEPROM backed-up)</td>
<td></td>
</tr>
<tr>
<td>2 phase</td>
<td>Range: -1 to -14,999 counts</td>
<td>C241 to C244, 3 points</td>
</tr>
<tr>
<td>FX0: When multiple 1-phase counters are used the sum of the frequencies must be equal or less than 14kHz. Only 1, 2 phase high speed counter may be used at any one time. When 2 phase counters are in use the maximum counted speeds must be equal or less than 14kHz, calculated as (2 ph counter speed 5 number of counted edges) + 1 ph counter speeds.</td>
<td>Note; These are latched (EEPROM backed-up)</td>
<td></td>
</tr>
<tr>
<td>A/B phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C251, C252 and C254, 3 points</td>
</tr>
<tr>
<td>FX0: Select upto four 1 phase counters with a combined counting frequency of 5kHz or less.</td>
<td>Note; These are latched (EEPROM backed-up)</td>
<td></td>
</tr>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>30 points</td>
<td>D0 to D29</td>
</tr>
<tr>
<td>Latched</td>
<td>2 points (EEPROM Backed-up)</td>
<td>D30 to D31</td>
</tr>
<tr>
<td>Externally adjusted</td>
<td>Range: 0 to 255</td>
<td>D8013</td>
</tr>
<tr>
<td></td>
<td>1 point</td>
<td>Data is entered indirectly through the external setting potentiometer</td>
</tr>
<tr>
<td>Special</td>
<td>27 points (inclusive of D8013)</td>
<td>From the range D8000 to D8255</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Index</td>
<td>2 points</td>
<td>V and Z</td>
</tr>
<tr>
<td><strong>Pointers (P)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>64 points</td>
<td>P0 to P63</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>4 points</td>
<td>I00 to I30 (rising trigger q = 1, falling trigger q = 0)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td><strong>Constants</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: -2,147,483,648 to +2,147,483,647</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 0000 to FFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
</tbody>
</table>
A-2: FXon Series PLC

Latched devices range is fixed by PLC's parameter. So that, these cannot be changed in the Parameter setting menu on FXGP/WIN-E.

**Table A-2: Device Table for FXon Series PLC**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O configuration</strong></td>
<td>Max hardware I/O configuration points 128, dependent on user selection (Max. software addressable Inputs 128, Outputs 128)</td>
<td></td>
</tr>
<tr>
<td><strong>Auxiliary relay (M coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>384 points</td>
<td>M0 to M383</td>
</tr>
<tr>
<td>Latched</td>
<td>128 points (EEPROM Backed-up)</td>
<td>M384 to M511</td>
</tr>
<tr>
<td>Special</td>
<td>65 points</td>
<td>From the range M8000 to M8255</td>
</tr>
<tr>
<td><strong>State relays (S coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initial (Latched)</td>
<td>128 points (EEPROM Backed-up)</td>
<td>S0 to S127</td>
</tr>
<tr>
<td><strong>Timers (T)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec</td>
<td>T0 to T62</td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec</td>
<td>T32 to T62 when special M coil M8028 is driven ON</td>
</tr>
<tr>
<td>1 msec</td>
<td>Range: 0 to 32.767 sec</td>
<td>T63</td>
</tr>
<tr>
<td><strong>Counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Range: 1 to 32,767 counts</td>
<td>C0 to C15</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: 1 to 32,767 counts (EEPROM Backed-up)</td>
<td>C16 to C31</td>
</tr>
<tr>
<td><strong>High speed counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. 4points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C235 to C238</td>
</tr>
<tr>
<td>1 phase c/w start stop input</td>
<td>Select upto four 1 phase counters with a combined counting frequency of 5kHz or less. Alternatively select one 2 phase or A/B phase counter with a counting frequency of 2kHz or less. Note all counters are latched (EEPROM Backed-up)</td>
<td>C241, C242 and C244</td>
</tr>
<tr>
<td>2 phase</td>
<td>C246, C247 and C249</td>
<td></td>
</tr>
<tr>
<td>A/B phase</td>
<td>C251, C252 and C254</td>
<td></td>
</tr>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>128 points</td>
<td>Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Latched</td>
<td>128 points (EEPROM Backed-up)</td>
<td>Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>File</td>
<td>1500 points</td>
<td>D1000 to D2499 set by parameter in 3 blocks of 500 program steps</td>
</tr>
<tr>
<td>Externally adjusted</td>
<td>Range: 0 to 255</td>
<td>Data is move from external setting potentiometers to registers D8030 and D8031 (D8013 is used when no RTC is fitted)</td>
</tr>
<tr>
<td>Special</td>
<td>42 points (inclusive of D8013, D8030 and D8031)</td>
<td>From the range D8000 to D8255</td>
</tr>
<tr>
<td><strong>Pointers (P)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>64 points</td>
<td>Type: 16 bit data storage register</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>4 points</td>
<td>P0 to P63</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td><strong>Constants</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
<tr>
<td>32 bit: -2,147,483,648 to +2,147,483,647</td>
<td>32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
</tbody>
</table>
## A-3: FX Series PLC (Version 2.30 or earlier)

Latched devices range can change in the Parameter setting menu on FXGP/WIN-E. For explanation about operation, refer to section 6.8.2.

### Table A-3: Device Table for FX Series PLC (Version 2.30 or earlier)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O configuration</strong></td>
<td>Max hardware I/O configuration points 256, dependent on user selection (Max. software addressable I/O configuration points 128, Outputs 128)</td>
<td></td>
</tr>
<tr>
<td><strong>Auxiliary relay (M coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1024 points, Default: 500 points (subset)</td>
<td>M0 to M1023, Default: M0 to M499</td>
</tr>
<tr>
<td>Latched</td>
<td>1024 points (Battery backed-up), Default: 524 points (subset)</td>
<td>M0 to M1023, Default: M500 to M1023</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range M8000 to M8255</td>
</tr>
<tr>
<td><strong>State relays (S coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1000 points, Default: 500 points (subset)</td>
<td>S0 to S999, Default: S0 to S499</td>
</tr>
<tr>
<td>Latched</td>
<td>1000 points (Battery backed-up), Default: 500 points (subset)</td>
<td>S0 to S999, Default: S500 to S999</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td>Annunciator</td>
<td>100 points</td>
<td>S900 to S999</td>
</tr>
<tr>
<td><strong>Timers (T)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec 200 points</td>
<td>T0 to T199</td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec 46 points</td>
<td>T200 to T245</td>
</tr>
<tr>
<td>1 msec retentive</td>
<td>Range: 0 to 32.767 sec 4 points (Battery backed-up)</td>
<td>T246 to T249</td>
</tr>
<tr>
<td>100 msec retentive</td>
<td>Range: 0 to 3.276.7 sec 6 points (Battery backed-up)</td>
<td>T250 to T255</td>
</tr>
<tr>
<td><strong>Counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Range: 1 to 32,767 counts 200 points, Default: 100 points (subset)</td>
<td>C0 to C199, Default: C0 to C99 Type: 16 bit up counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: 1 to 32,767 counts 200 points (Battery backed-up), Default: 100 points (subset)</td>
<td>C0 to C199, Default: C100 to C199 Type: 16 bit up counter</td>
</tr>
<tr>
<td>General</td>
<td>Range: -2,147,483,648 to 2,147,483,647 35 points, Default: 20 points (subset)</td>
<td>C200 to C234, Default: C200 to C219 Type: 32 bit up/down counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: -2,147,483,648 to 2,147,483,647 35 points (Battery backed-up), Default: 15 points (subset)</td>
<td>C200 to C234, Default: C220 to C234 Type: 16 bit up/down counter</td>
</tr>
<tr>
<td><strong>High speed counters (C)</strong> Max. 6 points</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C235 to C240, 6 points</td>
</tr>
<tr>
<td>1 phase</td>
<td>General rule: Select counter combinations with a combined counting frequency of 20kHz or less. Note all counters are latched (Battery backed-up)</td>
<td>C241 to C245, 5 points</td>
</tr>
<tr>
<td>2 phase</td>
<td>A/B phase</td>
<td>C246 to C250, 5 points</td>
</tr>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>512 points, Default: 200 points (subset)</td>
<td>D0 to D511, Default: D0 to D199 Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Latched</td>
<td>512 points (Battery backed-up), Default: 312 points (subset)</td>
<td>D0 to D511, Default: D200 to D511 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>File</td>
<td>Maximum 2000 points</td>
<td>D1000 to D2999 set by parameter in 4 blocks of 500 program steps Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range D8000 to D8255 Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Index</td>
<td>2 points</td>
<td>V and Z Type: 16 bit data storage register</td>
</tr>
</tbody>
</table>
### Table A-3: Device Table for FX Series PLC (Version 2.30 or earlier)

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointers (P)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>64 points</td>
<td>P0 to P63</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>6 input points and 3 timers</td>
<td>I00 to I50, I60 to I80 (rising trigger = 1, falling trigger = 0, (\star\star) = time in msec)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td>Constants</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: -2,147,483,648 to +2,147,483,647</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 0000 to FFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
</tbody>
</table>
A-4: FX (Version 3.07 or later)/FX2C (All version) Series PLC

Latched devices range can change in the Parameter setting menu on FXGP/WIN-E. For explanation about operation, refer to section 6.8.2. However, fixed latched device cannot be changed by it.

### Table A-4: Device Table for FX (Version 3.07 or later) and FX2C Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O configuration</td>
<td>Max hardware I/O configuration points 255, dependent on user selection</td>
<td>(Max. software addressable Inputs 255, Outputs 255)</td>
</tr>
<tr>
<td>Auxiliary relay (M coils)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1024 points, Default: 500 points (subset)</td>
<td>M0 to M1023, Default: M0 to M499</td>
</tr>
<tr>
<td>Latched</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subset</td>
<td>1024 points (Battery backed-up), Default: 524 points (subset)</td>
<td>M0 to M1023, Default: M500 to M1023</td>
</tr>
<tr>
<td>Fixed</td>
<td>512 points (Battery backed-up)</td>
<td>M1024 to M1535</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range M8000 to M8255</td>
</tr>
<tr>
<td>State relays (S coils)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1000 points, Default: 500 points (subset)</td>
<td>S0 to S999, Default: S0 to S499</td>
</tr>
<tr>
<td>Latched</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Subset</td>
<td>1000 points (Battery backed-up), Default: 500 points (subset)</td>
<td>S0 to S999, Default: S500 to S999</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td>Annunciator</td>
<td>100 points</td>
<td>S900 to S999</td>
</tr>
<tr>
<td>Timers (T)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec 200 points</td>
<td>T0 to T199</td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec 46 points</td>
<td>T200 to T245</td>
</tr>
<tr>
<td>1 msec retentive</td>
<td>Range: 0 to 32.767 sec 4 points (Battery backed-up)</td>
<td>T246 to T249</td>
</tr>
<tr>
<td>100 msec retentive</td>
<td>Range: 0 to 3,276.7 sec 6 points (Battery backed-up)</td>
<td>T250 to T255</td>
</tr>
<tr>
<td>Counters (C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General 16 bit</td>
<td>Range: 1 to 32,767 counts 200 points (subset)</td>
<td>C0 to C199, Default: C0 to C99</td>
</tr>
<tr>
<td></td>
<td>Type: 16 bit up counter</td>
<td></td>
</tr>
<tr>
<td>Latched 16 bit</td>
<td>Range: 1 to 32,767 counts 200 points (Battery backed-up), Default: 100 points (subset)</td>
<td>C0 to C199, Default: C100 to C199</td>
</tr>
<tr>
<td></td>
<td>Type: 16 bit up counter</td>
<td></td>
</tr>
<tr>
<td>General 32 bit</td>
<td>Range: -2,147,483,648 to 2,147,483,647 35 points (subset)</td>
<td>C200 to C234, Default: C200 to C219</td>
</tr>
<tr>
<td></td>
<td>Type: 32 bit up/down counter</td>
<td></td>
</tr>
<tr>
<td>Latched 32 bit</td>
<td>Range: -2,147,483,648 to 2,147,483,647 35 points (Battery backed-up), Default: 15 points (subset)</td>
<td>C200 to C234, Default: C220 to C234</td>
</tr>
<tr>
<td></td>
<td>Type: 16 bit up/down counter</td>
<td></td>
</tr>
<tr>
<td>High speed counters (C) Max. 6 points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts General rule: Select counter combinations with a combined counting frequency of 20kHz or less.</td>
<td>C235 to C240, 6 points</td>
</tr>
<tr>
<td>1 phase c/w start stop input</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts Note all counters are latched (Battery backed-up)</td>
<td>C241 to C245, 5 points</td>
</tr>
<tr>
<td>A/B phase</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data registers (D)</td>
<td>Specification</td>
<td>Remarks</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>---------</td>
</tr>
<tr>
<td>General</td>
<td>512 points, Default: 200 points (subset)</td>
<td>D0 to D511, Default: D0 to D199 Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Latched</td>
<td>512 points (Battery backed-up), Default: 312 points (subset)</td>
<td>D0 to D511, Default: D200 to D511 Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Fixed</td>
<td>488 points (Battery backed-up)</td>
<td>D512 to D999 Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>File registers</td>
<td>Maximum 2000 points</td>
<td>D1000 to D2999 set by parameter in 4 blocks of 500 program steps Type: 16 bit data storage register</td>
</tr>
<tr>
<td>RAM file registers</td>
<td>2000 points</td>
<td>D6000 to D7999 active when special relay M8074 is active Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range D8000 to D8255 Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Index</td>
<td>2 points</td>
<td>V and Z Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Points (P)</td>
<td>For use with CALL 128 points</td>
<td>P0 to P127</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>6 input points, 3 timers and 6 counters</td>
<td>I00 to I50 and I6 to I8 (rising trigger Q=1, falling trigger Q=0, \star\star=time in msec)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td>Numbers</td>
<td>Decimal K 16 bit: -32,768 to +32,767 32 bit: -2,147,483,648 to +2,147,483,647</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hexadecimal H 16 bit: 0000 to FFFF 32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Floating Point 32 bit: 0, ±1.175 x 10^-38, ±3.403 x 10^38 (Not directly enterable)</td>
<td></td>
</tr>
</tbody>
</table>
## A-5: FX1s Series PLC

Latched devices range is fixed by PLC’s parameter. So that, these cannot be changed in the Parameter setting menu on FXGP/WIN-E.

### Table A-5: Device Table for FX1s Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O configuration</strong></td>
<td>Max total I/O set by Main Processing Unit</td>
<td></td>
</tr>
<tr>
<td><strong>Auxiliary relay (M coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>384 points</td>
<td>M0 to M383</td>
</tr>
<tr>
<td>Latched</td>
<td>128 points (EEPROM backed-up)</td>
<td>M384 to M511</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range M8000 to M8255</td>
</tr>
<tr>
<td><strong>State relays (S coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>128 points</td>
<td>S0 to S127</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td><strong>Timers (T)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec 63 points</td>
<td>T0 to T62</td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec 31 points</td>
<td>T32 to T62 when special M coil M8028 is driven ON</td>
</tr>
<tr>
<td>1 msec</td>
<td>Range: 0.001 to 32.767 sec 1 point</td>
<td>T63</td>
</tr>
<tr>
<td><strong>Counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Range: 1 to 32,767 counts 16 points</td>
<td>C0 to C15 Type: 16 bit up counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: 1 to 32,767 counts 16 points (EEPROM backed-up)</td>
<td>C16 to C31 Type: 16 bit up counter</td>
</tr>
<tr>
<td><strong>High speed counters (C) Max. 6 points</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C235 to C240, 6 points</td>
</tr>
<tr>
<td>1 phase c/w start stop input</td>
<td>General rule: Select counter combinations with a combined counting frequency of 60kHz or less.</td>
<td>C241 to C245, 5 points</td>
</tr>
<tr>
<td>2 phase</td>
<td>Note all counters are latched (EEPROM backed-up) If high speed counter is used with the HCS or HSCR instruction, a combined counting frequency of 30kHz or less.</td>
<td>C246 to C250, 5 points</td>
</tr>
<tr>
<td>A/B phase</td>
<td></td>
<td>C251 to C255, 5 points</td>
</tr>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>128 points</td>
<td>Type: D0 to D127 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Latched</td>
<td>128 points (EEPROM backed-up)</td>
<td>Type: D128 to D255 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td><strong>File registers</strong></td>
<td>Maximum 2000 points</td>
<td>D1000 to D2499 set by parameter in 3 blocks of 500 program steps Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Externally adjusted</td>
<td>Range: 0 to 255</td>
<td>DB030 &amp; DB031 Data is entered indirectly through the external setting potentiometer</td>
</tr>
<tr>
<td>Special</td>
<td>256 points (inclusive of D8013)</td>
<td>From the range D8000 to D8255 Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Index</td>
<td>16 points</td>
<td>V and Z Type: 16 bit data storage register</td>
</tr>
<tr>
<td><strong>Pointers (P)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>64 points</td>
<td>P0 to P63</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>6 points</td>
<td>I00 to I05 (rising trigger q = 1, falling trigger q = 0)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td><strong>Constants</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767 32 bit: -2,147,483,648 to +2,147,483,647</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 0000 to FFFF 32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
</tbody>
</table>
A-6:  **FX1N Series PLC**

Latched devices range is fixed by PLC’s parameter. So that, these cannot be changed in the Parameter setting menu on FXGP/WIN-E.

**Table A-6: Device Table for FX1N Series PLC**

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>I/O configuration</td>
<td>Max hardware I/O configuration points 128, dependent on user selection (Max. software addressable Inputs 128, Outputs 128)</td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>384 points</td>
<td>M0 to M383</td>
</tr>
<tr>
<td>Auxiliary relay (M coils)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latched</td>
<td>1152 points</td>
<td>M384 to M1535</td>
</tr>
<tr>
<td></td>
<td>EEPROM backed-up: 128 points</td>
<td>EEPROM keep: M384 to M511</td>
</tr>
<tr>
<td></td>
<td>Capacitor backed-up: 1024 points</td>
<td>Capacitor keep: M512 to M1535</td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range M8000 to M8255</td>
</tr>
<tr>
<td>State relays (S coils)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Latched</td>
<td>1000 points</td>
<td>S0 to S999</td>
</tr>
<tr>
<td></td>
<td>EEPROM backed-up: 128 points</td>
<td>EEPROM keep: S0 to S127</td>
</tr>
<tr>
<td></td>
<td>Capacitor backed-up: 872 points</td>
<td>Capacitor keep: S128 to S999</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td>Timers (T)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec</td>
<td>T0 to T199</td>
</tr>
<tr>
<td></td>
<td>200 points</td>
<td></td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec</td>
<td>T200 to T245</td>
</tr>
<tr>
<td></td>
<td>46 points</td>
<td></td>
</tr>
<tr>
<td>1 msec retentive</td>
<td>Range: 0 to 32.767 sec</td>
<td>T246 to T249</td>
</tr>
<tr>
<td></td>
<td>4 point, Capacitor backed-up</td>
<td></td>
</tr>
<tr>
<td>100 msec retentive</td>
<td>Range: 0 to 3,276.7 sec</td>
<td>T250 to T255</td>
</tr>
<tr>
<td></td>
<td>6 points, Capacitor backed-up</td>
<td></td>
</tr>
<tr>
<td>Counters (C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>Range: 1 to 32,767 counts</td>
<td>C0 to C15</td>
</tr>
<tr>
<td></td>
<td>16 points</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: 1 to 32,767 counts</td>
<td>C16 to C199</td>
</tr>
<tr>
<td></td>
<td>184 points</td>
<td>EEPROM keep: C16 to C31</td>
</tr>
<tr>
<td></td>
<td>EEPROM backed-up: 16 points</td>
<td>Capacitor keep: C32 to C199</td>
</tr>
<tr>
<td></td>
<td>Capacitor backed-up: 168 points</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>General</td>
<td>Range: -2,147,483,648 to 2,147,483,647</td>
<td>C200 to C219</td>
</tr>
<tr>
<td></td>
<td>20 points</td>
<td>Type: 32 bit bi-directional counter</td>
</tr>
<tr>
<td>Latched</td>
<td>Range: -2,147,483,648 to 2,147,483,647</td>
<td>C220 to C234</td>
</tr>
<tr>
<td></td>
<td>15 points, Capacitor backed-up</td>
<td>Type: 32 bit bi-directional counter</td>
</tr>
<tr>
<td>High speed counters (C)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max. 6 points</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647</td>
<td>C235 to C240, 6 points</td>
</tr>
<tr>
<td>1 phase c/w start stop input</td>
<td>General rule: Select counter combinations with a combined counting frequency of 60kHz or less. Note;</td>
<td>C241 to C245, 5 points</td>
</tr>
<tr>
<td></td>
<td>all counters are latched (EEPROM backed-up) if high speed counter is used with the HSCS or HSCR instruction, a combined counting frequency of 30kHz or less.</td>
<td>C246 to C250, 5 points</td>
</tr>
<tr>
<td>2 phase</td>
<td>A/B phase</td>
<td></td>
</tr>
</tbody>
</table>

Note: All counters are latched (EEPROM backed-up) if high speed counter is used with the HSCS or HSCR instruction, a combined counting frequency of 30kHz or less.
### Table A-6: Device Table for FX1N Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>128 points</td>
<td>D0 to D127, Type: 16 bit data storage register pair for 32 bit device</td>
</tr>
<tr>
<td>Latched</td>
<td>7872 points</td>
<td>D128 to D7999, EEPROM backed-up: D128 to D255, Capacitor backed-up: D255 to D7999</td>
</tr>
<tr>
<td>File registers</td>
<td>Maximum 7000 points</td>
<td>D1000 to D7999 set by parameter in 14 blocks of 500 program steps, Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Externally adjusted</td>
<td>Range: 0 to 255</td>
<td>D8030 &amp; D8031, Data is entered indirectly through the external setting potentiometer</td>
</tr>
<tr>
<td>Special</td>
<td>256 points (inclusive of D8030 and D8031)</td>
<td>From the range D8000 to D8255, Type: 16 bit data storage register</td>
</tr>
<tr>
<td>Index</td>
<td>16 points</td>
<td>V and Z, Type: 16 bit data storage register</td>
</tr>
<tr>
<td><strong>Pointers (P)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>128 points</td>
<td>P0 to P127, Type: 16 bit data storage register</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>6 points</td>
<td>I00 to I50 (rising trigger = 1, falling trigger = 0)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td><strong>Constants</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767</td>
<td>32 bit: -2,147,483,648 to +2,147,483,647</td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 0000 to FFFF</td>
<td>32 bit: 00000000 to FFFFFFFFFFF</td>
</tr>
</tbody>
</table>
## A-7: FX2N/FX2NC Series PLC

Latched devices range can change in the Parameter setting menu on FXGP/WIN-E. For explanation about operation, refer to section 6.8.2. However, fixed latched device cannot be changed by it.

### Table A-7: Device Table for FX2N and FX2NC Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>I/O configuration</strong></td>
<td>Max hardware I/O configuration points 255, dependent on user selection</td>
<td>(Max. software addressable Inputs 255, Outputs 255)</td>
</tr>
<tr>
<td><strong>Auxiliary relay (M coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1024 points (Battery backed-up), Default: 500 points (subset)</td>
<td>M0 to M1023, Default: M0 to M499</td>
</tr>
<tr>
<td>Latched</td>
<td>1024 points (Battery backed-up), Default: 524 points (subset)</td>
<td>M0 to M1023, Default: M500 to M1023</td>
</tr>
<tr>
<td>Fixed</td>
<td>2048 points (Battery backed-up)</td>
<td>M1024 to M3071</td>
</tr>
<tr>
<td><strong>State relays (S coils)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>1000 points, Default: 500 points (subset)</td>
<td>S0 to S999, Default: S0 to S499</td>
</tr>
<tr>
<td>Latched</td>
<td>1000 points (Battery backed-up), Default: 500 points (subset)</td>
<td>S0 to S999, Default: S500 to S999</td>
</tr>
<tr>
<td>Initial</td>
<td>10 points (subset)</td>
<td>S0 to S9</td>
</tr>
<tr>
<td>Annunciator</td>
<td>100 points</td>
<td>S900 to S999</td>
</tr>
<tr>
<td><strong>Timers (T)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>100 msec</td>
<td>Range: 0 to 3,276.7 sec</td>
<td>T0 to T199</td>
</tr>
<tr>
<td>10 msec</td>
<td>Range: 0 to 327.67 sec</td>
<td>T200 to T245</td>
</tr>
<tr>
<td>1 msec retentive</td>
<td>Range: 0 to 32.767 sec (Battery backed-up)</td>
<td>T246 to T249</td>
</tr>
<tr>
<td>100 msec retentive</td>
<td>Range: 0 to 3,276.7 sec 6 points (Battery backed-up)</td>
<td>T250 to T255</td>
</tr>
<tr>
<td><strong>Counters (C)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General 16 bit</td>
<td>Range: 1 to 32,767 counts</td>
<td>C0 to C199, Default: C0 to C99</td>
</tr>
<tr>
<td></td>
<td>200 points, Default: 100 points (subset)</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>Latched 16 bit</td>
<td>Range: 1 to 32,767 counts</td>
<td>C0 to C199, Default: C100 to C199</td>
</tr>
<tr>
<td></td>
<td>200 points (Battery backed-up), Default: 100 points (subset)</td>
<td>Type: 16 bit up counter</td>
</tr>
<tr>
<td>General 32 bit</td>
<td>Range: -2,147,483,648 to 2,147,483,647</td>
<td>C200 to C234, Default: C200 to C219</td>
</tr>
<tr>
<td></td>
<td>35 points, Default: 20 points (subset)</td>
<td>Type: 32 bit up/down counter</td>
</tr>
<tr>
<td>Latched 32 bit</td>
<td>Range: -2,147,483,648 to 2,147,483,647 35 points (Battery backed-up)</td>
<td>C200 to C234, Default: C22 to C234</td>
</tr>
<tr>
<td></td>
<td>Default: 15 points (subset)</td>
<td>Type: 32 bit up/down counter</td>
</tr>
<tr>
<td><strong>High speed counters (C)</strong></td>
<td>Max. 6 points</td>
<td></td>
</tr>
<tr>
<td>1 phase</td>
<td>Range: -2,147,483,648 to +2,147,483,647 counts</td>
<td>C235 to C240, 6 points</td>
</tr>
<tr>
<td>1 phase c/w start stop input</td>
<td>General rule: Select counter combinations with a combined counting frequency of 20kHz or less. Note all counters are latched (Battery backed-up) If high speed counter is used with the HSCS or HSCR instruction, a combined counting frequency of 11kHz or less.</td>
<td>C241 to C245, 5 points</td>
</tr>
<tr>
<td>2 phase</td>
<td>35 points, Default: 20 points (subset)</td>
<td>C246 to C250, 5 points</td>
</tr>
<tr>
<td>A/B phase</td>
<td>11 points, Default: 5 points (subset)</td>
<td>C251 to C255, 5 points</td>
</tr>
</tbody>
</table>
### Table A-7: Device Table for FX2N and FX2NC Series PLC

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Data registers (D)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>General</td>
<td>512 points, Default: 200 points (subset)</td>
<td>D0 to D511, Default: D0 to D199 <em>Type: 16 bit data storage register pair for 32 bit device</em></td>
</tr>
<tr>
<td>Latched Subset</td>
<td>512 points (Battery backed-up), Default: 312 points (subset)</td>
<td>D0 to D511, Default: D200 to D511 <em>Type: 16 bit data storage register pair for 32 bit device</em></td>
</tr>
<tr>
<td>Fixed</td>
<td>7488 points (Battery backed-up)</td>
<td>D512 to D7999</td>
</tr>
<tr>
<td>File registers</td>
<td>Maximum 7000 points</td>
<td>D1000 to D7999 set by parameter in 14 blocks of 500 program steps <em>Type: 16 bit data storage register</em></td>
</tr>
<tr>
<td>Special</td>
<td>256 points</td>
<td>From the range D8000 to D8255 <em>Type: 16 bit data storage register</em></td>
</tr>
<tr>
<td>Index</td>
<td>16 points</td>
<td>V0 to V7 and Z0 to Z7 <em>Type: 16 bit data storage register</em></td>
</tr>
<tr>
<td><strong>Pointers (P)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For use with CALL</td>
<td>128 points</td>
<td>P0 to P127</td>
</tr>
<tr>
<td>For use with interrupts</td>
<td>6 input points, 3 timers, 6 counters</td>
<td>I00 to I50, and I6 to I8 (rising trigger =1, falling trigger =0, <em>time in msec</em> =1)</td>
</tr>
<tr>
<td>Nest levels</td>
<td>8 points for use with MC and MCR</td>
<td>N0 to N7</td>
</tr>
<tr>
<td><strong>Numbers</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decimal K</td>
<td>16 bit: -32,768 to +32,767</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: -2,147,483,648 to +2,147,483,647</td>
<td></td>
</tr>
<tr>
<td>Hexadecimal H</td>
<td>16 bit: 0000 to FFFF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>32 bit: 00000000 to FFFFFFFF</td>
<td></td>
</tr>
<tr>
<td>Floating Point</td>
<td>32 bit: 0, ±1.175 x 10^-38, ±3.403 x 10^38</td>
<td><em>Not directly enterable</em></td>
</tr>
</tbody>
</table>
Appendix B:
PLC Instruction Tables

For further information about instruction of the FX0, FX0S, FX0N, FX and FX2C Series PLC can be found in FX Programming Manual (Manual number: JY992D48301), about the FX1S, FX1N, FX2N and FX2NC Series PLC can be found in FX Programming Manual II (Manual number: JY992D88101).

B-1: Basic Program Instruction Table

<table>
<thead>
<tr>
<th>Instruction (Mnemonic)</th>
<th>FX0/ FX0S</th>
<th>FX0N</th>
<th>FX/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX2N/ FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td>LD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>LDI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>LDP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>LDF</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AND</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ANI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ANP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ANF</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>OR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ORI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ORP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>ORF</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>OUT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>SET</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>RST</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MCR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPS</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MRD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>MPP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>NOP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>END</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

B-2: SFC (STL) Program Instruction Table

<table>
<thead>
<tr>
<th>Instruction (Mnemonic)</th>
<th>FX0/ FX0S</th>
<th>FX0N</th>
<th>FX/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX2N/ FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td>STL</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>RET</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
# Appendix B: Applied Instruction Table

## Note

Some instructions is supported differently by CPU version of an PLC. For further information about instruction of the FX0, FX0S, FX0N, FX and FX2C Series PLC can be found in FX Programming Manual (Manual number: JY992D48301), about the FX1S, FX1N, FX2N and FX2NC Series PLC can be found in FX Programming Manual II (Manual number: JY992D88101).

- ✔: Supports from first product
- ✔(_CPU version in Table A-3): The instruction is supported from “(_CPU version in Table A-3)” or later. “(_CPU version in Table A-3)” is CPU version of PLC on the Table A-3.
- ✗(_CPU version in Table A-3): The instruction is not supported from “(_CPU version in Table A-3)” or later. “(_CPU version in Table A-3)” is CPU version of PLC on the Table A-3.

### Table B-3: Applied Instructions

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Instruction Code</th>
<th>FX0/FX0S</th>
<th>FX0N (V2.30 or earlier)</th>
<th>FX(V3.07 or later)/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX2N/FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td>000</td>
<td>CJ</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>001</td>
<td>CALL</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>002</td>
<td>SRET</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>003</td>
<td>IRET</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>004</td>
<td>EI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>005</td>
<td>DI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>006</td>
<td>FEND</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>007</td>
<td>WDT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>008</td>
<td>FOR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>009</td>
<td>NEXT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>010</td>
<td>CMP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>011</td>
<td>ZCP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>012</td>
<td>MOV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>013</td>
<td>SMOV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>014</td>
<td>CML</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>015</td>
<td>BMOV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>016</td>
<td>FMOV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>017</td>
<td>XCH</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>018</td>
<td>BCD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>019</td>
<td>BIN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
FX-PCS/WIN-E Software Manual

Applied Instructions

High Speed Processing

Data Operation

Rotation And Shift

FX
(V2.30 or
earlier)
Pulse Operation

16bit Operation

32bit Operation

Pulse Operation

16bit Operation

32bit Operation

Pulse Operation

16bit Operation

32bit Operation

Pulse Operation

16bit Operation

32bit Operation

Pulse Operation

16bit Operation

32bit Operation

FX2N/FX2NC

32bit Operation

FX1N

16bit Operation

FX1S

32bit Operation

Pulse Operation

FX(V3.07 or
later)/FX2C

16bit Operation

FX0N

Mnemonic

FX0/FX0S

FNC No.
Arithmetic And Logical Operations

Instruction

Pulse Operation

Table B-3:

Appendix B:

020

ADD

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

021

SUB

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

022

MUL

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

023

DIV

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

024

INC

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

025

DEC

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

026

WAND

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

027

WOR

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

028

WXOR

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔
✔

029

NEG

✔

✔

✔

✔

✔

✔

✔

✔

030

ROR

✔

✔

✔

✔

✔

✔

✔

✔

031

ROL

✔

✔

✔

✔

✔

✔

✔

✔

032

RCR

✔

✔

✔

✔

✔

✔

✔

✔

033

RCL

✔

✔

✔

✔

✔

✔

✔

✔

034

SFTR

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

035

SFTL

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

036

WSFR

✔

✔

✔

✔

✔

✔

037

WSFL

✔

✔

✔

✔

✔

✔

038

SFWR

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

039

SFRD

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

040

ZRST

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

041

DECO

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

042

ENCO

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

043

SUM

✔

✔

✔

✔

✔

✔

✔

✔

✔

044

BON

✔

✔

✔

✔

✔

✔

✔

✔

✔

045

MEAN

✔

✔

✔

✔

✔

✔

✔

✔

✔

046

ANS

✔

✔

ANR

✔

✔

✔

✔

✔

✔

✔

✔

✔

✔

049

FLT

✔

✔

✔

✔

✔

✔

050

REF

✔

✔

✔

051

REFF

052

MTR

053

HSCS

✔

✔

✔

✔

✔

✔

✔

054

HSCR

✔

✔

✔

✔

✔

✔

✔

HSZ

056

SPD

✔

✔

✔

✔

✔

✔

✔

✔

057

PLSY

✔

PWM

✔

059

PLSR

✔

✔
✔

✔

✔
✔

✔

✔

✔
✔

✔

✔

✔
✔

✔
✔

✔

✔

✔
✔

✔
✔

✔

✔
✔

✔
✔

✔

✔

✔

✔
✔

B-3

✔

5
6

A
B
C
D

✔

✔
✔

✔

✔

✔
✔

✔

058

✔

4

9

SQR
✔

3

8

048

✔

✔

2

7

047

055

✔

✔

1

✔

E


### Table B-3: Applied Instructions

<table>
<thead>
<tr>
<th>Instruction</th>
<th>FX0/FX0S</th>
<th>FX0N (V2.30 or earlier)</th>
<th>FX(V3.07 or later)/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX3N/FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FXN No.</strong></td>
<td><strong>Mnemonic</strong></td>
<td><strong>Pulse Operation</strong></td>
<td><strong>16bit Operation</strong></td>
<td><strong>32bit Operation</strong></td>
<td><strong>Pulse Operation</strong></td>
<td><strong>16bit Operation</strong></td>
</tr>
<tr>
<td>060</td>
<td>IST</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>061</td>
<td>SER</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>062</td>
<td>ABSD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>063</td>
<td>INC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>064</td>
<td>TTMR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>065</td>
<td>STMR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>066</td>
<td>ALT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>067</td>
<td>RAMP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>068</td>
<td>ROT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>069</td>
<td>SORT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>070</td>
<td>TKY</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>071</td>
<td>HKY</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>072</td>
<td>DSW</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>073</td>
<td>SEG</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>074</td>
<td>SEGL</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>075</td>
<td>ARWS</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>076</td>
<td>ASC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>077</td>
<td>PR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>078</td>
<td>FROM</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>079</td>
<td>TO</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>080</td>
<td>RS</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>081</td>
<td>PRUN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>082</td>
<td>ASCI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>083</td>
<td>HEX</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>084</td>
<td>CCD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>085</td>
<td>VRRD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>086</td>
<td>VRSC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>088</td>
<td>PID</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
### Table B-3: Applied Instructions

<table>
<thead>
<tr>
<th>Instruction</th>
<th>FX0/FX0S</th>
<th>FX2N</th>
<th>FX (V2.30 or earlier)</th>
<th>FX (V3.07 or later)/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX2N/FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td>090</td>
<td>MNET</td>
<td>✔✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>091</td>
<td>ANRD</td>
<td>✔✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>092</td>
<td>ANWR</td>
<td>✔✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>093</td>
<td>RMST</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>094</td>
<td>RMWR</td>
<td>✔✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>095</td>
<td>RMRD</td>
<td>✔✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>096</td>
<td>RMMN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>097</td>
<td>BLK</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>098</td>
<td>MCDE</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>110</td>
<td>ECMP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>111</td>
<td>EZCP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>118</td>
<td>EBCD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>119</td>
<td>EBIN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>120</td>
<td>EADD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>121</td>
<td>ESUB</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>122</td>
<td>EMUL</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>123</td>
<td>EDIV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>127</td>
<td>ESQR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>129</td>
<td>INT</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>130</td>
<td>SIN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>131</td>
<td>COS</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>132</td>
<td>TAN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>147</td>
<td>SWAP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>155</td>
<td>ABS</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>156</td>
<td>ZRN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>157</td>
<td>PLSV</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>158</td>
<td>DRVI</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>159</td>
<td>DRVA</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
### Table B-3: Applied Instructions

<table>
<thead>
<tr>
<th>Instruction</th>
<th>FX0/FX0S</th>
<th>FX0N (V2.30 or earlier)</th>
<th>FX(V3.07 or later)/FX2C</th>
<th>FX1S</th>
<th>FX1N</th>
<th>FX2N/FX2NC</th>
</tr>
</thead>
<tbody>
<tr>
<td>160</td>
<td>TCMP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>161</td>
<td>TZCP</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>162</td>
<td>TADD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>163</td>
<td>TSUB</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>166</td>
<td>TRD</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>167</td>
<td>TWR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>169</td>
<td>HOUR</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>170</td>
<td>GRY</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>171</td>
<td>GBIN</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>176</td>
<td>RD3A</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>177</td>
<td>WR3A</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>180</td>
<td>EXTR</td>
<td></td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>224</td>
<td>LD=</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>225</td>
<td>LD&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>226</td>
<td>LD&lt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>228</td>
<td>LD&lt;&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>229</td>
<td>LD≤</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>230</td>
<td>LD≥</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>232</td>
<td>AND=</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>233</td>
<td>AND&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>234</td>
<td>AND&lt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>236</td>
<td>AND&lt;&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>237</td>
<td>AND≤</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>238</td>
<td>AND≥</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>240</td>
<td>OR=</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>241</td>
<td>OR&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>242</td>
<td>OR&lt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>244</td>
<td>OR&lt;&gt;</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>245</td>
<td>OR≤</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>246</td>
<td>OR≥</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>
Appendix C:
Error Cord of PLC

For further information about error cord of the FX0, FX0S, FX0N, FX and FX2C Series PLC can be found in the each series Hardware Manual and FX Programming Manual (Manual number: JY992D48301), about the FX1S, FX1N, FX2N and FX2NC Series PLC can be found in the each series Hardware Manual and FX Programming Manual II (Manual number: JY992D88101).

**Table C-1: PLC Hardware Error**

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8061 PLC Hardware error</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6101</td>
<td>RAM error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6102</td>
<td>Operation circuit error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6103</td>
<td>I/O bus error (M8069 = ON)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6104</td>
<td>Extension unit 24V failure (M8069=ON)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6105</td>
<td>Watch Dog Timer error</td>
<td></td>
</tr>
</tbody>
</table>

**Table C-2: PC/HPP Communication Error**

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8062 PC/HPP communication error (Not FX1S, FX1N)</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6201</td>
<td>Parity/ overrun/ framing error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6202</td>
<td>Communications character error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6203</td>
<td>Communication data sum check error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6204</td>
<td>Data format error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6205</td>
<td>Command error</td>
<td></td>
</tr>
</tbody>
</table>

**Table C-3: Serial Communication Error**

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8063 Serial communication errors</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6301</td>
<td>Parity/ overrun/ framing error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6302</td>
<td>Comms character error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6303</td>
<td>Comms data sum check error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6304</td>
<td>Comms data format error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6305</td>
<td>Command error Computer link - received command other than GW (global) when station number was FF</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6306</td>
<td>Watchdog timer error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6312</td>
<td>Parallel link character error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6313</td>
<td>Parallel link data sum check error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6314</td>
<td>Parallel link data format error</td>
<td></td>
</tr>
</tbody>
</table>

Note: Check communication settings, parameters and applicable devices. (Computer link, N:N network, Parallel link etc.) Refer to FX Communication Users Manual for wiring techniques.
### Table C-4: Parameter Error

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8064 Parameter error</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6401</td>
<td>Program sum check error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6402</td>
<td>Memory capacity setting error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6403</td>
<td>Latched device area setting error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6404</td>
<td>Comment area setting error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6405</td>
<td>File register area setting error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6406 - 6408</td>
<td>Reserved</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6409</td>
<td>Other setting error</td>
<td></td>
</tr>
</tbody>
</table>

### Table C-5: Syntax Error

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8065 Syntax error</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6501</td>
<td>Incorrect instruction/ device symbol/ device number combination</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6502</td>
<td>No timer or counter coil before setting value</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6503</td>
<td>1) No setting value following either a timer or a counter coil</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2) Insufficient number of operands for an applied instruction</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6504</td>
<td>1) The same label number is used more than once</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>2) The same interrupt input or high speed counter input is used more than once</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6505</td>
<td>Device number is outside the allowable range</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6506</td>
<td>Invalid applied instruction</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6507</td>
<td>Invalid Pointer device [P] assignment for Jump or Call instruction</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6508</td>
<td>Invalid Interrupt pointer device [I] assignment</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6509</td>
<td>Other error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6510</td>
<td>MC nesting (N) number error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6511</td>
<td>The same interrupt input or high speed counter input is used more than once</td>
<td></td>
</tr>
</tbody>
</table>
### Table C-6: Circuit Error

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8066 Circuit error</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6601</td>
<td>LD and LD/LDI is used continuously 9 or more times in succession</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6602</td>
<td>1) No LD/LDI instruction. The use of LDLDI or ANB/ORB instruction is incorrect. 2) The following instructions are not connected to the active bus line: STL, RET, MCR, (P)ointer, (I)nterrupt, EI, DI, SRET, IRET, FOR, NEXT, FEND and END 3) When MPP is missing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6603</td>
<td>MPS is used continuously more than 12 times</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6604</td>
<td>The use of MPS, MRD, MPP instruction is incorrect.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6605</td>
<td>1) The STL instruction is continuously used 9 times or more 2) MC, MCR instruction, (I)nterrupt pointer or SRET instruction is used within an STL program area 3) RET has not been used in the program or is not connected to an STL instruction</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6606</td>
<td>1) No (P)ointer, (I)nterrupt pointer 2) No SRET/IRET 3) An (I)nterrupt pointer, SRET or IRET has been used within the main program 4) STL, RET, MC or MCR have been used either within a subroutine or an interrupt routine</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6607</td>
<td>1) The use of FOR and NEXT is incorrect 2) The following instructions have been used within a FOR-NEXT loop: STL, RET, MC, MCR, IRET, SRET, FEND or END</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6608</td>
<td>1) The use of MC/ MCR is incorrect 2) Missing MCR N0 3) SRET, IRET instruction or an (I)nterrupt pointer has been used within an MC/ MCR instruction area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6609</td>
<td>Other error</td>
<td></td>
</tr>
</tbody>
</table>

A circuit error occurs if a combination of instructions is incorrect or badly specified. Select programming mode and correct the identified error.
### Table C-6: Circuit Error

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>6610</td>
<td>LD, LDI is used continuously 9 or more times in succession</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6611</td>
<td>Number of LD/LDI instructions is more than ANB/ORB instructions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6612</td>
<td>Number of LD/LDI instructions is less than ANB/ORB instructions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6613</td>
<td>MPS is used continuously more than 12 times</td>
<td></td>
</tr>
<tr>
<td></td>
<td>6614</td>
<td>MPS instruction missing</td>
<td></td>
</tr>
<tr>
<td>6515</td>
<td>MPP instruction missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6616</td>
<td>Unauthorized use of the MPS/MR/MPP instructions; possible coil missing</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6617</td>
<td>One of the following instructions is not connected to the active bus line: STL, RET, MCR, (P)ointer, (I)nterrupt pointer, EI, DI, SRET, IRET, FOR, NEXT, FEND and END</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6618</td>
<td>STL, RET, MC or MCR programmed within either a subroutine or an interrupt routine</td>
<td>A circuit error occurs if a combination of instructions is incorrect or badly specified. Select programming mode and correct the identified error.</td>
<td></td>
</tr>
<tr>
<td>6619</td>
<td>Invalid instruction programmed within a FOR-NEXT loop: STL, RET, MC, MCR, (I)nterrupt pointer, IRET and SRET</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6620</td>
<td>FOR - NEXT instruction nesting levels (5) exceeded</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6621</td>
<td>The number of FOR and NEXT instructions does not match</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6622</td>
<td>NEXT instruction not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6623</td>
<td>MC instruction not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6624</td>
<td>MCR instruction not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6625</td>
<td>The STL instruction is continually used 9 times or more</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6626</td>
<td>Invalid instruction programmed within an STL - RET program area: MC, MCR, (I)nterrupt pointer, IRET and SRET</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6627</td>
<td>RET instruction not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6628</td>
<td>(I)nterrupt pointer, SRET and IRET incorrectly programmed within main program</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6629</td>
<td>(P)ointer or (I)nterrupt pointer label not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6630</td>
<td>SRET or IRET not found</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6631</td>
<td>SRET programmed in invalid location</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6632</td>
<td>IRET programmed in invalid location</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table C-7: Operation Error and PID Operation Error

<table>
<thead>
<tr>
<th>Error Detection Device</th>
<th>Stored Error Number</th>
<th>Associated Meaning</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>D8067 Operation error</td>
<td>0000</td>
<td>No error</td>
<td></td>
</tr>
</tbody>
</table>
|                        | 6701                | 1) No jump destination (pointer) for CJ or CALL instructions  
2) (P)ointer is designated in a block that comes after the END instruction  
3) An independent label is designated in a FOR-NEXT loop or a subroutine | These errors occur during the execution of an operation. When an operation error occurs, STOP the PLC. Enter programming code and correct the fault. Note: operation errors can occur even when the syntax or circuit design is correct, e.g. D500Z is a valid statement within an FX1N PLC. But if Z had a value of 10000, the data register D10500 would be attempted to be accessed. This will cause an operation error as there is no D10500 device available. |
|                        | 6702                | 6 or more CALL instruction nesting levels have been used |        |
|                        | 6703                | 3 or more interrupt nesting levels have been used |        |
|                        | 6704                | 6 or more FOR - NEXT instruction nesting levels have been used |        |
|                        | 6705                | An incompatible device has been specified as an operand for an applied instruction |        |
|                        | 6706                | A device has been specified outside of the allowable range for an applied instruction operand |        |
|                        | 6707                | A file register has been accessed which is outside of the users specified range |        |
|                        | 6708                | FROM/TO instruction error |        |
|                        | 6709                | Other error, i.e. missing IRE/SRET, unauthorized FOR - NEXT relationship |        |
| D8067 PID Operation error | 6730                | Sampling time T S (TS<0 or >32767) | The identified parameter is specified outside of its allowable range. Execution ceases PID instruction must be reset before execution will resume |
|                        | 6732                | Input filter value α (α<0 or >=101) |        |
|                        | 6733                | Proportional gain K P (KP<0 or >32767) |        |
|                        | 6734                | Integral time constant T I (TI<0 or >32767) |        |
|                        | 6735                | Derivative gain K D (KD<0 or >=101) |        |
|                        | 6736                | Derivative time constant T D (TD<0 or >32767) |        |
|                        | 6740                | Sampling time TS is less than the program scan time. | TS is set to program scan time - Execution will continue. |
|                        | 6742                | Current value χ exceeds its limits | Data affected resets to the nearest limit value. For all errors except 6745, this will either be a minimum of -32768 or a maximum of +32767. |
|                        | 6743                | Calculated error ε exceeds its limits |        |
|                        | 6744                | Integral result exceeds its limits |        |
|                        | 6745                | Derivative gain over, or differential value exceeds allowable range |        |
|                        | 6746                | Derivative result exceeds its limits |        |
|                        | 6747                | Total PID result exceeds its limits |        |
|                        | 6750                | SV - PV _nf < 150, or system is unstable (SV - PV _nf has wide, fast variations) | The error fluctuation is outside the normal operation limits for the PID instruction. Execution ceases. PID instruction must be reset. |
|                        | 6751                | Large Overshoot of the Set Value |        |
|                        | 6752                | Large fluctuations during Autotuning Set Process |        |
Appendix D:  
File converter

By using this file converter, a MELSEC MEDOC file (.TMP) can be converted into an FXGP/ WIN-E file.

**Listings for printout**

1) "INSTR" and "PARAMETER" must always be selected in the printout menu of MELSEC MEDOC.
2) When the device names and the device comments should be converted, "NAME" must be selected in the printout menu of MELSEC MEDOC.
3) When the circuit comment is converted, "ONLY COM" must be selected in the printout menu of MELSEC MEDOC.
4) When the value of the data register is converted, "DWR" must be selected in the printout menu of MELSEC MEDOC.

**File name**

1) File names up to eight characters are allowed.  
   (Do not use the long file names of WINDOWS95)
2) The extension of the text file for MELSEC MEDOC should be "TMP".

**Limitation and rule of the data when converting.**

1) Device name conversion  
   NAME which exceeds eight characters are cut to eight characters.  
   Characters other than alphabet characters, numbers or the effective signs stated below are replaced with '_'(under bar).  
   (Effective sign: +/-*/=:? #$%&: ; _)
2) Circuit comment  
   Up to 500 characters in total are converted when there are two or more comment lines for one circuit block.
3) Value of data register  
   When two or more sets of SETUP data of the data, link and file registers (DWR) are converted, only the last SETUP data can be converted.
MEMO
Appendix E: Associated Manuals

Further information on Hardware (Specification, configuration, Installation and wiring) programming, optional modules or special function units/blocks can be found in each respective manual.

Table E-1: Associated Manuals

<table>
<thead>
<tr>
<th>Manual name</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX2N Series Programmable Controllers Hardware Manual</td>
<td>JY992D66301</td>
<td>This manual contains hardware explanations for wiring, installation and specification, etc.</td>
</tr>
<tr>
<td>FX2NC (DSS/DS) Series Programmable Controllers Hardware Manual</td>
<td>JY992D76401</td>
<td></td>
</tr>
<tr>
<td>FX2NC (D/UL) Series Programmable Controllers Hardware Manual</td>
<td>JY992D87201</td>
<td></td>
</tr>
<tr>
<td>FX1N Series Programmable Controllers Hardware Manual</td>
<td>JY992D89301</td>
<td></td>
</tr>
<tr>
<td>FX1S Series Programmable Controllers Hardware Manual</td>
<td>JY992D83901</td>
<td></td>
</tr>
<tr>
<td>FX Series Programmable Controllers Hardware Manual (FX/FX2C)</td>
<td>JY992D47401</td>
<td></td>
</tr>
<tr>
<td>FX/FX2N Series Programmable Controllers Hardware Manual</td>
<td>JY992D47501</td>
<td></td>
</tr>
<tr>
<td>FX0 Series Programmable Controllers Hardware Manual</td>
<td>JY992D55301</td>
<td></td>
</tr>
<tr>
<td>FX Programming Manual II (for FX1S, FX1N, FX2N, FX2NC Series PLC)</td>
<td>JY992D88101</td>
<td>This manual contains instruction explanations.</td>
</tr>
<tr>
<td>FX Programming Manual II (for FX0, FX0S, FX0N, FX, FX2C Series PLC)</td>
<td>JY992D48301</td>
<td></td>
</tr>
<tr>
<td>FX1N-4EX-BD Input Expansion Board User's Manual</td>
<td>JY992D95001</td>
<td></td>
</tr>
<tr>
<td>FX1N-2EYT-BD Input Expansion Board User's Manual</td>
<td>JY992D95201</td>
<td>This manual contains hardware explanations for wiring, installation and specification, etc.</td>
</tr>
<tr>
<td>FX I/O Terminal Block User's Guide</td>
<td>JY992D560401</td>
<td></td>
</tr>
<tr>
<td>FX1N-1DA-BD Analog Output Expansion Board User's Guide</td>
<td>JY992D96401</td>
<td>This manual contains explanations for wiring, installation and specification.</td>
</tr>
<tr>
<td>FX1N-2AD-BD Analog Input Expansion Board User's Guide</td>
<td>JY992D96201</td>
<td></td>
</tr>
<tr>
<td>FX2N-2DA Special Function Block User's Guide</td>
<td>JY992D74901</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-2AD Special Function Block User's Guide</td>
<td>JY992D74701</td>
<td></td>
</tr>
</tbody>
</table>
### Table E-1: Associated Manuals

<table>
<thead>
<tr>
<th>Manual name</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX2N-3A Special Function Block User's Guide</td>
<td>JY992D49001</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-4DA Special Function Block User's Guide</td>
<td>JY992D65901</td>
<td></td>
</tr>
<tr>
<td>FX2N-4AD Special Function Block User's Guide</td>
<td>JY992D65201</td>
<td></td>
</tr>
<tr>
<td>FX2N-4AD-PT Special Function Block User's Guide</td>
<td>JY992D65601</td>
<td></td>
</tr>
<tr>
<td>FX2N-4AD-TC Special Function Block User's Guide</td>
<td>JY992D65501</td>
<td></td>
</tr>
<tr>
<td>FX2N-8AD Special Function Block User's Manual</td>
<td>JY992D86001</td>
<td></td>
</tr>
<tr>
<td>FX-2DA Special Function Block User's Guide</td>
<td>JY992D52801</td>
<td></td>
</tr>
<tr>
<td>FX-4DA Special Function Block User's Guide</td>
<td>JY992D61001</td>
<td></td>
</tr>
<tr>
<td>FX-4AD Special Function Block User's Guide</td>
<td>JY992D52601</td>
<td></td>
</tr>
<tr>
<td>FX-2AD-PT Special Function Block User's Guide</td>
<td>JY992D55701</td>
<td></td>
</tr>
<tr>
<td>FX-4AD-TC Special Function Block User's Guide</td>
<td>JY992D55901</td>
<td></td>
</tr>
<tr>
<td>FX2N-2LC Special Function Block User's Manual</td>
<td>JY992D85801</td>
<td></td>
</tr>
<tr>
<td>FX2N-1HC Special Function Block User's Guide</td>
<td>JY992D65401</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX-1HC Special Function Block User's Guide</td>
<td>JY992D53001</td>
<td></td>
</tr>
<tr>
<td>FX1PG-E/FX2N-1PG-E Pulse Generation Unit User's Manual</td>
<td>JY992D65301</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-10PG Pulse Generation Unit User's Manual</td>
<td>JY992D93401</td>
<td></td>
</tr>
<tr>
<td>FX2N-10GM, FX2N-20GM Hardware/Programming Manual</td>
<td>JY992D77801</td>
<td></td>
</tr>
<tr>
<td>FX-10GM, FX-20GM Hardware/Programming Manual</td>
<td>JY992D60401</td>
<td></td>
</tr>
</tbody>
</table>
### Table E-1: Associated Manuals

<table>
<thead>
<tr>
<th>Manual name</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX2N-1RM-E-SET Programmable Cam Switch User’s Manual</td>
<td>JY992D71101</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-232IF RS-232C Interface Block Hardware Manual</td>
<td>JY992D73501</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-232-BD Communication Board User’s Guide</td>
<td>JY992D66001</td>
<td></td>
</tr>
<tr>
<td>FX2N-422-BD Communication Board User’s Guide</td>
<td>JY992D66101</td>
<td></td>
</tr>
<tr>
<td>FX2N-485-BD Communication Board User’s Guide</td>
<td>JY992D73401</td>
<td></td>
</tr>
<tr>
<td>FX2NC-232ADP Installation Manual</td>
<td>JY997D01101</td>
<td></td>
</tr>
<tr>
<td>FX2N-232ADP Communication Adapter User’s Guide</td>
<td>JY992D51301</td>
<td></td>
</tr>
<tr>
<td>FX-232ADP Communication Adapter User’s Guide</td>
<td>JY992D48801</td>
<td></td>
</tr>
<tr>
<td>FX2NC-485ADP Installation Manual</td>
<td>JY997D01201</td>
<td></td>
</tr>
<tr>
<td>FX2NC-485ADP Communication Adapter User’s Guide</td>
<td>JY992D53201</td>
<td></td>
</tr>
<tr>
<td>FX2N-16CCL-M CC-Link System Master Block User’s Manual</td>
<td>JY992D93101</td>
<td></td>
</tr>
<tr>
<td>FX2N-32CCL CC-Link Interface Block User’s Manual</td>
<td>JY992D71801</td>
<td></td>
</tr>
<tr>
<td>FX2N-32NT-DP Profinet-DP Interface User’s Manual</td>
<td>JY992D61401</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX2N-64DNET DeviceNet Interface User’s Manual</td>
<td>JY992D86301</td>
<td></td>
</tr>
<tr>
<td>FX2N-32ASI-M AS-interface Master Block User’s Manual</td>
<td>JY992D76901</td>
<td></td>
</tr>
<tr>
<td>FX2N-16LNK-M MELSEC I/O Link System Master Block User’s Manual</td>
<td>JY992D73701</td>
<td>This manual contains explanations for wiring, installation, specification setting and I/O allocation, etc.</td>
</tr>
</tbody>
</table>
Table E-1: Associated Manuals

<table>
<thead>
<tr>
<th>Manual name</th>
<th>Manual No.</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX0N-16NT MELSEC NET-MINI (-S3) Interface User's Guide</td>
<td>JY992D48901</td>
<td>This manual contains explanations for wiring, installation and specification.</td>
</tr>
<tr>
<td>FX-16NT/NP MELSEC NET-MINI (-S3) Interface User's Guide</td>
<td>JY992D56201</td>
<td>This manual contains explanations for wiring, installation, specification and BFM allocation, etc.</td>
</tr>
<tr>
<td>FX-16NT/NP-S3 MELSEC NET-MINI-S3 Interface User's Manual</td>
<td>JY992D34601</td>
<td></td>
</tr>
<tr>
<td>FX2N-CNV-BD Manual</td>
<td>JY992D63601</td>
<td>This manual contains explanations for installation.</td>
</tr>
<tr>
<td>FX1N-CNV-BD Manual</td>
<td>JY992D84701</td>
<td></td>
</tr>
<tr>
<td>FX2N-8AV-BD Manual</td>
<td>JY992D62501</td>
<td></td>
</tr>
<tr>
<td>FX1N-8AV-BD Manual</td>
<td>JY992D84601</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>---</td>
<td>---------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>2</td>
<td>Installing FXGP/WIN-E</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>Main Operation</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Work Windows and their Functions</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>Guidance of Basic Operations</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>Menu Bar Commands and their Functions</td>
<td>6</td>
</tr>
<tr>
<td>7</td>
<td>Creating Ladder and Instruction Programs</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>Creating SFC Programs</td>
<td>8</td>
</tr>
<tr>
<td>9</td>
<td>Remote Maintenance Using Telephone Line</td>
<td>9</td>
</tr>
<tr>
<td>A</td>
<td>Appendix A: Device Lists</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>Appendix B: Instruction List</td>
<td>B</td>
</tr>
<tr>
<td>C</td>
<td>Appendix C: Error Code Tables</td>
<td>C</td>
</tr>
<tr>
<td>D</td>
<td>Appendix D: File Convertor</td>
<td>D</td>
</tr>
<tr>
<td>E</td>
<td>Appendix D: Associated Manuals</td>
<td>E</td>
</tr>
</tbody>
</table>
SOFTWARE MANUAL

FX-PCS/WIN-E

MITSUBISHI ELECTRIC CORPORATION

HEAD OFFICE: TOKYO BUILDING, 2-7-3 MARUNOUCHI, CHIYODA-KU, TOKYO 100-8310, JAPAN
HIMEJI WORKS: 840, CHIYODA CHO, HIMEJI, JAPAN

<table>
<thead>
<tr>
<th>MODEL</th>
<th>FX-PCS/WIN-SW-E</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODEL CODE</td>
<td>09R908</td>
</tr>
</tbody>
</table>

JY992D66501F
(MEE)

Effective Nov. 2008
Specifications are subject to change without notice.